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How to Contact Oracle Technical Publications
Oracle Corporation welcomes your comments and suggestions on the quality and usefulness of this 
publication. We also welcome your comments regarding our documentation delivery format. Your 
input is an important part of the information used for revision.

■ Did you find any errors?
■ Is the information clearly presented?
■ Do you need more information? If so, where?
■ Are the examples correct? Do you need more examples?
■ What features did you like most about this manual?
■ Do you have suggestions for improvement? Please indicate the topic, chapter, and page 

number (if available) in your e-mail.

Send your comments to ntdoc@us.oracle.com

Other Ways to Contact Oracle Corporation
Depending on your need for information, one or more of these sources may be valuable to you: 

Location Contact

Oracle Corporation Home Page http://www.oracle.com

Oracle World Wide Support (on the World Wide Web) http://www.oracle.com/support/ 

Oracle World Wide Support in the United States of 
America (by telephone)

■ (1) (650) 506-1500 for customers with support 
contracts

■ (1) (650) 506-5577 to obtain a support contract

Oracle World Wide Support International Your local support center in your country

Product Availability infowin@us.oracle.com
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Preface

This guide is your primary source of introductory, post-installation, configuration, 
and administration information for Oracle7 Server on Windows platforms. 

Specific topics discussed are:

■ Prerequisites

■ Intended Audience

■ How This Guide Is Organized

■ Conventions



xiv                                                                                         

Prerequisites
This guide assumes that you are familiar with:

■ Windows NT and have installed and tested it for your personal computer (PC) 
and network hardware

■ Relational database management concepts

Intended Audience
This guide is necessary for anyone installing, configuring, or administering Oracle7 
Server. 

How This Guide Is Organized
This guide is organized as follows:

Chapter 1, “Getting Started with Your Documentation”
Introduces you to the Oracle documentation set. Oracle Corporation 
recommends that you read this chapter before installing or using Oracle7 Server.

Chapter 2, “Introducing Oracle7 Server”
Describes the basic components of Oracle7 Server, and new features of this 
release.

Chapter 3, “Database Tools”
Provides a list of preferred tools, among the many tools available to you, to 
perform common database administration tasks.

Chapter 4, “Oracle7 Server Integration with Windows NT”
Describes the close integration of Oracle7 Server with Windows NT.

Note: This guide describes only the features of Oracle7 Server 
software that apply to the Windows NT, Windows 95, and 
Windows 3.1 operating systems. For information about Oracle7 
Server that is applicable to all operating systems, see Oracle7 Server 
Concepts and other documentation included in your package. A list 
of included documentation is available in Chapter 1, “Getting 
Started with Your Documentation”.
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Chapter 5, “Understanding Oracle Enterprise Manager”
Provides an overview of Oracle Enterprise Manager, Oracle’s suite of products 
for managing Oracle7 databases over a distributed network.

Chapter 6, “Starter Database Contents”
Describes the contents of the preconfigured starter database.

Chapter 7, “Upgrading a Database”
Describes how to upgrade from a previous release of Oracle7 Server to the 
current release.

Chapter 8, “Configuration Tasks”
Describes the configuration tasks you must perform before using products, 
such as Oracle Enterprise Manager, Oracle ConText Option, and Oracle7 
Spatial Data Option.

Chapter 9, “Creating a Database”
Describes how to create a database using command line tools and the CREATE 
DATABASE SQL statement.

Chapter 10, “Administering a Database”
Describes how to administer a database.

Chapter 11, “Monitoring a Database”
Describes how to monitor an Oracle7 Server database.

Chapter 12, “Backing Up and Recovering Database Files”
Provides recommendations and procedures for backing up and recovering 
database files.

Chapter 13, “Distributing and Managing Oracle Software”
Describes how to install Oracle7 Server products using Oracle Client Software 
Manager (OCSM), Oracle Software Manager (OSM), and Microsoft Systems 
Management Server (SMS).

Chapter 14, “Developing Applications”
Describes Windows NT-specific issues for applications developers.
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Chapter 15, “Using Oracle ConText Option”
Describes Oracle ConText Filters, Demos, and Oracle ConText Option 
Workbench components.

Appendix A, “Directory Structures”
Lists default directory structures for Oracle7 Server components installed on 
the Windows NT and Windows 95 operating systems.

Appendix B, “Initialization Parameter Files”
Describes Oracle7 Server initialization parameters, how to edit them, and 
Windows NT-specific defaults (and ranges) for them.

Appendix C, “Configuration Parameters and the Registry”
Describes the use of the registry for various Oracle7 Server components. 
Additionally, it lists the defaults and ranges for configuration parameters.

Appendix D, “Messages and Codes”
Lists the error messages, causes, and corrective actions specific to installing and 
using Oracle7 Server.

Appendix E, “National Language Support”
Explains the NLS_LANG configuration parameter and its components and lists 
the available options.

Appendix F, “Troubleshooting”
Describes how to diagnose and troubleshoot common error messages and how 
to contact Oracle Worldwide Customer Support if you cannot resolve these 
problems.
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Conventions
The following conventions are used in this guide:

Convention Example Meaning

All uppercase plain ORANT\DATABASE\INITORCL.ORA Indicates command names, SQL 
reserved words, and keywords, as in 
ALTER DATABASE. All uppercase 
plain is also used for directory names 
and file names.

Italic Italic used to indicate a variable:

C:\ORACLE_HOME\filename

Italic used for emphasis:

The WHERE clause may be used to join 
rows in different tables.

Indicates a value that you must provide. 
For example, if a command asks you to 
type filename, you must type the actual 
name of the file.

Italic is also used for emphasis in the 
text and to indicate the titles of other 
guides.

Horizontal ellipsis ... CHKVAL fieldname value 1 value 2... valueN Indicates that parts of the statement or 
command not directly related to the 
example have been omitted.

Vertical bar | ..DEFINE [  macro1 | macro2 ] Represents an ‘or’ option between 
several options. You must enter only one 
of the options. Do not enter the vertical 
bar. The set of alternative choices is 
enclosed by curly braces if one of the 
items is required, or by square brackets 
if the item is an optional alternative.

Curly braces {} ..DEFINE {  macro1 | macro2 } Encloses required items. You must 
choose one of the alternatives.

Square brackets [ ] cvtcrt termname [outfile] Encloses optional items. You can choose 
one or none of the alternatives. 

Square brackets also indicate a function 
key, for example [Enter].

C:\> C:\ORANT\DATABASE> Represents the Windows NT command 
prompt of the current hard disk drive. 
Your prompt may differ and may, at 
times, reflect the subdirectory in which 
you are working. Referred to as the MS-
DOS command prompt in this guide.
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Oracle home Go to the ORACLE_HOME\DATABASE 
directory.

SVRMGR> 
@%ORACLE_HOME%\RDBMS73\ADMIN\CATALOG.SQL

Oracle home is represented as the hard 
drive letter and the top level directory 
where your Oracle software is installed. 
In this guide, the convention 
ORACLE_HOME is used to indicate 
your Oracle home directory, which may 
be:

■ C:\ ORANT for Windows NT

■ C:\ ORAWIN95 for Windows 95

■ C:\ ORAWIN for Windows 3.1

or whatever you may have called your 
Oracle home.

In Server Manager commands, you may 
see %ORACLE_HOME%. Server 
Manager is able to locate your Oracle 
Home directory using the  
%ORACLE_HOME% variable. This 
convention can be used in Server 
Manager, SQL*Plus, Export, and Import.

Backslash (\) before 
a directory name

\DATABASE Indicates that the directory is a 
subdirectory of the root directory.

Symbols period  .

comma  ,

hyphen  -

semicolon  ;

colon  :

equal sign  =

backslash  \

single quote  ‘

double quote  “

parentheses ()

Symbols other than brackets and vertical 
bars must be entered in commands 
exactly as shown.

Convention Example Meaning
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1
Getting Started with Your Documentation

This chapter introduces you to the Oracle7 Server documentation set. Oracle 
Corporation recommends that you read this chapter before installing or using 
Oracle7 Server.

Specific topics discussed are:

■ Documentation Formats

■ What Documentation Did I Receive?

■ What Documentation Do I Read First?

■ Starting Oracle Information Navigator
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Documentation Formats
This table describes the format and availability of documents in your Oracle7 
Server package and the tools required to view them.

Document Format Document Availability Document Tools

HyperText Markup 
Language (HTML)

All Oracle documentation is 
available in HTML.

Use the included Oracle Information Navigator to 
view your HTML documentation set. For 
information on how to start Oracle Information 
Navigator, see the section, “Starting Oracle 
Information Navigator” in this chapter.

Printed ■ Oracle7 Server Getting 
Started Release 7.3.4 for 
Windows NT

■ Oracle Network Products 
Getting Started Release 
2.3.4 for Windows 
Platforms

■ Oracle Parallel Server 
Getting Started Release 
7.3.4 for Windows NT

■ Oracle7 Server 
Installation Release 7.3.4 
for Windows NT

The documentation in this list is included in your 
package as printed books. If you wish to order other 
printed books, please contact Oracle Documentation 
Sales at the following locations:

■ Telephone (1) (800) 252-0303 in the United 
States of America.

■ Visit: http://www.oracle.com/documentation/sales/

Note: Oracle documentation is not supplied in Portable 
Document Format (PDF) for this release. Legato documentation is 
supplied in PDF on the Oracle7 Server for Windows NT CD-ROM 
disc in the \LEGATO directory at the root level of the CD-ROM 
disc. The free Adobe Acrobat Reader is also included at the root 
level of the CD-ROM disc in the \ACROREAD directory.
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What Documentation Did I Receive?
Your documentation set consists of two types of documentation:   

Documentation Type Describes...

Platform-specific Installation, upgrading, configuration, and use of Oracle7 Server 
products in a Windows NT, Windows 95, or Windows 3.1 
environment. Platform-specific documents are occasionally 
referenced in the generic documentation set. Platform-specific 
documents are easy to identify because they always mention 
their specific operating system in the title.

Generic Oracle7 Server, networking information, and Application 
Programming Interfaces information that is uniform across all 
operating system platforms. The vast majority of documents in 
your documentation set belong to this category. While reading 
through the generic documentation set, you are occasionally 
asked to refer to your platform (or operating system) 
documentation for procedures specific to the Windows NT, 
Windows 95, or Windows 3.1 operating systems.

IMPORTANT: Documentation may be included in your package 
detailing products that you did not buy or license, or whose 
functionality is not included in the current release. The presence 
of such documentation does not mean that these products are 
included in your package.
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Online Documentation Set
Your Oracle online documentation set is divided into the following categories:

■ Installation

■ Oracle7 Server

■ Networking

■ Oracle Enterprise Manager

■ Application Programming Interfaces

■ Master Glossary

Installation
Oracle7 Server Installation Release 7.3.4 for Windows NT

Oracle7 Server

Oracle7 Server Documentation for Windows NT, Release 7.3.4   

Oracle7 Server Getting Started Release 7.3.4 for Windows NT (this guide)

Oracle Network Products Getting Started Release 2.3.4 for Windows Platforms

Oracle Parallel Server Getting Started Release 7.3.4 for Windows NT

SQL*Plus Getting Started Release 3.3.4 for Windows Platforms

Oracle Call Interface Getting Started Release 7.3.4 for Windows Platforms

Oracle Pro*C/C++ Getting Started Release 2.2.4 for Windows Platforms

Oracle Pro*COBOL Getting Started Release 1.8.4 for Windows Platforms
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Oracle7 Server Documentation, Release 7.3.4   

Oracle7 Server Concepts

Oracle7 Server Administrator’s Guide 

Oracle7 Server Reference

Oracle7 Server Utilities

Oracle7 Server Migration

Oracle7 Server Tuning

Oracle7 Server Error Messages

Oracle7 Server SQL Reference

Oracle7 Server Application Developer’s Guide 

PL/SQL User’s Guide and Reference

SQL*Plus User’s Guide and Reference

Oracle7 Server Distributed Database Systems  

Oracle7 Server Replication 

Oracle7 Parallel Server Concepts and Administrator’s Guide

Oracle Parallel Server Support for the Oracle Enterprise Manager Console

Oracle7 JDBC Drivers

Oracle Server Manager User’s Guide

SQL*DBA to Oracle Server Manager Migration Guide

Oracle Server Manager Release 2.3.2 Addendum

Oracle7 Spatial Data Option    

Oracle7 Spatial Data Option User's Guide and Reference

Oracle ConText Option   

Oracle ConText Option QuickStart

Oracle ConText Option Application Developer's Guide

Oracle ConText Option Administrator's Guide

Oracle ConText Option Messages

Oracle ConText Option Workbench
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Oracle Enterprise Manager Backup Utility   

Oracle7 Enterprise Backup Utility Administrator’s Guide

Oracle7 Enterprise Backup Utility Error and Diagnostics Manual

Networking
Oracle Advanced Networking Option Administrator’s Guide

Oracle Names Administrator’s Guide

Oracle Network Manager Administrator’s Guide

Oracle Network Products Troubleshooting Guide

Understanding SQL*Net

Oracle Enterprise Manager
Oracle Enterprise Manager Concepts Guide 

Oracle Enterprise Manager Administrator's Guide 

Oracle Enterprise Manager Messages Manual 

Oracle Enterprise Manager Oracle Expert User's Guide 

Oracle Enterprise Manager Oracle Trace User's Guide 

Oracle Enterprise Manager Oracle Trace Developer's Guide 

Oracle Enterprise Manager Performance Monitoring User's Guide 

Oracle Enterprise Manager Configuration Guide 

Oracle Enterprise Manager Application Developer’s Guide 

Application Programming Interfaces
Programmer's Guide to the Oracle Call Interface

Programmer's Guide to the Pro*C/C++ Precompiler

Programmer’s Guide to the Oracle Precompilers

Pro*COBOL Supplement to the Oracle Precompilers
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What Documentation Do I Read First?
This table lists the recommended order in which to start reading through your 
documentation set in order to quickly install and configure Oracle7 Server.

Read Documents in This Order... For Information On...

1. Customer Support Information Booklet How to obtain Customer Support 
information. This document is also available 
online at http://support.oracle.com/
support_guide/.

2. Oracle7 Server Installation Release 7.3.4 for Windows NT Installation instructions included in the CD-
ROM insert.

3. Oracle7 Server Getting Started Release 7.3.4 for Windows NT Post-installation, database upgrade, and 
configuration information for Oracle 
products.

4. Oracle Network Products Getting Started Release 2.3.4 for 
Windows Platforms

Oracle7 Server client/server networking 
environment, basic database networking 
concepts, network protocols, and Oracle 
Protocol Adapters.

5. Oracle7 Server Concepts Basic database concepts.

6. Oracle7 Server Administrator’s Guide Basic database administration.

7. Oracle Enterprise Manager Concepts Guide Instructions on using Oracle Enterprise 
Manager.

8. The remaining documentation in your documentation set 
in an order appropriate to your database or network 
administration expertise.
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Starting Oracle Information Navigator
Oracle Information Navigator enables you to search your entire documentation set 
for information on specific topics. Use Oracle Information Navigator to view your 
HTML documentation set on Windows NT and Windows 95. 

To start Oracle Information Navigator:

1. Install Oracle Documentation from the CD-ROM disc.

Oracle Information Navigator is automatically installed along with your Oracle 
Documentation.

2. Start Oracle Information Navigator: 

Your web browser is automatically started, and a welcome web page to the 
Oracle documentation set appears.

3. Use a browser that is Java-enabled and supports frames and tables to use 
Oracle Information Navigator.

Additional Information: See Oracle7 Server Installation Release 7.3.4 
for Windows NT for information on how to install Oracle products.

If Using... Then...

■ Windows NT 3.51

■ Windows 3.1

Double-click the Oracle Documentation icon in your Oracle for 
Windows NT Program Group

Windows NT 4.0 Choose Start>Programs>Oracle for Windows NT>Oracle 
Documentation
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4. Click the Java Version option on the welcome web page to launch Oracle 
Information Navigator.

Note: If you currently do not have an appropriate browser, you 
can obtain one at the following sites:

■ Netscape Navigator Version 3.0

Visit http://www.netscape.com

■ Microsoft Internet Explorer Version 3.0

Visit http://www.microsoft.com

If you do not have a Java-enabled browser, you can still access the 
Oracle online documentation by selecting the Text Version option 
on the welcome web page. However, you will not be able to use 
the Oracle Information Navigator with the Text Version option.

Click Java Version to 
launch Oracle 
Information Navigator
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Oracle Information Navigator appears:

5. Click the icon to access the online help for instructions on using Oracle 
Information Navigator.

Known Issues, Restrictions, and Workarounds
■ The Oracle Information Navigator and its HTML files cannot be viewed on 

Windows 3.1. Please use a 32-bit Microsoft operating system such as Windows 
NT and Windows 95 to view this information.

■ Recent changes to Microsoft’s Internet Explorer release 3.02 to address security 
issues may prevent the Oracle Information Navigator from starting and 
displaying properly. This does not affect your access to the Oracle online 
documentation.



                                                            Introducing Oracle7 Server 2-1

2
Introducing Oracle7 Server

This chapter introduces you to Oracle7 Server for Windows NT.

Specific topics discussed are:

■ What is Oracle7 Server?

■ New Features in This Release

■ What Products are on the CD-ROM?

■ Oracle7 and Oracle8 Database Coexistence and Migration
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What is Oracle7 Server?
Oracle7 Server for Windows NT is a release 7.3.4 Relational Database Management 
System (RDBMS). Oracle7 Server client and server software operates on a personal 
computer (PC), running one of the following operating systems:      

Key Features
Operating within the framework of Network Computing Architecture (NCA), 
Oracle7 Server for Windows NT provides:

■ Tight integration with the Windows NT Performance Monitor, Event Viewer, 
Registry, Service, and Security Login.

■ Automatic authentication of users by the Windows NT operating system.

■ Central, easy-to-use Graphical User Interface (GUI) distributed database 
management using Oracle Enterprise Manager.

This Operating System... Runs Oracle7 Server software? Runs Oracle7 Client software?

Windows NT Workstation Version 4.0 YES YES

Windows NT Workstation Version 3.51 YES YES

Windows NT Server Version 4.0 YES YES

Windows NT Server Version 3.51 YES YES

Windows 95 NO YES

Windows 3.1 NO YES

Windows for Workgroups 3.11 NO YES

Note: This guide describes only those features of Oracle7 Server 
that apply to the Windows NT, Windows 95, and Windows 3.1 
operating systems.
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New Features in This Release
This table describes the new features of Oracle7 Server specific to release 7.3.4 of 
Oracle7 Server for Windows NT. For a list of all new Oracle7 Server for Windows 
NT features, see Oracle7 Server Migration. 

New Features Description For More Information, See...

Oracle Parallel Server Option Provides the ability to run multiple 
Oracle instances on a single Oracle 
database. This option requires a separate 
license.

■ Oracle7 Server Installation 
Release 7.3.4 for Windows NT

■ Oracle Parallel Server Getting 
Started Release 7.3.4 for 
Windows NT

■ Oracle Parallel Server Release 
Notes Release 7.3.4 for 
Windows NT

Enterprise Backup Utility (EBU) Provides an effective mechanism to 
back up, restore, and recover all types 
of Oracle database files. This utility is 
specifically designed to back up very 
large databases. EBU requires a 
media management layer such as 
Legato Storage Manager, which is 
included on the Oracle7 Server for 
Windows NT CD-ROM disc.

■ Oracle7 Server Installation 
Release 7.3.4 for Windows NT

■ Oracle7 Enterprise Backup 
Utility Administrator’s Guide

■ Oracle7 Enterprise Backup 
Utility Error and Diagnostic 
Manual

■ Chapter 12, “Backing Up 
and Recovering Database 
Files”

JDK Java Database Connectivity 
(JDBC) Thin Driver 1.0 and 1.1

A Type 4 driver that uses Java 
sockets to connect directly to an 
Oracle7 database. It provides its own 
implementation of a TCP/IP version 
of Oracle’s SQL*Net. Because this 
software is written entirely in Java, it 
is platform-independent.

The JDBC Thin driver facilitates 
connections to any Oracle7 database 
version 7.2.x and later. It does not 
require Oracle software on the client 
side. The JDBC Thin driver requires a 
TCP/IP listener on the server side.

Oracle7 JDBC Drivers
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What Products are on the CD-ROM?
When you run Oracle Installer, a dialog box displays several product installation 
options. When you select an option for installation, a group of products are 
automatically installed. The installation options that display depend upon the 
operating system you are using. 

JDK Java Database Connectivity 
(JDBC) OCI Driver 1.0 and 1.1

A Type 2 driver. It provides an 
implementation of the JDBC 
interfaces that uses the Oracle Call 
Interface (OCI) to interact with an 
Oracle7 database. The driver can 
access Oracle7 databases version 7.x 
and later. Because this software uses 
native methods, it is platform-specific. 
The supported platforms are 
Windows NT 3.51, Windows NT 4.0, 
and Windows 95.

The JDBC OCI driver requires an 
Oracle 7.3.4 client installation 
including SQL*Net and all other 
dependent files.

Oracle7 JDBC Drivers

Installation Options Operating System

Oracle7 Server

Oracle7 Client

Custom Installation

Windows NT

Oracle7 Client

Custom Installation

Windows 95

Oracle7 Client

Custom Installation

Windows 3.1

New Features Description For More Information, See...
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Although the CD-ROM disc in your kit contains many Oracle products, you may 
install and use only those products for which you have purchased licenses. For 
additional licensing information, refer to the Global License Terms booklet in your kit.

The products in this table are listed according to the product installation options, of 
which they are a part, for each operating system (OS) on the Oracle7 Server for 
Windows NT CD-ROM disc.     

Note: If you purchased Oracle WebServer, please install the 
Oracle WebServer CD-ROM disc before installing the Oracle7 
Server for Windows NT CD-ROM disc. 

If you attempt to install the Oracle WebServer CD-ROM disc after 
installing the Oracle7 Server for Windows NT CD-ROM disc, 
dialog boxes appear requesting if you want to downgrade the 
software components. Please select No to those messages.

Oracle7 Products Installation Options Available on Each OS

Oracle7 Server 
on Windows NT

Oracle7 
Client on 
Windows NT, 
Windows 95, 
and 
Windows 3.1

Custom 
Installation 
on Windows 
NT, Windows 
95, and 
Windows 3.1

Oracle Installer 3.2 and 3.1

A graphical user interface (GUI) application that lets you 
quickly install, update, and remove Oracle products.

Note:  Oracle Installer is version 3.1 on Windows 3.1.

Yes Yes Yes

Oracle Online Documentation 7.3

Available in HTML, viewable using a web browser.

Yes Yes Yes

Oracle7 Server 7.3

The database component of Oracle7 Server for Windows NT 
software.

Yes No Yes
Only NT
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Required Support Files 7.2 and 7.1

Required Support Files version 7.2 and 7.1 can be installed on 
Windows NT, Windows 95, and Windows 3.1 clients but are 
only available for installation through the \RSF_ARCHIVE 
directory at the root level of the CD-ROM disc. Oracle 
Corporation provides Required Support Files version 7.2 and 
7.1 for third party applications linked with them.

No No No

Required Support Files 7.3

Required Support Files version 7.3 can be installed from each 
installation option. 

Yes Yes Yes

Oracle Enterprise Backup Utility 2.2

Backs up, restores, and recovers all types of Oracle database 
files. 

Yes No Yes

Only NT

Oracle Migration Wizard for Microsoft Access 1.5

Provides complete and easy migration of schema and/or data 
from your Microsoft Access database to an Oracle7 database.

Yes Yes

Not 3.1

Yes

Oracle7 Utilities 7.3

A suite of products used for database administration. Oracle7 
Utilities include NT Instance Manager, ORADIM73, Server 
Manager, Export Utility, Import Utility, SQL*Loader, 
DBVERIFY, NT Backup Manager, NT Recovery Manager, 
TKPROF, Enterprise Backup Manager, and the Password 
Utility. 

Yes Yes

Not 3.1

Yes

Not 3.1

 JDK JDBC Thin Driver 1.0 and 1.1

Appropriate for use by Java applets that can be downloaded 
in a web browser. The JDBC Thin Client Driver provides a 
direct connection from the web browser to the database by 
emulating SQL*Net and TTC (the wire protocol used by 
Oracle Call Interface [OCI]) on top of Java sockets. This driver 
works for Oracle7 version 7.2 and later.

No No Yes

Not 3.1

Oracle7 Products Installation Options Available on Each OS

Oracle7 Server 
on Windows NT

Oracle7 
Client on 
Windows NT, 
Windows 95, 
and 
Windows 3.1

Custom 
Installation 
on Windows 
NT, Windows 
95, and 
Windows 3.1
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JDK JDBC OCI Driver 1.0 and 1.1

The OCI based drivers are appropriate for use by Java 
applications, which include the Oracle WebServer Java 
Cartridge, or any other Java middle tier. The OCI JDBC 
Drivers call OCI directly from Java to connect to the database.

No No Yes

Not 3.1

Oracle Parallel Server Option 7.3

Provides the ability to run multiple Oracle instances on a 
single Oracle database. This product requires a separate license.

Yes No Yes

Only NT

Oracle Parallel Server Manager Server 7.3

Runs on an Oracle server to enable Oracle Enterprise 
Manager to manage multiple parallel server instances.

Yes No Yes

Only NT

Oracle Parallel Server Manager Client 7.3

Runs on a cluster console to enable Oracle Enterprise 
Manager to manage multiple parallel server instances.

No No Yes

Only NT

Oracle ConText Option 2.3

Enables text queries to be performed through SQL and PL/
SQL from most Oracle interfaces. By installing Oracle 
ConText Option with an Oracle7 Server, client tools such as 
SQL*Plus, Oracle Forms, and Pro*C are able to retrieve and 
manipulate text in an Oracle database. Oracle ConText 
Option manages textual data in association with traditional 
datatypes in an Oracle database. When text is inserted, 
updated, or deleted, Oracle ConText Option automatically 
manages the change. This product requires a separate license. If 
you select Oracle ConText Option, Oracle ConText Option 
Filters are also installed.

Yes No Yes

NT only

Oracle ConText Option Workbench 2.3

A suite of products used in conjunction with Oracle ConText 
Option to enhance viewing, storage, and manipulation of text 
data. If you select Oracle ConText Option Workbench, the 
following components are installed.

Yes No Yes

Not 3.1

Oracle7 Products Installation Options Available on Each OS

Oracle7 Server 
on Windows NT

Oracle7 
Client on 
Windows NT, 
Windows 95, 
and 
Windows 3.1

Custom 
Installation 
on Windows 
NT, Windows 
95, and 
Windows 3.1
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Oracle ConText Option System Administration 2.3

A GUI application that can be used to perform system and 
text administration tasks.

Yes No Yes

Not 3.1

Oracle ConText Option Viewer 2.3

A document viewer supplied as a custom control (OCX), 
which can be embedded in any application developed in an 
environment, such as Visual Basic and Visual C++, that 
supports custom controls.

No No Yes

Not 3.1

Oracle ConText Option Viewer Cartridge 2.3

A Java web server cartridge that packages data for viewing 
using the web browser plugin, and provides generic 
facilities for downloading large data types from the 
database to a web browser.

No No Yes

Not 3.1

Oracle ConText Option I/O Utility 2.3

A stand-alone executable that can be used to load text to a 
database column, load text from a column into a file, 
execute SQL and PL/SQL code, and call other executables 
from the MS-DOS command prompt.

Yes No Yes

Not 3.1

Oracle ConText Option Configuration Manager 2.3

A web application for administering Oracle ConText 
Option and managing the text objects in the Oracle 
ConText Option data dictionary on non-Windows 
platforms, including network computers (NCs).

No No Yes

Not 3.1

TextServer3 Migration Tool

This is not an installable product. The TextServer3 
Migration Tool is a PL/SQL package that must be created 
after Oracle ConText Option and the Oracle ConText 
Workbench (as well as SQL*Net and SQL*Plus) have been 
installed. See Oracle ConText Option Workbench User’s Guide 
for details on how to install and use the Migration Tool.

No No No

Oracle7 Products Installation Options Available on Each OS

Oracle7 Server 
on Windows NT

Oracle7 
Client on 
Windows NT, 
Windows 95, 
and 
Windows 3.1

Custom 
Installation 
on Windows 
NT, Windows 
95, and 
Windows 3.1
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Oracle ConText Option Demos 2.3

A sample application illustrating the text querying and 
retrieval capabilities of Oracle ConText Option and Oracle7 
Server. 

Yes No Yes

Not 3.1

Oracle7 Spatial Data Option 7.3

Makes the storage, retrieval, and manipulation of spatial data 
easier and more natural to users. Once spatial data is stored 
in an Oracle7 database, it can be easily and meaningfully 
manipulated and retrieved as it relates to all the other data 
stored in the database. This product requires a separate license.

Yes No Yes

Only NT

Oracle7 Spatial Data Option Utilities 7.3

A suite of tools that manage spatial data in an Oracle 
database.

Yes No Yes

Only NT

Oracle7 Performance Utility 1.1

Enables Database Administrators to monitor local and remote 
database performance through the Windows NT Performance 
Monitor.

Yes No Yes

Only NT

Open Database Connectivity Driver (ODBC) Driver 2.5

Provides support for ODBC connections from Windows NT 
and Windows 95 client systems to Oracle7 databases.

Yes Yes Yes

Oracle Call Interface 7.3

An application programming interface (API) for accessing an 
Oracle database from a C or C++ program. You make calls 
directly to the OCI functions from within your C or C++ 
program to direct the execution of your SQL statements.

Yes Yes Yes

Oracle Objects for Object Linking and Embedding (OLE) 2.2

Provides a custom control (OCX or ActiveX) combined with 
an OLE in-process server that lets you plug native Oracle7 
Server functionality into your Windows applications.

Yes Yes

Not 3.1

Yes

Oracle7 Products Installation Options Available on Each OS

Oracle7 Server 
on Windows NT

Oracle7 
Client on 
Windows NT, 
Windows 95, 
and 
Windows 3.1

Custom 
Installation 
on Windows 
NT, Windows 
95, and 
Windows 3.1
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SQL*Plus 3.3

Enables you to use the SQL and PL/SQL database languages 
in the Windows NT, Windows 95, and Windows 3.1 
environments. SQL*Plus has both a command line and 
graphical user interface.

Yes Yes Yes

Oracle WebServer Manager 1.0

Performs the most common web administrative tasks through 
web pages. Web administrative tasks include creating, 
modifying, deleting, Database Connection Descriptors 
(DCDs).

No No Yes

Not 3.1

Oracle Biometrics Manager 2.3

Administers the Oracle Fingerprint Security Service for the 
Advanced Networking Option.

No No Yes

Only NT

Oracle Enterprise Manager 1.3

Combines a graphical console, agent processes, and common 
services to provide an integrated, comprehensive systems 
management platform for managing distributed databases 
and networks.

Yes Yes

Not 3.1

Yes

Not 3.1

Oracle Administrator Toolbar 1.3

Enables you to execute commands and run applications in 
Oracle Enterprise Manager.

Yes Yes

Not 3.1

Yes

Not 3.1

Oracle Enterprise Manager Software Development Kit 
(SDK) 1.3

Provides sample source files, libraries, and header files for 
integrating new applications into the Oracle Enterprise 
Manager Console.

Yes Yes

Not 3.1

Yes

Not 3.1

Oracle7 Products Installation Options Available on Each OS

Oracle7 Server 
on Windows NT

Oracle7 
Client on 
Windows NT, 
Windows 95, 
and 
Windows 3.1

Custom 
Installation 
on Windows 
NT, Windows 
95, and 
Windows 3.1
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Oracle Client Software Manager (OCSM) 3.2 and 3.1

Enables System Administrators to install and configure 
Oracle products on a server for access by multiple client 
workstations.

Oracle Client Software Agent 3.2 and 3.1

Used to bring the client workstation up-to-date with 
respect to the OCSM host.

Oracle Client Configuration Manager 3.2 and 3.1

Used to define client configurations.

No No Yes

Oracle Replication Manager 1.3

Simplifies the complex tasks of managing and maintaining 
multiple copies of data in a distributed environment. The 
application provides immediate local access to data and 
allows local systems to function automatically, even when 
networks or other systems in the environment fail.

Yes Yes

Not 3.1

Yes

Not 3.1

Oracle Intelligent Agent 7.3

Responds to, schedules, and executes database administration 
job requests initiated by the Oracle Enterprise Manger 
Console.

Yes No Yes

Only NT

Oracle Network Manager 3.1

Performs network administration.

No Yes

Only 3.1

Yes

Only 3.1

SQL*Net Products 2.3

A software layer that is required to communicate between 
Oracle clients and servers. It provides both client-server and 
server-server communications across any network. It enables 
client tools to access, modify, share, and store data on Oracle7 
Servers over a network. See Oracle Network Products Getting 
Started Release 2.3.4 for Windows Platforms for detailed 
information on each SQL*Net product.

Yes Yes Yes

Oracle7 Products Installation Options Available on Each OS

Oracle7 Server 
on Windows NT

Oracle7 
Client on 
Windows NT, 
Windows 95, 
and 
Windows 3.1

Custom 
Installation 
on Windows 
NT, Windows 
95, and 
Windows 3.1
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Oracle Names Server 2.0

A transparent naming service used to centrally manage 
name and address resolution in a heterogeneous network 
with different protocols to resolve names. It stores network 
names and addresses so that network components can 
contact one another easily without regard to their physical 
locations or specific configurations on the network.

Yes No Yes

Only NT

SQL*Net Client 2.3

SQL*Net client software.

Yes Yes Yes

SQL*Net Server 2.3

SQL*Net server software.

Yes No Yes

Only NT

Oracle Protocol Adapters 2.3

Oracle Protocol Adapters are responsible for mapping 
Transparent Network Substrate (TNS) functionality to 
industry-standard protocols used in the client/server 
connection. Each protocol adapter is responsible for mapping 
the equivalent functions between TNS and a specific protocol. 
See Oracle Network Products Getting Started Release 2.3.4 for 
Windows Platforms for detailed information on each protocol 
adapter.

Yes Yes Yes

Oracle TCP/IP Protocol Adapter 2.3

Enables client/server conversation over a network using 
TCP/IP and SQL*Net. This combination of Oracle products 
enables an Oracle application on a client to communicate 
with remote Oracle databases through TCP/IP (if the 
Oracle database is running on a host system that supports 
network communication using TCP/IP).

Yes Yes Yes

Oracle SPX Protocol Adapter 2.3

Enables client/server conversation over a network using 
SPX/IPX and SQL*Net. This combination of Oracle 
products enables an Oracle application on a client to 
communicate with remote Oracle databases through SPX/
IPX (if the Oracle database is running on a host system that 
supports network communication using SPX/IPX).

Yes Yes Yes

Oracle7 Products Installation Options Available on Each OS

Oracle7 Server 
on Windows NT

Oracle7 
Client on 
Windows NT, 
Windows 95, 
and 
Windows 3.1

Custom 
Installation 
on Windows 
NT, Windows 
95, and 
Windows 3.1
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Oracle Named Pipes Protocol Adapter 2.3

Enables client/server conversation over a network using 
Named Pipes and SQL*Net. This combination of Oracle 
products enables an Oracle application on a client to 
communicate with remote Oracle databases through 
Named Pipes (if the Oracle database is running on a host 
system that supports network communication using 
Named Pipes).

Yes Yes Yes

Oracle LU6.2 Protocol Adapter 2.3

IBM’s Advanced Program-to-Program Communication 
(APPC) architecture. APPC is the IBM peer-to-peer 
(program-to-program) protocol for a System Network 
Architecture (SNA) network. SNA is an IBM reference 
model similar to the Open Systems Interconnect (OSI) 
model of the International Standards Organization (ISO).

Yes Yes

Not 95

Yes

Not 95

Oracle NetBIOS Protocol Adapter 2.3

An API that defines process-to-process communications on 
a PC local area network (LAN).

The Oracle NetBIOS Protocol Adapter for Windows lets an 
Oracle application on a Windows client machine 
communicate with remote Oracle7 databases using 
NetBIOS.

No Yes

Only 3.1

Yes

Only 3.1

Oracle DECnet Protocol Adapter 2.3

Enables client/server conversation over a network using 
DECnet and SQL*Net. DECnet is the networking and 
proprietary communication protocol of Digital Equipment 
Corporation.

Yes

Only NT 3.51

Yes

Only NT 
3.51 and 3.1

Yes

Only NT 
3.51 and 3.1

Oracle7 Products Installation Options Available on Each OS

Oracle7 Server 
on Windows NT

Oracle7 
Client on 
Windows NT, 
Windows 95, 
and 
Windows 3.1

Custom 
Installation 
on Windows 
NT, Windows 
95, and 
Windows 3.1
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Oracle7 and Oracle8 Database Coexistence and Migration
This section describes what you can do with your Oracle7 database if you have an 
existing Oracle8 database or subsequently decide to install an Oracle8 database. 

IMPORTANT: Oracle8 Enterprise Edition is not available on the 
Oracle7 Server for Windows NT CD-ROM disc and is not 
included in your kit on a separate disc. Oracle8 Enterprise 
Edition is available as a separately purchasable product. This 
section is an overview of coexistence and migration options for 
users who purchase Oracle8 Enterprise Edition.

Coexistence and Migration Options For More Information, See...

Install an Oracle8 database into the same Oracle 
home as your existing Oracle7 database and 
have both Oracle7 and Oracle8 clients 
connecting to both databases. This procedure is 
known as coexistence.

Oracle8 Enterprise Edition Getting 
Started for Windows NT 

Install Oracle7 and Oracle8 databases on 
separate servers and have both Oracle7 and 
Oracle8 clients connecting to both databases. 

Oracle8 Enterprise Edition Getting 
Started for Windows NT 

Migrate your data from the Oracle7 database to 
the Oracle8 database; that is, move data from 
the Oracle7 database to the Oracle8 database, 
and have both Oracle7 and Oracle8 clients 
connecting to the Oracle8 database. This 
procedure is known as migration. You can use a 
migration wizard included on the Oracle8 
Enterprise Edition CD-ROM disc to easily 
migrate your Oracle7 data to an Oracle8 
database. 

Oracle8 Enterprise Edition Getting 
Started for Windows NT 

Upgrade some or all of your Oracle7 clients to 
Oracle8 and migrate your Oracle7 database to 
an Oracle8 database at a later date. 

Oracle Networking Products Getting 
Started for Windows Platforms
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3
Database Tools

Oracle7 Server includes various tools to perform database administration. This 
chapter describes the preferred tools to perform common database administration 
tasks.

Specific topics discussed are:

■ Choosing Which Database Tools to Use

■ Starting Database Tools

■ Using NT Instance Manager from the Command Line (ORADIM73)

■ Using SQL*Loader with Windows NT
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Choosing Which Database Tools to Use
Database tools is a collective term for a number of tools, utilities, and wizards that 
you can use to perform database administration. Some database tools perform the 
same tasks, though no one database tool performs all database administration 
tasks. The following sections indicate which database tools can be used on 
particular operating systems and the preferred tools to use for common database 
administration tasks.

Database Tools and Operating System Compatibility
This table lists database tools and the operating system on which each can be used.  

Database Tools Oracle7 Server 
on Windows NT

Oracle7 Client 
on Windows NT

Oracle7 Client 
on Windows 95

Oracle7 Client 
on Windows 3.1

Oracle7 Utilities

NT Instance Manager (ORADIM73)1
Yes No No No

Server Manager (SVRMGR23) Yes Yes Yes No

Export (EXP73) Yes Yes Yes No

Import (IMP73) Yes Yes Yes No

SQL*Loader (SQLLDR73) Yes Yes Yes No

Password Utility (ORAPWD73)2
Yes No No No

OCOPY73 Yes Yes Yes No

TKPROF73 Yes Yes Yes No

DBVERF73 Yes Yes Yes No

Oracle7 Enterprise Backup Utility 
(EBU) 

Yes No No No

NT Backup Manager3
Yes No No No

NT Recovery Manager Yes No No No

Windows NT Tools

User Manager Yes Yes No No

Control Panel Yes Yes No No

Event Viewer Yes Yes No No

Performance Monitor Yes Yes No No
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1 NT Instance Manager is a graphical user interface (GUI) tool. It is also available in command line mode (ORADIM73). 
Instance Manager (both command line and GUI) is referred to as NT Instance Manager to distinguish it from Instance 
Manager, available through Oracle Enterprise Manager. NT Instance Manager only operates on local databases.

2 ORAPWD73 does not work on password files for remote databases.
3 NT Backup Manager and NT Recovery Manager are Oracle Corporation products, distinct from the NT Backup Tool 

available with your Windows NT operating system.

Oracle Enterprise Manager

Instance Manager Yes Yes Yes No

Data Manager Yes Yes Yes No

Storage Manager Yes Yes Yes No

Schema Manager Yes Yes Yes No

Security Manager Yes Yes Yes No

Backup Manager Yes Yes Yes No

SQL Worksheet Yes Yes Yes No

Oracle Wizard

Oracle Migration Wizard for 
Microsoft Access

Yes Yes Yes Yes

SQL*Plus Yes Yes Yes Yes

Database Tools Oracle7 Server 
on Windows NT

Oracle7 Client 
on Windows NT

Oracle7 Client 
on Windows 95

Oracle7 Client 
on Windows 3.1



Choosing Which Database Tools to Use

3-4 Oracle7 Server Getting Started Release 7.3.4 for Windows NT                                                   

Preferred Database Tools
This table lists the various database tools you can use to perform common database 
administration tasks. Oracle Corporation recommends that you use the tools listed 
in the “Preferred Database Tool” column of the table. After choosing a tool to 
perform a task, go to the section, “Starting Database Tools” in this chapter for 
instructions on how to start the tool. 

Database Administration Task Preferred Database Tool Other Database Tools

Create a database1 CREATE DATABASE SQL statement 
using Server Manager

■ NT Instance Manager

■ ORADIM73 and Server 
Manager together

■ SQL Worksheet

Delete a database1 ORADIM73 and Server Manager 
together

NT Instance Manager

Delete a database service1 ORADIM73

Start a database Instance Manager ■ ORADIM73 and Server 
Manager together

■ NT Instance Manager2

■ SQL Worksheet

Shut down a database Instance Manager ■ ORADIM73 and Server 
Manager together

■ Control Panel

■ SQL Worksheet

Change internal database passwords ORAPWD73 ORADIM733

Upgrade a database to the current version Run provided scripts in Server 
Manager

Export data Data Manager Export Utility

Import data Data Manager Import Utility

Load data Data Manager SQL*Loader

Back up database Backup Manager ■ EBU

■ NT Backup Manager

■ OCOPY734

Recover database Backup Manager ■ OCOPY734

■ NT Recovery Manager

Authenticate Database Administrators 
and users

Security Manager ■ Server Manager

■ SQL*Plus

■ SQL Worksheet

■ Windows NT operating system

Grant database roles Security Manager User Manager
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Starting Database Tools
This section describes how to start each of the database tools in the following 
categories:

■ Oracle7 Utilities

■ Windows NT Tools

■ Oracle Enterprise Manager Tools

■ Oracle Wizard

■ SQL*Plus 

You will frequently be referred back to this section for database tool startup 
procedures as you use this guide.

1 You cannot perform this operation on a remote database.
2 Instance Manager can start up and shut down a database and perform other limited functions. This tool cannot be used to 

create databases services, or create and delete databases.
3 ORADIM73 can only set a password when none was previously set. If a password has been previously set, ORADIM73 

cannot change it. Also, ORADIM73 can change a password by deleting and recreating the Oracle7 Server services.
4 Do not back up files while you are shutting down the database, otherwise your backup will be invalid. You cannot use an 

invalid backup to restore files at a later date.
5 See Oracle7 Server Administrator’s Guide for guidelines on creating database objects. In particular, see Appendix A, “Space 

Estimations for Schema Objects” which provides equations for estimating the space requirements for clusters, nonclustered 
tables, and indexes. Windows NT uses the same fixed header, transaction header, and row header constants described in 
that guide. 

Create database objects5 Schema Manager ■ Server Manager

■ SQL*Plus

Database Administration Task Preferred Database Tool Other Database Tools
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Oracle7 Utilities
This table describes how to start each Oracle7 Utility, and where to go for further 
information on using these products.    

Oracle7 Utilities To Start... For More Information, See...

NT Instance 
Manager (GUI 
mode)

■ On Windows NT 3.51, double-click the Oracle 
NT Instance Manager icon in the Oracle for 
Windows NT Program Group

■ On Windows NT 4.0, choose 
Start>Programs>Oracle for Windows NT>NT 
Instance Manager

■ Enter the following without any parameters at 
the command prompt:

C:\> ORADIM73

The online help for NT Instance 
Manager

NT Instance 
Manager 
(ORADIM73, 
command line 
mode)

Enter the following with parameters at the MS-DOS 
command prompt:

C:\> ORADIM73 PARAMETERS

To get a complete listing of ORADIM73 parameters, 
enter a question mark preceded by a dash after the 
executable name:

C:\> ORADIM73 -?

Note...  If you enter ORADIM73 without parameters 
at the MS-DOS command prompt, a GUI NT 
Instance Manager screen appears. 

The section, “Using NT Instance 
Manager from the Command Line 
(ORADIM73)” in this chapter

Server Manager 
(Line mode only)

Enter the following at the MS-DOS command 
prompt:

C:\> SVRMGR23

■ Oracle Server Manager User’s 
Guide

■ Chapter 10, “Administering a 
Database”, which contains 
examples of starting and 
stopping the database with 
Server Manager
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Export Utility Enter the following at the MS-DOS command 
prompt followed by your user name and password.

C:\> EXP73

EXP73 runs and prompts you for parameters. To 
obtain a list of these parameters, enter the following 
at the MS-DOS command prompt:

C:\> EXP73 HELP=Y

Note...  When running the Export utility, the default 
values for the following parameters under Windows 
NT are:

BUFFER 4 KB

RECORDLENGTH 2 KB

Note...  To export an entire database, you must use 
the user name SYSTEM. Do not use INTERNAL or 
SYS.

■ Oracle7 Server Utilities, which 
describes how to use the 
Export utility

■ Oracle7 Server Messages for 
information on error messages

Import Utility Enter the following at the MS-DOS command 
prompt followed by your user name and password.

C:\> IMP73

IMP73 runs and prompts you for parameters. To 
obtain a list of these parameters, enter the following 
at the MS-DOS command prompt:

C:\> IMP73 HELP=Y

Note...  When running the Import utility, the default 
values for the following parameters under Windows 
NT are:

BUFFER 4 KB

RECORDLENGTH 2 KB

■ Oracle7 Server Utilities, which 
describes how to use the 
Import utility

■ Oracle7 Server Messages for 
information on error messages

SQL*Loader Invoke SQL*Loader at the MS-DOS command 
prompt followed by certain keywords. Enter the 
following and SQL*Loader displays a Help screen 
with the available keywords and default values.

C:\> SQLLDR73

■ Oracle7 Server Utilities, which 
describes how to use the 
SQL*Loader utility

■ Oracle7 Server Messages for 
information on error messages

■ The section, “Using 
SQL*Loader with Windows 
NT” in this chapter

Oracle7 Utilities To Start... For More Information, See...
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Password Utility Enter the following at the MS-DOS command 
prompt:

C:\> ORAPWD73 FILE=FILENAME PASSWORD=PASSWORD 
ENTRIES=USERS

where:

■ FILENAME is the password file name for the 
instance

■ PASSWORD is the logon password for the 
instance

■ USERS is the maximum number of users

Oracle7 Server Administrator’s 
Guide, which describes how to use 
the Password Utility

OCOPY73 Enter the following at the MS-DOS command 
prompt.

C:\> OCOPY73

Chapter 12, “Backing Up and 
Recovering Database Files”

DBVERIFY Enter the following at the MS-DOS command 
prompt:

C:\> DBVERF73

DBVERIFY runs and prompts you for a filename 
parameter. To obtain a list of parameters, enter the 
following at the MS-DOS command prompt:

C:\> DBVERF73 HELP=Y

Oracle7 Server Utilities

TKPROF Enter the following at the MS-DOS command 
prompt:

C:\> TKPROF73

Oracle7 Server Tuning

EBU Enter the following at the MS-DOS command 
prompt:

C:\> EBU.EXE

■ Chapter 12, “Backing Up and 
Recovering Database Files”

■ Oracle7 Server Installation 
Release 7.3.4 for Windows NT

NT Backup 
Manager

■ On Windows NT 3.51, double-click the NT 
Backup Manager icon in the Oracle for 
Windows NT Program Group

■ On Windows NT 4.0, choose 
Start>Programs>Oracle for Windows NT>NT 
Backup Manager

Online help included with this tool

Oracle7 Utilities To Start... For More Information, See...
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Windows NT Tools
This table describes how to start each Windows NT tool, and where to go for 
further information on using these products.

NT Recovery 
Manager

■ On Windows NT 3.51, double-click the NT 
Recovery Manager icon in the Oracle for 
Windows NT Program Group

■ On Windows NT 4.0, choose 
Start>Programs>Oracle for Windows NT>NT 
Recovery Manager

Online help included with this tool

Windows NT Tools To Start... For More Information, See...

User Manager ■ On Windows NT 3.51, double-click the 
User Manager icon in the Administrative 
Tools Program Group

■ On Windows NT 4.0, choose 
Start>Programs>Administrative 
Tools>User Manager

■ Chapter 4, “Oracle7 Server 
Integration with Windows 
NT”

■ Chapter 10, “Administering a 
Database”

■ Your Microsoft Windows NT 
documentation

Control Panel ■ On Windows NT 3.51, double-click the 
Control Panel icon in the Main Program 
Group

■ On Windows NT 4.0, choose 
Start>Settings>Control Panel

■ Chapter 4, “Oracle7 Server 
Integration with Windows 
NT”

■ Chapter 10, “Administering a 
Database”

■ Your Microsoft Windows NT 
documentation

Event Viewer ■ On Windows NT 3.51, double-click the 
Event Viewer icon in the Administrative 
Tools Program Group

■ On Windows NT 4.0, choose 
Start>Programs>Administrative 
Tools>Event Viewer

■ Chapter 4, “Oracle7 Server 
Integration with Windows 
NT”

■ Chapter 10, “Administering a 
Database”

■ Your Microsoft Windows NT 
documentation

Performance Monitor ■ On Windows NT 3.51, double-click the 
Performance Monitor icon in the 
Administrative Tools Program Group

■ On Windows NT 4.0, choose 
Start>Programs>Performance Monitor

■ Chapter 4, “Oracle7 Server 
Integration with Windows 
NT”

■ Chapter 11, “Monitoring a 
Database”

■ Your Microsoft Windows NT 
documentation

Oracle7 Utilities To Start... For More Information, See...



Starting Database Tools

3-10 Oracle7 Server Getting Started Release 7.3.4 for Windows NT                                                   

Oracle Enterprise Manager Tools
You can start Oracle Enterprise Manager tools:

■ as separate applications

■ from the Oracle Enterprise Manager Console

To start an Oracle Enterprise Manager tool separately:

The Login Information dialog box appears:

1. Enter the connect information in the Login Information dialog box.  

To start an Oracle Enterprise Manager tool from the Console:

1. Choose Start>Programs>Oracle Enterprise Manager.

2. Log on when prompted.

3. You can now either:

If Using... Then...

Windows NT 3.51 Double-click the Oracle Enterprise Manager icon in your 
Program Group

Windows NT 4.0 Choose Start>Programs>Oracle Enterprise Manager. For 
example, Start>Programs>Oracle Enterprise 
Manager>Instance Manager.

Additional Information: See the section, “Configuring Oracle 
Enterprise Manager” in Chapter 8, “Configuration Tasks” for 
information on configuration tasks you must perform before using 
Oracle Enterprise Manager and information on how to connect to 
the Oracle7 database.
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■ Select the database you want to administer in the Navigator tree or in the 
Map window, then choose the tool in the Console Tools menu or in the 
Launch Palette.

■ Select the database you want to administer in the Navigator tree, then 
choose the tool from the Related Tools menu of the context-sensitive menu.

■ Choose the application in the Console Tools menu or in the Launch Palette, 
then enter the connect information in the Login Information dialog box.

The following table describes how to start each Oracle Enterprise Manager tool 
through the Console, and where to go for further information on using these tools. 

Note: When you select a database before starting a tool, you are 
connected to the database according to the preferred credentials 
that have been set up for the database or the credentials you used 
to log on to the Console. If connection to the database fails for any 
reason, the Login Information dialog box appears.

Oracle Enterprise 
Manager Tools

To Start... For More Information, See...

Instance Manager ■ On Windows NT 3.51, double-click the Instance 
Manager icon in the Oracle Enterprise Manager 
Program Group

■ On Windows NT 4.0, choose View>Launch 
Palettes>Applications. The Applications palette 
appears. Click the Instance Manager icon, or 
choose Tools>Applications>Instance Manager

The section, “Starting Instance 
Manager” in Chapter 10, 
“Managing Instances and 
Sessions” of Oracle Enterprise 
Manager Administrator’s Guide

Data Manager ■ On Windows NT 3.51, double-click the Data 
Manager icon in the Oracle Enterprise Manager 
Program Group

■ On Windows NT 4.0, choose View>Launch 
Palettes>Applications. The Applications palette 
appears. Click the Data Manager icon, or choose 
Tools>Applications>Data Manager

The section, “Starting Data 
Manager” in Chapter 14, 
“Managing and Moving Data” of 
Oracle Enterprise Manager 
Administrator’s Guide
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Schema Manager ■ On Windows NT 3.51, double-click the Schema 
Manager icon in the Oracle Enterprise Manager 
Program Group

■ On Windows NT 4.0, choose View>Launch 
Palettes>Applications. The Applications palette 
appears. Click the Schema Manager icon, or 
Choose Tools>Applications>Schema Manager

The section, “Starting Schema 
Manager” in Chapter 11, 
“Managing Schema Objects” of 
Oracle Enterprise Manager 
Administrator’s Guide

Security Manager ■ On Windows NT 3.51, double-click the Security 
Manager icon in the Oracle Enterprise Manager 
Program Group

■ On Windows NT 4.0, choose View>Launch 
Palettes>Applications. The Applications palette 
appears. Click the Security Manager icon, or 
Choose Tools>Applications>Security Manager

The section, “Starting Security 
Manager” in Chapter 9, 
“Controlling Database Security” 
of Oracle Enterprise Manager 
Administrator’s Guide

Backup Manager ■ On Windows NT 3.51, double-click the Backup 
Manager icon in the Oracle Enterprise Manager 
Program Group

■ On Windows NT 4.0, choose View>Launch 
Palettes>Applications. The Applications palette 
appears. Click the Backup Manager icon, or 
choose Tools>Applications>Backup Manager

The section, “Starting Backup 
Manager” in Chapter 12, 
“Managing Backups and 
Archiving” of Oracle Enterprise 
Manager Administrator’s Guide

SQL Worksheet ■ On Windows NT 3.51, double-click the SQL 
Worksheet icon in the Oracle Enterprise 
Manager Program Group

■ On Windows NT 4.0, choose 
Tools>Applications>SQL Worksheet. The new 
worksheet is connected to the database you 
have selected in the Navigator tree list or in the 
map window.

The section, “Overview of the 
SQL Worksheet” in Chapter 13, 
“Using the SQL Worksheet” of 
Oracle Enterprise Manager 
Administrator’s Guide

Oracle Enterprise 
Manager Tools

To Start... For More Information, See...
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Oracle Wizard
This table describes how to start the wizard, and where to go for further 
information on using this product.

SQL*Plus
This table describes how to start SQL*Plus, and where to go for further information 
on using this product.

Wizard To Start... For More Information, See...

Oracle 
Migration 
Wizard for 
Microsoft Access

■ On Windows NT 3.51, double-click the Oracle 
Migration Wizard for Microsoft Access icon in the 
Oracle for Windows NT Program Group

■ On Windows NT 4.0, choose 
Start>Programs>Oracle for Windows NT>Oracle 
Migration Wizard for Microsoft Access

Chapter 7, “Upgrading a 
Database”

Online help available with this 
product.

SQL*Plus To Start... For More Information, See...

SQL*Plus Enter any of the following at the MS-DOS 
command prompt:

■ C:\> SQLPLUS

Starts the line mode version of SQL*Plus

■ C:\> PLUS33W

Starts the GUI version of SQL*Plus

■ C:\> PLUS33

Starts the line mode version of SQL*Plus

■ On Windows NT 3.51, double-click the 
SQL*Plus icon in the Oracle for 
Windows NT Program Group to start 
the GUI version of SQL*Plus

■ On Windows NT 4.0, choose 
Start>Programs>Oracle for Windows 
NT>SQL*Plus 3.3 to start the GUI 
version of SQL*Plus

■ SQL*Plus Getting Started Release 3.3.4 
for Windows Platforms

■ SQL*Plus User’s Guide and Reference
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Using NT Instance Manager from the Command Line (ORADIM73)
This section describes the ORADIM73 commands and parameters. Note that each 
command is preceded by a dash (-).   

Task Use This Command...

Create an 
instance 

ORADIM73 -NEW -SID SID [-INTPWD INTERNAL_PWD] [-SRVC SRVCNAME] 

[-MAXUSERS NUMBER][-STARTMODE AUTO, MANUAL][-PFILE FILENAME]

where:

■ SID is the value of the instance.

■ INTERNAL_PWD is the password for the INTERNAL account. Mandatory unless 
DBA_AUTHORIZATION or DBA_SID_AUTHORIZATION is set to BYPASS in 
\\HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\ of the registry.

■ SRVCNAME is the service name.

■ NUMBER is the number of users defined in the password file. The default is five.

■ AUTO or MANUAL indicate whether to start the database automatically or 
manually at startup. The default setting is manual.

■ FILENAME is the INITSID.ORA file to be used with this instance. Ensure you 
specify the complete path name of this file, including drive letter.

Note...  -NEW and -SID are mandatory parameters. The remaining parameters are 
optional.

Note...  Creating an instance using ORADIM73 only creates the password file and related 
service. The database (that is, the database files) is not created.

Start an instance ORADIM73 -STARTUP -SID SID [-USRPWD USER_PWD] -STARTTYPE SRVC,INST [-PFILE 
FILENAME] 

where:

■ SID is the value of the instance to start.

■ USER_PWD is the password for the INTERNAL account. This is a mandatory 
parameter.

■ SRVC is for starting the services and INST is for starting an instance (both can be 
specified).

■ FILENAME is the INITSID.ORA file to be used with this instance. Ensure you 
specify the complete path name of this file, including drive letter.

Note...  -STARTUP, -SID, and -STARTTYPE are mandatory parameters. The remaining 
parameters are optional.
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Task Use This Parameter...

Stop an instance ORADIM73 -SHUTDOWN -SID SID [-USRPWD USER_PWD] -SHUTTYPE SRVC, INST -SHUTMODE 
[A, I, N]

where:

■ SID is the value of the instance to stop.

■ USER_PWD is the password for the INTERNAL account. Mandatory unless 
DBA_AUTHORIZATION or DBA_SID_AUTHORIZATION is set to BYPASS in  
\\HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\ of the registry.

■ SRVC is for stopping the services and INST is for shutting down a database (both 
can be specified).

■ Specifications on how to stop an instance; A indicates abort mode, I indicates 
immediate mode, and N indicates normal mode.

Note...  -SHUTDOWN, -SID, and -SHUTTYPE are mandatory parameters. The remaining 
parameters are optional.

Edit an instance ORADIM73 -EDIT -SID SID [-NEWSID NEWSID][-INTPWD INTERNAL_PWD]
[-STARTMODE AUTO, MANUAL][-PFILE FILENAME]

where:

■ SID is the value of the instance to edit.

■ NEWSID is the new SID for the instance (enter only if changing an existing instance 
name).

■ INTERNAL_PWD is the password for the INTERNAL account. This is necessary 
only if the password file was not created earlier.

■ AUTO or MANUAL indicates whether to start the database automatically or 
manually at startup.

■ FILENAME is the INITSID.ORA file to be used with this instance. Ensure you 
specify the complete path name of this file.

Note...  -EDIT and -SID are mandatory parameters. The remaining parameters are 
optional.

Note...  This command cannot be used to change the password, as it does not overwrite 
the existing password file. It can only create a new password file when none already 
exists. To create a new password file, use ORAPWD73, or delete the Oracle7 Server 
services (this action implicitly deletes the associated password file) and then recreate the 
Oracle7 Server services (this action implicitly creates the associated password file).

Delete an 
instance

ORADIM73 -DELETE -SID SIDA, SIDB, SIDC,... 
ORADIM73 -DELETE -SRVC SRVCA, SRVCB, SRVCC,... 

where:

■ SIDA, SIDB, SIDC are the SIDs of the instances to delete.

■ SRVCA, SRVCB, SRVCC are the services to delete.
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Using SQL*Loader with Windows NT
This section describes Windows NT specific information for using SQL*Loader 
(SQLLDR73.EXE).

Windows NT Processing Options
These are the possible values for the Operating System Dependent (OSD) file 
processing specifications string option, referred to in the “SQL*Loader Control File 
Reference” chapter of Oracle7 Server Utilities.   

1 Two double quote characters with no space in between.

Task Use This Parameter...

Display a 
complete list of 
ORADIM73 
commands

ORADIM73 -? | /? | /H | /HELP

Note: When you use ORADIM73, a log file called 
ORADIM73.LOG is opened in ORACLE_HOME\RDBMS73. All 
operations (both successful and failed) are logged in this file. You 
must check this file to verify the success of an operation.

Processing Option Description

"VAR xxxx" Load variable length records. Specify the OSD "VAR recsizehint" in the control file 
for this option to take effect. The xxxx gives an estimate of the average record size 
to SQL*Loader so that it can approximate buffer sizes accurately and not waste 
memory. The default length is eighty characters. The xxxx does not specify how 
many leading bytes of length are included in each record. It only acts as a hint to 
SQL*Loader. Each record must always be preceded by five ASCII bytes containing 
the length of the remainder of the record. For example, a record must look like the 
following: 

00024This is a 24 byte string 

Any whitespace, carriage returns, or linefeeds at the end of the record are ignored 
unless specifically included in the byte count in the length field. 

"FIX  n" Fixed record format in which each record is exactly n bytes long. If the record is 
terminated by a newline character, the newline character must be the nth byte.

""1 Stream record format in which each record is terminated by a newline character. 
The maximum record size is 48 KB.
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Direct Path Option
SQL*Loader includes a direct path option that bypasses Oracle7 Server redo log 
and data verification features, thereby decreasing loading time. Use the direct path 
option with data files known to be error free.

Control File Conventions
When preparing a SQL*Loader control file (.CTL), you must follow certain syntax 
and notational conventions. When specifying data types in the SQL*Loader control 
file, note that the default size of native data types is specific to Windows NT. You 
cannot override these defaults in the control file.    

Native Data types Default Field Length

INTEGER 4

SMALLINT 2

FLOAT 4

DOUBLE 8

Additional Information: For a complete list of options and 
instructions on using SQL*Loader, see Oracle7 Server Utilities. The 
directory ORACLE_HOME\RDBMS73\LOADER contains a 
number of examples on the use of SQL*Loader.



Using SQL*Loader with Windows NT

3-18 Oracle7 Server Getting Started Release 7.3.4 for Windows NT                                                   



                                                  Oracle7 Server Integration with Windows NT 4-1

4
Oracle7 Server Integration with Windows NT

This chapter provides an overview of how Oracle7 Server integration with 
Windows NT enables you to use Windows NT tools to administer your database.

Specific topics discussed are:

■ Event Viewer

■ Performance Monitor

■ Registry

■ Control Panel

■ User Manager



Event Viewer

4-2 Oracle7 Server Getting Started Release 7.3.4 for Windows NT                                          

Event Viewer
The Event Viewer is a Windows NT tool that enables you to monitor events in your 
system. An event is an important occurrence in the system or application (such as 
your Oracle7 Server) that requires user notification. While messages for major 
events can display on-screen as you work at your computer, events not requiring 
your immediate attention are recorded by Windows NT in the Event Viewer log 
file. You can then view this information at your convenience.

What Oracle7 Server Events Are Monitored?
The Event Viewer can be used to monitor Oracle7 Server events, such as:

■ Initialization of the System Global Area (SGA) for the active instance

■ Initialization of the Program Global Area (PGA) for the background processes 
of the active instance

■ Connection to the Oracle7 Server with the CONNECT INTERNAL command

■ Operating system audit trail

The figure below shows the Event Viewer displaying Oracle7 Server events. 
Double-click an entry to see specific information about an event.
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Performance Monitor
The Performance Monitor is a Windows NT tool that measures computer 
performance. This enables you to view the performance of processors, memory, 
cache, threads, and processes. Performance information provided includes device 
usage, queue lengths, delays, throughput measurements, and internal congestion 
measurements. This information is provided in the form of charts, alerts, and 
reports.

What Oracle7 Server Information is Monitored?
If you install the Oracle7 Performance Utility from your Oracle7 Server for 
Windows NT CD-ROM disc, you can use the Performance Monitor to monitor key 
Oracle7 Server information, such as:

■ Library Cache

■ Buffer Cache

■ Data Dictionary Cache

■ Redo Log Buffer Cache

■ Thread Activity

You can use your findings to improve database performance. 

Additional Information: See Chapter 11, “Monitoring a 
Database”, for specific instructions on accessing and using Event 
Viewer to monitor Oracle7 Server events.
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The figure below shows the Performance Monitor monitoring Oracle7 Server 
objects listed at the bottom of the screen:

Additional Information: See Chapter 11, “Monitoring a 
Database”, for specific instructions on accessing and using the 
Performance Monitor to monitor Oracle7 Server performance.

Performance ActivityCounters Objects
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Registry
The Oracle7 Server stores configuration information in a structure known as the 
registry. You can view and modify this configuration information through the 
Registry Editor. Since the registry contains configuration information for your 
computer, it must not be accessible for editing by inexperienced users. Only 
experienced administrators must be allowed to view and change this information.

The Registry Editor displays configuration information in a tree-like format 
consisting of four keys (or folders) in the left-hand pane. In the right-hand pane, 
the parameters and values assigned to that key are displayed. 

What Database Parameters Are Configured?
When you install products from your Oracle7 Server for Windows NT CD-ROM 
disc, configuration parameters are automatically entered in the registry. These 
parameters are read each time your Windows NT computer is rebooted. These 
parameters include settings for:

■ Language

■ Company name

■ Oracle home directory

■ Oracle home subdirectories for individual products

■ Individual products such as the Oracle7 Performance Utility
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The figure below shows some of the Oracle7 Server configuration parameters in the 
registry:

Additional Information: See Appendix C for: 

■ Definitions of Oracle7 Server configuration parameters

■ Specific instructions on using the registry to modify Oracle7 
Server configuration parameters
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Control Panel
The Control Panel is a Windows NT tool that enables you to modify system options 
such as services. A service is an executable process registered in the registry and 
administered by Windows NT. The registry automatically tracks and records 
security information for each service you create. 

What Oracle7 Services Appear in the Control Panel?
When you install the Oracle7 Server starter database and other products, Oracle 
services are created and displayed in the Services dialog box: 

Service Description

OracleServiceORCL Created for the database instance ORCL. An Oracle instance is 
a logical term that refers to:

■ an Oracle service called OracleServiceORCL

■ a database

Each Oracle instance must have a system identifier (SID). A 
SID is a unique name for an Oracle database instance that can 
be up to four alphanumeric characters in length. The default 
SID of ORCL is appended to the service OracleService. Each 
file for the database instance ORCL in the ORACLE_HOME\ 
DATABASE directory has this SID as part of its name (for 
example, CTL1ORCL.ORA, LOG1ORCL.ORA, and 
INITORCL.ORA). The instance name is the same as the value 
of the ORACLE_SID registry configuration parameter.

To connect to a specific Oracle7 Server, users must specify a 
service name (also known as a database alias or connect string) 
that contains a SID for that database.

OracleStartORCL Starts the database instance ORCL automatically whenever the 
Windows NT machine reboots.

OracleTNSListener Listens for and accepts incoming connection requests from 
client applications and other servers. Automatically starts 
when the Windows NT machine reboots.

OracleAgent Listens for and responds to job and event requests sent from 
the Oracle Enterprise Manager console.

OracleConTextService73 ConText server processes started on an NT server are normally 
terminated by Windows NT when the user logs off. This 
service is used to start server processes that survive logouts. 
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Additional networking services are described in Oracle Network Products Getting 
Started Release 2.3.4 for Windows Platforms.

Oracle services are the same as Windows NT services. In order to connect to and 
use an Oracle instance, an Oracle service is created during the database creation 
process and associated with the Oracle7 Server. With Oracle7 Server, you can run 
multiple Oracle instances simultaneously on one machine.

Once a service is created with your Oracle7 Server, the service can run even while 
no user is logged on. This is because your Oracle7 Server runs each instance as a 
service. This feature enables you to maintain workstation security while running 
your Oracle7 Server.

Use the Services dialog box to start, stop, pause, or continue each of the Oracle 
services available on the computer, and to pass startup parameters to the service.

The figure below shows Oracle7 Server services in the Control Panel: 

Additional Information: See Chapter 10, “Administering a 
Database” for specific instructions on using the Control Panel to 
start and stop Oracle7 Server services. 
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User Manager
User Manager is a tool that enables you to manage Windows NT computer security 
and create user accounts. 

What Oracle7 Server Tasks Can the User Manager Perform?
With User Manager, you can:

■ Grant Oracle7 Server roles

■ Use operating system authentication for user accounts

■ Create an NT user account that enables you to make secure client connections 
to Oracle7 Server without a password

The figure below shows the User Manager:

Additional Information: See Chapter 10, “Administering a 
Database” for specific instructions on using the User Manager to 
perform Oracle7 Server administration.
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5
Understanding Oracle Enterprise Manager

This chapter provides an overview of Oracle Enterprise Manager, Oracle’s suite of 
products for managing Oracle7 Servers over a distributed database network.

 Specific topics discussed are:

■ Oracle Enterprise Manager

■ Overview of Oracle Enterprise Manager Components
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Oracle Enterprise Manager
Oracle Enterprise Manager enables database administrators (DBAs) to manage 
databases distributed across a network from a single central Console. Database 
management is performed through an easy-to-use graphical user interface (GUI). 
From the Console, you can:

■ Administer, diagnose, and tune multiple databases distributed across a 
network. 

■ Distribute software to multiple servers and clients.

■ Accommodate growing distributed environments by easily scaling upwards to 
maintain performance and automate routine tasks.

■ Automate remote task execution by scheduling jobs on multiple databases 
simultaneously or at varying time intervals.

■ Schedule and run tasks such as remote database backups or report execution at 
off hours, providing the kind of “lights out” management vital in a large, 
distributed environment.

■ Remotely monitor critical database and system events that you define, have 
detected events represented graphically on the Console (or be notified through 
electronic mail or paging), and specify for corrective actions to be performed in 
response to an event.

■ Run integrated third-party applications and tools.

■ Accommodate both large database configurations and environments with 
numerous databases.

■ Administer multiple databases simultaneously in separate windows.

■ Localize task execution, so that tasks are completed even during network 
downtime. Messages are queued locally and saved until they can be delivered, 
even if a network connection is down.

■ Allow DBAs single logon access to particular databases by storing their 
privileges in a credentials file used to manage connections. When connecting to 
a database from the Console, credentials are transparently passed, so you do 
not have to log in repeatedly.
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Overview of Oracle Enterprise Manager Components
This section describes the following components that enable Oracle Enterprise 
Manager to manage your distributed database network.

■ Oracle Enterprise Manager Console Features

■ Common Services for Managing Databases

■ Integrated Applications

Oracle Enterprise Manager Console Features
The Oracle Enterprise Manager Console provides a central point of control 
through a GUI that provides drag and drop systems management. The Oracle 
Enterprise Manager Console consists of:

■ Menus that primarily manipulate objects in the Console windows

■ Toolbars that provide graphic icons that represent most menu items

■ Tools palette for executing applications and utilities

■ Four windows that provide a general view of the system being managed and 
an interface to the Oracle Enterprise Manager common services (described later 
in this chapter) 

The menus, toolbars, and tools palette are context-sensitive. Integrated applications 
can also be launched from the Console. The menu options that display depend on 
which Console window is active. The tools available in the palette depend upon the 
type of service selected in the navigator or map windows. Press F1 to determine the 
context-sensitive options.
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The figure below shows the four Console windows.

See the Oracle Enterprise Manager Administrator’s Guide and Chapter 11, 
“Monitoring a Database”, in this guide for information on using the Console 
menus, toolbars, tools palette, and windows. Brief descriptions of the four 
windows are provided in the table below.

Navigator Window Map Window

Job Scheduling Window Event Management Window
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Element Description

Navigator Window The Navigator Window provides a hierarchical tree view of the network nodes and 
services, and any objects they may contain. This enables easy object manipulation of all 
objects in the system. 

Objects include nodes, databases, listeners, users, roles, and profiles. A node contains 
databases and listeners. A database contains users, roles, and profiles.

Each type of object in the Navigator tree list is identified by an icon and a name. An 
object in the tree can also be copied by dragging and dropping it. For example, you can 
drag and drop users from one database to another.

Depending on the applications installed, additional objects such as video servers can 
appear.

Map Window The Map Window provides a customized, graphical representation of key objects (such 
as databases) created by an administrator to manage and monitor a subset or group of 
objects in the system. Objects can be grouped together based on any criteria, 
simplifying all operations performed on the group members. 

The map is useful for environments with many databases and for visually representing 
problems detected by the Event Management System.

Job Scheduling 
Window

The Job Scheduling Window enables you to automate repetitive tasks and provide the 
kind of “lights out” management vital in a large, distributed environment. 

You can schedule, cancel, or view the status of a job, or review historical information 
about jobs. You can also create and manage job scripts. See the section “Job Scheduling 
System” and Chapter 10, “Administering a Database” for additional information.

Event Management 
Window

The Event Management Window enables you to create and register event sets, modify 
or cancel registrations, view the status of services being monitored, view summary 
information about events that have occurred, and further manage event information. 

You can choose to have the events of interest represented graphically on the Console 
when they are detected. The system can also notify you through e-mail or paging. See 
the section “Event Management System” and Chapter 10, “Administering a Database” 
for additional information.
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Common Services for Managing Databases
Oracle Enterprise Manager has the following set of common services that help you 
manage Oracle7 Servers throughout the network:

■ Oracle Intelligent Agent and Communication Daemon

■ Service Discovery

■ Job Scheduling System

■ Event Management System

■ Repository

■ Security

The figure below shows how these common services work together to perform 
distributed database management across a network. Each common service is then 
described.
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Oracle Intelligent Agent and Communication Daemon
The Oracle Enterprise Manager uses the Oracle Intelligent Agent and 
Communication Daemon to manage Console tasks such as scheduling and running 
remote jobs, and monitoring events on remote sites. The Oracle Enterprise Manager 
is installed on a Windows NT or Windows 95 Console workstation. The Oracle 
Intelligent Agent is installed on each node with an Oracle7 Server for Windows NT 
database to be managed.

The Communication Daemon runs on the Console and communicates with the 
Oracle Intelligent Agent to manage jobs and events. 

The Oracle Intelligent Agent is effective, non-intrusive, and functions as the 
executor of jobs and events sent by the Console through the Communication 
Daemon. High availability is ensured since the Oracle Intelligent Agent can 
function regardless of the status of the Console or network connections. The Oracle 
Intelligent Agent is responsible for managing and completing tasks requested from 
the Console workstation by the Oracle Enterprise Manager. Once installed, the 
Oracle Intelligent Agent:

■ listens for and responds to job requests initiated from the Oracle Enterprise 
Manager Console workstation 

■ schedules job requests (requests can include detecting and correcting abnormal 
conditions, performing standard database administration procedures, and 
monitoring events)

■ executes the job request
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Service Discovery 
The Communication Daemon uses the dynamic discovery feature to identify nodes 
and services on the network. The figure below illustrates this process:

Job Scheduling System
The Job Scheduling System enables you to schedule and manage job tasks on 
remote sites. The Job Scheduling System, Communication Daemon, and Oracle 
Intelligent Agents work together to schedule and execute the job. Use the Job 
Scheduling System to perform asynchronous tasks on multiple sites without 
having to maintain connections to all those sites. In addition, jobs can run 
simultaneously on different nodes in the system. See the Oracle Enterprise Manager 
Administrator’s Guide for information on scheduling and managing jobs. 

The process for scheduling a job is:

1. From the Console Job system, you submit a job that you have set up.

2. The Communication Daemon sends the job information to the appropriate 
Oracle Intelligent Agent(s). 

3. If a site or its Oracle Intelligent Agent is down, the Communication Daemon 
queues the job. Once the site can be contacted, the daemon submits the queued 
job to the Oracle Intelligent Agent.

4. The Oracle Intelligent Agent executes the scheduled job.

Communication Daemon

Network

Intelligent
Agent

Network

Console

Topology

Manager
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5. The Oracle Intelligent Agent returns any related job messages back to the 
daemon for display in the Console.

The benefits of the Job Scheduling System are described in the table below:

Feature Description

a variety of predefined 
job tasks

You can schedule and run jobs on remote sites throughout the 
network, including: 

■ Backing up a database

■ Starting up or shutting down databases or listeners

■ Running SQL scripts or operating system programs

You can also submit your own custom jobs to the Job 
Scheduling System.

stored and forwarding 
job scheduling

You can submit a job once, regardless of the number of nodes 
on which the job runs or how often it must be executed. 
Oracle Enterprise Manager ensures that the job is run on 
schedule on all specified databases, and keeps a history of the 
job and record of the job status. You can view information 
about the job in the Job Scheduling Window. (The task of 
submitting and managing jobs is centralized in the Console.)

To schedule a job, you do not need to connect to the node on 
which the job runs. Instead, submit the job from the Console 
and specify the nodes or services on which it runs.

When you submit a job to one or more destinations, it is 
possible that any one of those sites may be down. If a site or 
its Oracle Intelligent Agent is down, the Communication 
Daemon queues job requests not delivered to the sites. Once 
the site can be contacted, the daemon submits the queued job 
to the agent.

“lights out” management You can automate repetitive and periodic tasks and problem 
correction. If the job has to be executed periodically, the 
agents reschedule the job without your intervention. 
Messages about a job status are reported back to the Console.

When you register an event to be monitored by Oracle 
Enterprise Manager, you can specify a fixit job, which is 
executed to correct the problem if the event occurs.
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cross-platform job scripts Jobs are implemented as Tool Command Language (Tcl) 
scripts. Tcl is a scripting language used to write both job and 
event scripts. Oracle has also extended Tcl (OraTcl) to include 
database-specific commands. With OraTcl, you can:

■ Invoke operating system facilities, such as programs or 
shell scripts

■ Execute SQL and PL/SQL scripts

■ Start up and shut down Oracle databases

■ Communicate with the Oracle Intelligent Agent

Although you submit a job from the Console, the job scripts 
themselves reside on the agent nodes. Because the manner in 
which a job is implemented can depend on the platform, each 
agent keeps a set of job scripts.

This enables you to submit a job, such as backing up a 
database, without worrying about the specifics of the 
platform. For example, you can select a group of databases 
residing on Windows NT machines, and send one backup job 
request to back up the databases. The agents on those nodes 
run backup job scripts that are specific to their platforms.

composite jobs You can combine two or more predefined jobs (such as 
backing up a database and then running a script) into one 
composite job. Each of the predefined jobs contained in the 
composite job is called a task.

Composite jobs can contain test conditions based on the 
success of a task. For example, if a composite job consists of 
two tasks, starting up a database and then running a SQL 
script, you can specify that the script be run only if the 
database was successfully started.

Feature Description
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scalability You can run jobs efficiently on multiple remote nodes. When 
you submit a job to run on a remote node, all the information 
needed to run the job is transferred to the agent servicing the 
node. When the job is executed, it is run by the agent on that 
node, minimizing network traffic between the remote node 
and the Console and daemon. The only communication 
between the agents and the Console and daemon are the 
initial transmission of job information and any subsequent 
messages about job status changes.

Because jobs are run independently by agents, you can 
submit any number of jobs on multiple nodes without 
affecting the Console. For example, you can submit several 
jobs and then immediately start another task without waiting 
for the agents to schedule the jobs.

In addition, because there is an Oracle Intelligent Agent 
residing on each managed node, jobs can be run on multiple 
nodes simultaneously. For example, you can submit a job to 
run a report on multiple databases worldwide. The job is 
scheduled and run independently by the agent that services 
each database. Therefore, the jobs can be executed by their 
respective agents at the same time.

security Jobs are normally run with your preferred credentials; 
therefore, you cannot run jobs to perform functions that you 
could not perform if you were logged into the machine 
directly.

Because jobs are categorized by service types, such as 
database or node, the Job Scheduling System knows which 
credentials to pass to the agent. If the job runs on a node, the 
Job Scheduling System passes either your preferred 
credentials for the node or, if none are specified, the user 
name and password used when logging into the Console. If 
the job runs on a service, such as a database, the Job 
Scheduling System also passes your preferred credentials to 
the service.

A job can also be run with the agent’s credentials. This 
flexibility enables a site to easily incorporate the Job 
Scheduling System’s authentication methods with existing 
security policies.

Feature Description
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Event Management System
The Event Management System enables you to monitor specific events at remote 
sites throughout the network, such as problems on a node or database. The process 
to register an event set is:

1. From the Console, you register a predefined event set or a set that you created.

2. The Communication Daemon sends the event information to the appropriate 
intelligent agent(s). 

3. The agent does the monitoring and alerts you if the event occurs.

4. Optionally, you can specify a fixit job to execute if the event occurs.

When an event occurs, you can be notified in various ways, such as electronic mail 
or paging. Also, events are always logged in the repository and can be viewed in 
the Console.

The benefits of the Event Management System are described in the table below:

Feature Description

Proactive Events 
Management

You can automate problem detection and correction in 
response to an event. This ensures that a problem is corrected 
before it noticeably impacts end-users. You can also specify a 
fixit job to be run in response to a particular event. For 
example, you can have the Event Management System 
monitor the tablespace TEMP in the database HR_DB and 
generate an alert if TEMP runs out of free space. You can also 
have a data file automatically added to TEMP if this event 
occurs.

Unsolicited Error 
Detection

You can detect events with tools and applications 
independent of the Oracle Intelligent Agents. These tools and 
applications can be integrated into the Event Management 
System and communicate directly with the Oracle Intelligent 
Agents. For example, a third-party application can detect an 
event on a node and report that event to the Oracle Intelligent 
Agent on that node. The Oracle Intelligent Agent then sends 
the message back to the Console.
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Scalability The Event Management System allows one person to monitor 
a large system. If you are responsible for 100 databases, you 
cannot connect to each database every day to check on 
performance. Using the Event Management System, you can 
effectively monitor all databases 24 hours a day, and be 
alerted if a problem is detected.

The Event Management System also enables you to focus on 
select systems and events. This control is vital in a large 
system. Rather than monitor all sites or a large number of 
sites, you can pinpoint only those services you want to 
monitor.

An administrator can monitor a large number of sites with 
minimal performance impact on the Console. Because the 
Oracle Intelligent Agents perform the monitoring 
independent of the Console, an administrator can monitor 
many sites without slowing other tasks.

Predefined Event Sets Standard predefined event sets are provided. Advanced 
event sets are included with the optional Performance Pack. 

The standard predefined events are the fault management 
events:

■ Database up/down

■ Listener up/down

■ Node up/down

Predefined event sets included with the Performance Pack are:

■ Space and resource management events, such as a disk 
becoming too full or a tablespace running out of extents

■ Performance management events, such as a CPU load 
being abnormal or a database system statistic being too 
high

See the Oracle Enterprise Manager Performance Monitoring 
User’s Guide and Chapter 11, “Monitoring a Database”.

Note: The Performance Pack is not on the Oracle7 Server for 
Windows NT CD-ROM disc and must be purchased 
separately.

Feature Description
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Repository
The Oracle Enterprise Manager repository is a database accessible from the 
Console. The repository:

■ consists of database tables

■ holds information used by the Oracle Enterprise Manager

■ can be installed in any accessible Oracle database in the system

You can have more than one repository in your system. A user is associated with 
one repository.

The repository provides a centralized location for storing information about the 
state of the environment managed by Oracle Enterprise Manager from the 
perspective of each Console user. It contains information on: 

■ configurations 

■ jobs and events 

■ historical collections 

■ tuning recommendations 

■ preferred credentials for each user 

■ other information associated with each Oracle Enterprise Manager Console 
login. 

Event Scripts As with jobs, events are OraTcl scripts that are stored on the 
Oracle Intelligent Agent node. Event scripts can save state 
information. Saving a state between executions of an event 
script enables the Oracle Intelligent Agent to remember if it 
has already detected a certain event and eliminates 
redundant event messages to the Console. This also enables 
event scripts to maintain a history of a database and adjust to 
behavior that is typical.

Note: Unlike job scripts, event scripts are run with the 
permissions of the Oracle Intelligent Agent.

Optimized Intelligent 
Agents

The optimized intelligent agent has been optimized to 
monitor large numbers of systems and events efficiently. 
Event tests are generally executed by the agent process 
directly and can be run quickly.

Feature Description
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See the Oracle Enterprise Manager Administrator’s Guide for information on creating 
your own repository.

Security
Access to Oracle Services on the network is controlled by a set of user-defined, 
preferred credentials for the available nodes and services. Oracle Enterprise 
Manager caches the user authentication information in encrypted form in the 
repository and provides it as part of the connection request from the Oracle 
Enterprise Manager Console or Console-launched applications. 

To access services, you must log in to the Console by using an authorized user 
name and password. Oracle Enterprise Manager manages the connections made on 
your behalf and ensures that others cannot perform operations they are not 
privileged to perform.

Integrated Applications
Oracle Enterprise Manager has an open architecture that enables software to be 
integrated with the Console. These integrated applications:

■ execute tasks quickly

■ perform multiple tasks concurrently

■ administer multiple databases simultaneously in separate windows

■ centralize DBA tasks in a single locale

Database Administration Applications
Oracle Enterprise Manager includes a standard set of integrated database 
administration (DBA) applications that automate and simplify DBA tasks. These 
applications can be launched directly from the Console or the Administration 
Toolbar. In addition, third-parties can write applications that integrate into the 
Console, use the available common services, and launch from the Console. The 
applications available are described in the table below:
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DBA Application Description

Instance Manager This tool enables you to start up and shut down databases, examine and edit 
initialization parameters, manage in-doubt transactions, and manage user sessions. 

Schema Manager This tool enables you to create, edit, and examine status, owner, creation date, and 
last date modified information for the following schema objects:

■ clusters

■ database links

■ functions and procedures

■ indexes

■ packages and package bodies

■ refresh groups

■ sequences

■ snapshots and snapshot logs

■ synonyms

■ tables

■ triggers

■ views

Backup Manager This tool enables you to perform tablespace backups, create backup scripts guided 
by a backup wizard, and administer redo logs. The Backup Manager manages the 
following groups:

■ database

■ tablespace

■ data files

The Backup Manager simplifies backups through the use of a Backup Wizard. The 
Backup Wizard enables you to specify the:

■ status of the database required to complete the backup 

■ particular tablespaces of the database to be backed up

■ backup method to be used

■ name of the file that contains the backup job script you are creating
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Security Manager This tool enables you to create, alter, and drop users, roles, and profiles, and add 
multiple privileges and roles for database users. Security Manager controls the 
security of Oracle databases. Profiles and roles assigned to a set of users are in 
constant change. Security Manager simplifies making changes by providing security 
lists that an administrator uses to determine which profiles and roles have been 
assigned to a set of users. Use property sheets to determine the security parameters 
for each database. Required changes can then be made quickly.

Storage Manager This tool enables you to perform DBA tasks associated with managing database 
storage. These tasks include managing tablespaces and rollback segments, and 
adding and renaming data files. You can also launch database tools and utilities 
from the application.

SQL Worksheet This tool enables you to enter SQL statements, PL/SQL code, and DBA commands 
dynamically, and run scripts stored as files. The SQL Worksheet maintains a history 
of the commands entered, enabling you to edit and re-execute an earlier command 
without retyping it. You can drag a SQL file and drop it into a worksheet to load it. 
You can have multiple SQL Worksheets open at a time, each separate from others. 
Therefore, you can commit or roll back work in each worksheet independently.

Data Manager This tool enables you to automate (through wizards) the transfer of data to and from 
an Oracle database. Data Manager also provides job tasks that can be submitted 
with the Job Scheduling System. The Data Menu of Data Manager includes Export, 
Import, and Load wizard options for:

■ Exporting data to a file. This option transfers data from an Oracle database to an 
Oracle binary operating system file. The file can then be used with the import 
operation. 

■ Importing data from a file. This option transfers data to an Oracle database that 
has been exported from another Oracle database.

■ Loading data from an external file. This option loads data from operating 
system files, such as text files, into an Oracle database.

DBA Application Description
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See the Oracle Enterprise Manager Administrator’s Guide for information on using 
these tools.

Common Features
The integrated database administrator applications share some common features:

Oracle Software 
Manager

This tool enables you to manage software from a central location across the 
enterprise with: 

■ An integrated toolset for managing software in a distributed fashion 

■ A next generation architecture that offers network scalability through an 
advanced client-agent-server paradigm 

■ An easy-to-use graphical user interface that allows administrators to easily run 
software configuration jobs and track assets across the entire network 

The Oracle Enterprise Manager/Oracle Software Manager (OSM) network is 
comprised of one or more Oracle Enterprise Manager/OSM installations, each 
administering host servers that contain Oracle Intelligent Agents. The Oracle 
Intelligent Agent can have clients that are administered as part of the network.

OSM uses a lightweight store-and-forward messaging system that keeps network 
traffic to a minimum. In the event of network problems, any message that is waiting 
to be sent, either from the Console or the agent, is held until the network is back 
online. Communications between the Console and agents are not resource intensive; 
they require only one connection per agent. If a host becomes unavailable, the 
connection is freed.

See Chapter 13, “Distributing and Managing Oracle Software”, for a list of Oracle 
products that can be installed and managed with OSM.

Feature Description

Tree Lists All tools have a tree list of managed objects similar to the Navigator tree list in the 
Console. For example, in the Security Manager, the tree list has containers for 
users, roles, and profiles. These containers can be expanded or collapsed by 
clicking the + or - icons to the left of the container.

Multi-column Lists A multi-column list is displayed when you select a group container. Each row in 
the list provides a quick view of summary information about objects in the selected 
container. Additionally, you can select and alter items through their respective 
property sheets.

DBA Application Description
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Other Integrated Applications
Other systems management applications are available for Oracle Enterprise 
Manager. These applications are available from Oracle Corporation and third-party 
software developers.

Examples of the integration of other Oracle applications into Oracle Enterprise 
Manager are:

■ Oracle Replication Manager

■ Oracle Media Server

■ Oracle Parallel Server

■ Oracle WebServer

■ Oracle Advanced Networking Option - Network Security and Single Sign-On 
Biometric Manager

Oracle Replication Manager  Oracle Replication Manager simplifies the complex tasks 
of managing and maintaining multiple copies of data in a distributed environment. 
This application provides immediate local access to data and enables local systems 
to function automatically, even when networks or other systems in the 
environment fail. 

Oracle Replication Manager improves access to information about the replication 
environment and helps the administrator better manage replication tasks.

Property Sheets A property sheet is a dialog box used to specify options when you are creating or 
altering a composite instance, such as a user or tablespace. A property sheet 
consists of one or more pages that are labeled with page tabs. By default, one page 
is open when the sheet is entered, but all pages show page tabs. To access another 
page, select its page tab.

Record and Play Back The integrated applications also provide a “record and play back” mechanism that 
makes it easy to record a task and perform it at multiple locations. For example, if 
you want to assign several privileges to a set of users who exist on ten databases, 
use the Security Manager and the logging mechanism to record the granting of the 
privileges, then use the Job Control System to perform the assignment at the ten 
databases.

Basic/Advanced User 
Modes

Advanced Mode displays additional property sheets that enable you to access an 
application’s advanced database administration features.

Feature Description
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Oracle Media Server  Oracle Media Server, a component of the Oracle Media suite of 
products, provides high-performance, scalable, and reliable multimedia library 
services on a wide variety of general-purpose computer platforms. Oracle Media 
Server provides the full range of services needed to deliver sophisticated, 
interactive multimedia applications to tens of thousands of simultaneous clients. 
Services provided can range from storage, retrieval, and management of movies, 
music, photographs, and text articles, to the critical customer tracking and billing 
applications required to deliver these commercial services, in real time, over the 
network.

Oracle Media Server provides a complete set of services for the delivery of 
multimedia applications, such as video-on-demand, home shopping, video 
teleconferencing, interactive learning, and personalized newspapers.

Most modules of Oracle Media Server, from the sophisticated content management, 
customer tracking, and customer billing services, to the highly scalable multimedia 
stream server, are portable to virtually any hardware or operating system 
environment. This enables customers to develop a system on hardware from one 
vendor, and later move it to a completely different system without any application 
reprogramming. This important capability allows you to swap in the most cost-
effective and high-performance components at any point in time to save money, 
increase capability, and prevent vendor “lock-in”. Portability at all levels 
(including back-end video servers, application servers, networks, set-top boxes, 
and their associated operating systems) means that compatibility is never an issue 
and your investment is never lost.

All Oracle modules are based on standards, where they exist, from the relevant 
interactive television standards organizations such as ANSI, ISO, MPEG, and 
DAVIC, all of which Oracle actively participates in, among others.

Oracle Parallel Server  With the Oracle Parallel Server, separate Oracle instances run 
simultaneously on one or more nodes using a technology called parallel cache 
management.

A parallel server has the following characteristics:

■ An Oracle instance can be started on each node in the network.

■ Each instance has a separate System Global Area (SGA) and set of background 
processes. 

■ All instances share the same data files and control file. 

■ The data files, redo log files, and control file reside on one or more disks of the 
system. 
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■ All instances can execute transactions concurrently against the same database, 
and each instance can have multiple users executing transactions. 

■ Row locking is preserved. 

In some configurations, each instance has its own redo log file, whereas in other 
configurations, there is only a single redo file.

Applications that access the database can run on the same nodes as instances of a 
parallel server or on separate nodes, using the client-server architecture. A parallel 
server can be part of a distributed database system. Distributed transactions access 
the data in a remote database in the same manner, regardless of whether the data 
files are owned by an Oracle7 Server (in exclusive mode) or a parallel server (in 
exclusive or parallel mode).

Other non-Oracle processes can run on each node of the system, or you can 
dedicate the entire system or part of the system to Oracle.

For example, a parallel server and its applications can occupy three nodes of a five-
node configuration, while the other two nodes are used for non-Oracle applications.

For additional information on Oracle Parallel Server, see Oracle Parallel Server 
Getting Started Release 7.3.4 for Windows NT.

Oracle WebServer  Oracle WebServer turns your Oracle7 Server into a powerful 
worldwide web server with the potential for enabling a whole new generation of 
web applications. Oracle WebServer is a key component of the Oracle Universal 
Server, a complete solution for managing any data (relational, spatial, text, image, 
video, and audio) in any application, at any scale. 

Oracle WebServer enables developers to build powerful web applications using a 
familiar environment: stored procedures written in PL/SQL. 

Oracle WebServer is a comprehensive solution that provides the portability, 
scalability, and support for many concurrent users needed to power large web 
sites. The integrated environment is based on three components: 

■ Oracle Web Listener

■ Oracle Web Agent

■ Oracle7 Server 

Hypertext links in any HyperText Markup Language (HTML) document can now 
point directly to an Oracle stored procedure, allowing Oracle7 Server to 
immediately build dynamic HTML documents.
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All components of Oracle WebServer are fully configurable and manageable 
through a collection of HTML forms and online, context-sensitive help. These 
administration pages allow an administrator to quickly configure additional Oracle 
Web Listeners and Oracle Web Agents or change attributes of existing services 
with the click of a button. 

Oracle Advanced Networking Option - Network Security and Single Sign-On Biometric 
Manager  The Oracle Advanced Networking Option is a set of features integrating 
network security and single sign-on. To enable enhanced user authentication, the 
Oracle Advanced Networking Option provides support for verification of user 
identities through finger print analysis. This tool enables the systems administrator 
to: 

■ Enroll and disable users in the Biometric Authentication Server by scanning 
their fingerprints 

■ Set a policy of biometric comparison thresholds common to multiple databases

■ Define a key 

■ View user lists 

Note: Oracle WebServer is not on the Oracle7 Server for 
Windows NT CD-ROM disc and must be purchased separately.

Note: The Oracle Advanced Networking Option is not on the 
Oracle7 Server for Windows NT CD-ROM disc and must be 
purchased separately.
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6
Starter Database Contents

This chapter describes the contents of the Oracle7 Server starter database.

Specific topics discussed are:

■ Starter Database

■ Starter Database Contents
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Starter Database
During the installation process, you have the option of installing either of two 
types of starter databases:

See the section “Starter Database Contents” for information on the contents of your 
starter database.

If You Select... You Receive...

Standard A fully configured and ready-to-use starter database with:

■ default database name of ORACLE 

■ system identifier (SID) of ORCL 

■ read-only snapshot capabilities. A read-only snapshot is a full 
copy of a table, or a subset of a table, that reflects a recent 
state of a database. All copies of data can potentially be 
updated, and ultimately all sites can have access to the same 
data. 

During installation, you can also select to include the Oracle 
ConText, Oracle7 Spatial Data, and Parallel Server Options in 
your starter database.

Replication A database with:

■ default database name of ORACLE 

■ SID of ORCL 

■ symmetric, update-anywhere replication capabilities (also 
referred to as updatable snapshots). All copies of data can 
potentially be updated, and ultimately all sites can have 
access to the same data. 

During installation, you can also select to include the Oracle 
ConText, Oracle7 Spatial Data, and Parallel Server Options in 
your starter database.

Note: You can choose None as your database selection. If this is 
your selection, see Chapter 9, “Creating a Database” for 
information on manually creating a database. Do not select None 
unless you are an Oracle database administrator (DBA) 
experienced with advanced database creation procedures.
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Starter Database Contents
The starter database you receive if you select the Standard or Replication database 
option contains:

■ User accounts

■ Tablespaces

■ Data files

■ Initialization parameter file

■ Redo log files

■ Control file

■ Data dictionary 

Each of these is described below.

User Accounts
Your starter database contains these user accounts:

User Account Password Description

INTERNAL ORACLE is automatically 
the password if you 
installed your Oracle7 
Server using the Oracle7 
Server option. If you 
installed your Oracle7 
Server using the Custom 
option, the password is 
whatever you entered 
when prompted during 
installation.

DBA user name with which to perform 
database administration tasks, 
including starting up and shutting 
down a database.

Note:  INTERNAL is not a true user 
account; it is an alias for the SYS user 
account and SYSDBA privilege.

Note:  INTERNAL uses the SYS 
schema, listed below, with additional 
SYSDBA privileges. See the chapter 
“The Oracle7 Database Administrator” 
of the Oracle7 Server Administrator’s 
Guide for more information.
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SYS CHANGE_ON_INSTALL DBA user name with the following 
database roles:

■ CONNECT 

■ RESOURCE

■ DBA

■ EXP_FULL_DATABASE

■ IMP_FULL_DATABASE

■ SNMPAGENT

SYSTEM MANAGER DBA user name with the DBA database 
role.

SCOTT TIGER User name with CONNECT and 
RESOURCE database roles. 

DBSNMP DBSNMP User name with CONNECT, 
RESOURCE, and SNMPAGENT 
database roles. The SNMPAGENT role 
can access the dynamic performance 
(V$) tables listed in the 
ORACLE_HOME\RDBMS73\ 
ADMIN\CATSNMP.SQL file.

If you want to drop this role and user, 
run the script CATNSNMP.SQL in 
ORACLE_HOME\RDBMS73\ADMIN.

Note: Change the passwords for the SYS and SYSTEM accounts 
immediately after installation with the following SQL statement 
from the Server Manager utility:

SVRMGR> ALTER USER USERNAME IDENTIFIED BY PASSWORD;

See Chapter 3, “Database Tools”, for information on starting Server 
Manager.

Additional Information: See the chapters “The Oracle7 Database 
Administrator” and “Managing Users and Resources” of the 
Oracle7 Server Administrator’s Guide.

User Account Password Description
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Tablespaces
The Oracle7 Server starter database is subdivided into smaller logical areas of space 
known as tablespaces. Each tablespace corresponds to one or more physical data 
files. The four tablespaces in the Oracle7 Server starter database contain the 
following types of data:  

Tablespace Description

SYSTEM Consists of the data dictionary, including definitions of 
tables, views, and stored procedures needed by the Oracle7 
Server. Information in this area is maintained automatically. 
The SYSTEM tablespace is present in all Oracle7 Servers.

USER_DATA Consists of your application data. As you create and enter 
data into tables, you fill this space with your data.

TEMPORARY_DATA Consists of temporary tables and/or indexes created during 
the processing of your SQL statement. You may need to 
expand this tablespace if you are executing a SQL statement 
that involves a lot of sorting, such as ANALYZE COMPUTE 
STATISTICS on a very large table, or the constructs GROUP 
BY, ORDER BY, or DISTINCT.

ROLLBACK_DATA Consists of rolling back transactions that fail to complete 
normally. You may need to expand this tablespace if you 
have long-running or high-data-volume transactions.

Additional Information:  See the chapter “Tablespaces and 
Datafiles” of Oracle7 Server Concepts and the chapter “Managing 
Tablespaces” of the Oracle7 Server Administrator’s Guide.
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Data Files
Data files contain the contents of logical database structures such as tables and 
indexes. One or more data files form a logical unit of storage called a tablespace. A 
data file can be associated with only one tablespace, and only one database. The 
starter database contains the following four data files located in the 
ORACLE_HOME\DATABASE directory:   

Initialization Parameter File
The starter database contains one initialization parameter file located in the 
ORACLE_HOME\DATABASE directory.   

This Data File... Is Contained in the Tablespace...

SYS1ORCL.ORA SYSTEM

USR1ORCL.ORA USER_DATA

RBS1ORCL.ORA ROLLBACK_DATA

TMP1ORCL.ORA TEMPORARY_DATA

Additional Information: See the chapter “Tablespaces and 
Datafiles” of Oracle7 Server Concepts and the chapter “Managing 
Datafiles” of the Oracle7 Server Administrator’s Guide.

Initialization Parameter File Description

INITORCL.ORA The parameter file INITSID.ORA must exist for an 
instance to start. A parameter file is a text file 
containing a list of instance configuration 
parameters. The starter database includes a file called 
INITORCL.ORA (ORCL is the SID) that has 
preconfigured parameters. No edits are required to 
this file in order to use the starter database.

Additional Information: See Appendix B, “Initialization 
Parameter Files” of this guide. This appendix lists the Oracle7 
Server-specific initialization parameters for Windows NT and their 
default values. See Oracle7 Server Reference for further information 
on initialization parameters.
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Redo Log Files
The starter database contains four redo log files located in the 
ORACLE_HOME\DATABASE directory, each 1 MB in size. In previous releases, 
the starter database only contained two redo log files, each 200 KB in size.                  

Control File
The starter database contains two control files located in the 
ORACLE_HOME\DATABASE directory.     

Database Files Disk Size Log Group Description

LOG1ORCL.ORA

LOG2ORCL.ORA

LOG3ORCL.ORA

LOG4ORCL.ORA

1 MB

1 MB

1 MB

1 MB

1

1

2

2

Redo log files hold a record of all changes made to data in the 
database buffer cache. If an instance failure occurs, the redo 
log files are used to recover the modified data that was in 
memory. Redo log files are used in a cyclical fashion. For 
example, if four files constitute the online redo log, the first 
two files are filled, the second two files are filled, the first two 
files are re-used and filled, the second two files are re-used 
and filled, and so on. 

Additional Information: See the chapters “Managing the Online 
Redo Log” and “Recovering a Database” of the Oracle7 Server 
Administrator’s Guide.

Control Files Description

CTL1ORCL.ORA

CTL2ORCL.ORA

A control file is an administrative file required to start 
and run the database. The control file records the 
physical structure of the database. For example, a control 
file contains the database name, and the names and 
locations of the database data files and redo log files. 

Note: Oracle Corporation recommends that you keep multiple 
control files (on separate physical drives) for each database and set 
the CONTROL_FILES initialization parameter in the file 
INITORCL.ORA to list each control file. See the chapter 
“Managing Control Files” of the Oracle7 Server Administrator’s 
Guide for information on setting this initialization parameter value.
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Data Dictionary
The data dictionary is a protected collection of tables and views containing 
reference information about the database, its structures, and its users. The data 
stored in the dictionary includes:

■ Names of the Oracle7 Server users

■ Privileges and roles granted to each user

■ Names and definitions of schema objects (tables, views, snapshots, indexes, 
clusters, synonyms, sequences, procedures, functions, packages, and so on) 

■ Integrity constraints

■ Space allocation for database objects

■ Auditing information, such as who accessed or updated various objects 

Additional Information: See the chapter “The Data Dictionary” of 
Oracle7 Server Concepts and “Static Data Dictionary Views” of 
Oracle7 Server Reference.
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7
Upgrading a Database

This chapter describes how to upgrade databases created using previous releases of 
Oracle7 Server to the current release of Oracle7 Server. If you have data stored in a 
release 7.0, 7.1, 7.2, or 7.3.x Oracle7 database, you must upgrade your database to 
make it work with release 7.3.4 of Oracle7 Server. This chapter also describes how 
to move the contents of a Microsoft Access database to an Oracle7 database.

Specific topics discussed are:

■ Upgrading Overview

■ Performing Pre-Upgrading Tasks

■ Installing Oracle7 Server from the CD-ROM Disc

■ Moving and Renaming Database Files

■ Using Oracle Migration Wizard for Microsoft Access
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Upgrading Overview
In the following sections you will be asked to enter commands at the SQL*DBA or 
Server Manager prompt. The SQLDBAxx application has been replaced by 
SVRMGR23 for release 7.3.4. Remember to use the appropriate release of SQL*DBA 
for your release of Oracle7 Server. If you are upgrading from:

■ release 7.0 use SQLDBA

■ release 7.1 use SQLDBA71

■ release 7.2 use SQLDBA72

■ release 7.3.x use SVRMGR23

Performing Pre-Upgrading Tasks
Before upgrading to release 7.3.4, complete the following:

1. Remove SQL*Net release 2.2 (or any previous releases of SQL*Net) before 
installing the SQL*Net release 2.3 product included on this CD-ROM disc.

If you remove SQL*Net release 2.2 after installing SQL*Net release 2.3, some 
shared SQL*Net release 2.3 files will be overwritten, rendering SQL*Net release 
2.3 unusable. If you mistakenly remove SQL*Net release 2.2 after installing 
SQL*Net release 2.3, then install SQL*Net release 2.3 again.

2. Ensure there is at least 8 MB of free space in the SYSTEM tablespace. 

a. Check the amount of free space in the SYSTEM tablespace by connecting as 
SYSTEM/MANAGER, then using this SQL statement at the SQL*DBA or 
Server Manager prompt:

SELECT SUM(BYTES) FROM SYS.DBA_FREE_SPACE
WHERE TABLESPACE_NAME = ’SYSTEM’;

If 8 MB of free space is not available, enlarge the system tablespace.

b. Increase the SYSTEM tablespace by adding a data file of the appropriate 
size. For example, the following SQL statement adds an 8 MB data file to 
the SYSTEM tablespace:

ALTER TABLESPACE SYSTEM ADD DATAFILE ’DIRECTORY FOR THE FILE\FILENAME’ 
SIZE 8M;
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3. Make a list of the control, data, and log files for each database instance you 
want to upgrade. To get a list of these files for the instance, enter the following 
SQL statement at the SQL*DBA or Server Manager prompt:

CONNECT SYSTEM/ACCOUNT PASSWORD FOR THE INSTANCE
SPOOL UPGRADE.LOG;
SELECT MEMBER FROM V$LOGFILE;
SELECT NAME FROM V$DATAFILE;
SELECT VALUE FROM V$PARAMETER
WHERE NAME = ’CONTROL_FILES’;

where the WHERE clause equals CONTROL_FILES, DB_FILES, or LOG_FILES. 

4. Shut down the Oracle7 Server database and delete any Oracle services 
belonging to the database.

a. To shut down the database, enter the following at the SQL*DBA or Server 
Manager prompt:

CONNECT INTERNAL/PASSWORD
SHUTDOWN
EXIT

b. Delete Oracle services belonging to the database using: 

ORASRV for a release 7.0 database

ORADIM71 for a release 7.1 database

ORADIM72 for a release 7.2 database

ORADIM73 for a release 7.3 database

For example, delete a release 7.2 Oracle7 Server database service with the 
following command:

NET STOP ORACLESERVICESID
ORADIM72 -DELETE -SID SID

This command stops and deletes the service where SID is the SID of the 
instance.

5. Back up your ORACLE_HOME directory. 

Additional Information: See Chapter 12, “Backing Up and 
Recovering Database Files” and Oracle7 Server Administrator’s 
Guide for information on how to back up your database.
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6. Change or add the value of the COMPATIBLE parameter in the INITSID.ORA 
file to the release of the Oracle7 Server to which you are upgrading. For 
example, set COMPATIBLE=7.3.0.0.0

7. Back up the release 7.0, 7.1, 7.2, or 7.3.x INITSID.ORA file.

8. Remove the release 7.0, 7.1, 7.2, or 7.3.x Oracle7 Server, SQL*Net Server, and 
Oracle7 Utilities using Oracle Installer.

Additional Information: See Oracle7 Server Installation Release 7.3.4 
for Windows NT for information on how to remove products with 
Oracle Installer.

CAUTION: Do not remove the release 7.0, 7.1, 7.2, or 7.3.x 
database files or the Required Support Files when prompted! 

Note: For the release 7.0 database, the Required Support Files are 
removed automatically. Therefore, you must re-install them.
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Installing Oracle7 Server from the CD-ROM Disc
1. Install Oracle7 Server from the CD-ROM disc. See Oracle7 Server Installation 

Release 7.3.4 for Windows NT for details.  

2. If you did not install a starter database, proceed to Step 3. If you installed a 
starter database, add an entry for ORACLE_SID to the registry. 

a. Create a SID for the instance you intend to upgrade. The SID is limited to 
four alphanumeric characters or less.

For example, choose ABCD as the SID.

b. Enter REGEDT32 at the command prompt to open the registry.

c. Go to the \HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE directory.

d. Create the ORACLE_SID value with data type REG_EXPAND_SZ and the 
SID you chose earlier in the string field.

e. Close the registry.

3. Create and start release 7.3.4 Oracle services.

a. Create and start an Oracle release 7.3.4 instance (without creating a new 
database) using ORADIM73. If you use the GUI release of Instance 
Manager a new database is automatically created.  

Note: During installation, you have the choice of installing the 
starter database. If you do not need another database (in addition 
to the one that you are upgrading from), you do not have to install 
the starter database.

Note: If you have chosen to install the starter database, do not use 
ORCL as the SID (previous release 7.x starter databases also have 
ORCL as the default SID. You will overwrite your previous starter 
database.) 
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b. From the command line, enter:

C:\> ORADIM73 -NEW -SID SID [-INTPWD INTERNAL_PWD] 
[-MAXUSERS NUMBER][-STARTMODE AUTO, MANUAL]
[-PFILE INITSID.ORA]

The following are created:

Oracle service (OracleServiceSID)

Oracle service (OracleStartSID)

Password file (PWDSID.ORA) located in %ORACLE_HOME%\DATABASE

c. From the command line, enter:

C:\> ORADIM73 -STARTUP -SID SID -PFILE INITSID.ORA [-USRPWD USER_PWD]  -
STARTTYPE SRVC,INST  

Additional Information: See Chapter 3, “Database Tools” for 
information on using the command line release of Instance 
Manager. Information on using Instance Manager GUI is available 
as online help.

Note: This command only starts the Oracle services. It does not 
start the database.

Additional Information: After installing Oracle7 Server release 
7.3.4, do not remove Oracle7 Server release 7.1. Removing release 
7.1 disrupts your release 7.3.4 installation.
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Moving and Renaming Database Files 
1. Move all release 7.0, 7.1, 7.2, or 7.3.x database files to the release 7.3.4 

ORANT\DATABASE directory.  

For example, move a release 7.1 control file to the release 7.3.4 directory as 
follows:

MOVE C:\ORANT\RDBMS71\CTL1ORCL.ORA                 
C:\ORANT\DATABASE\CTL1ABCD.ORA

2. Move all release 7.0, 7.1, 7.2, or 7.3.x archive files to the release 7.3.4 
\ARCHIVE directory.   

The following table lists the files of the release 7.0, 7.1, 7.2, or 7.3.x starter 
database. This information is in the spool file you created earlier in Step 3 of 
the section “Performing Pre-Upgrading Tasks”. If you have expanded the 
starter database, move the additional database files as well.             

Note: Database files consist of control files, data files, and log 
files.

Move Database Files From... To...

%ORACLE_HOME%\RDBMS70 %ORACLE_HOME%\DATABASE

%ORACLE_HOME%\RDBMS71 %ORACLE_HOME%\DATABASE

Move Archive Files From... To...

%ORACLE_HOME%\RDBMS70\ 
ARCHIVE

%ORACLE_HOME%\DATABASE\ARCHIVE

%ORACLE_HOME%\RDBMS71\ 
ARCHIVE

%ORACLE_HOME%\DATABASE\ARCHIVE

Note: release 7.2 and 7.3.x starter database files have the same 
names.
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Oracle Release 7.0 Starter Database Files

%RDBMS70%\ CTL1.ORA

%RDBMS70%\ DBS1.ORA

%RDBMS70%\ LOG1.ORA

%RDBMS70%\ LOG2.ORA

Oracle Release 7.1 Starter Database Files

%RDBMS71%\ CTL1ORCL.ORA

%RDBMS71%\ SYSORCL.ORA

%RDBMS71%\ USERORCL.ORA

%RDBMS71%\ RBSORCL.ORA

%RDBMS71%\ TEMPORCL.ORA

%RDBMS71%\ LOG1ORCL.ORA

%RDBMS71%\ LOG2ORCL.ORA

%RDBMS71%\ARCHIVE\CTL1ORCL.ORA

%RDBMS71%\ARCHIVE\LOG1ORCL.ORA

%RDBMS71%\ARCHIVE\LOG2ORCL.ORA

 Oracle Release 7.2 and 7.3.x Starter Database Files

%ORACLE_HOME%\ DATABASE\CTL1ORCL.ORA

%ORACLE_HOME%\ DATABASE\SYS1ORCL.ORA

%ORACLE_HOME%\ DATABASE\USR1ORCL.ORA

%ORACLE_HOME%\ DATABASE\RBS1ORCL.ORA

%ORACLE_HOME%\ DATABASE\TMP1ORCL.ORA

%ORACLE_HOME%\ DATABASE\LOG1ORCL.ORA

%ORACLE_HOME%\ DATABASE\LOG2ORCL.ORA

%ORACLE_HOME%\ DATABASE\ARCHIVE\ CTL1ORCL.ORA

%ORACLE_HOME%\ DATABASE\ARCHIVE\ LOG1ORCL.ORA

%ORACLE_HOME%\ DATABASE\ARCHIVE\ LOG2ORCL.ORA

Note: This information is in the spool file you created earlier.
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3. Edit the release 7.0, 7.1, 7.2, or 7.3.x initialization parameter files.

4. Move the initialization parameter files to the 7.3.4 ORANT\DATABASE 
directory.   

5. Edit the release 7.3.4 initialization parameter file.

You moved the release 7.0, 7.1, 7.2, or 7.3.x control files, data files, log files, 
archive files and any other database files you may have to the release 7.3.4 
directory %ORACLE_HOME%\DATABASE. The new location of these files 
must be reflected in the release 7.3.4 initialization parameter file. For example, 
edit the CONTROL_FILES parameter as follows:

CONTROL_FILES = (%ORACLE_HOME%\DATABASE\CTL1ABCD.ORA)       

6. Verify REMOTE_LOGIN_PASSWORDFILE=SHARED in the release 7.3.x 
initialization parameter file. If it does not, change the setting.

Move Initialization Files From... To... 

%ORACLE_HOME%\RDBMS70\ 
INITSID.ORA 

%ORACLE_HOME%\DATABASE\ 
INITSID.ORA

%ORACLE_HOME%\RDBMS71\ 
INITSID.ORA

%ORACLE_HOME%\DATABASE\ 
INITSID.ORA

Note: Change any occurrence of %RDBMS70%, %RDBMS71%, or 
%RDBMS72% in the initialization parameter file to %RDBMS73%.

Note: If you installed Oracle7 Server release 7.3.4 without the 
starter database, remove the reference to CTL2SID.ORA in your 
initialization parameter file.

Note: In Release 7.3.4 of the Oracle7 Server, the 
CONTROL_FILES parameter in the initialization parameter file 
points to two control files. Since some previous releases pointed to 
only one control file, you must ensure that this parameter points to 
only one control file, unless you have customized the initialization 
parameter file.
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7. Set ORACLE_SID=ORCL at the MS-DOS command prompt.

8. Start the release 7.0, 7.1, 7.2, or 7.3.x Oracle7 Server database using Server 
Manager line mode.

When prompted for a password, enter the password you used to create Oracle 
services. Then enter the following:

SVRMGR> CONNECT INTERNAL/PASSWORD
SVRMGR> STARTUP EXCLUSIVE MOUNT     

9. Enter the ALTER DATABASE statement at the Server Manager prompt to 
change the full paths of the data files and log files. 

The following example 7.0 statements upgrade the default SID ORCL. Your 
statement must match your actual files. 

SVRMGR> ALTER DATABASE RENAME FILE
2> ’C:\ORANT\RDBMS70\dbs1.ora’,
3> ’C:\ORANT\RDBMS70\log1.ora’,
4> ’C:\ORANT\RDBMS70\log2.ora’ to 
5> ’C:\ORANT\DATABASE\dbs1orcl.ora’,
6> ’C:\ORANT\DATABASE\log1orcl.ora’,
7> ’C:\ORANT\DATABASE\log2orcl.ora’

The following example 7.1 statements upgrade the default SID ORCL. Your 
statement must match your actual files. 

SVRMGR> ALTER DATABASE RENAME FILE
2> ’C:\ORANT\RDBMS71\log1orcl.ora’,
3> ’C:\ORANT\RDBMS71\ARCHIVE\log1orcl.ora’,
4> ’C:\ORANT\RDBMS71\log2orcl.ora’,
5> ’C:\ORANT\RDBMS71\ARCHIVE\log2orcl.ora’,
6> ’C:\ORANT\RDBMS71\sysorcl.ora’,
7> ’C:\ORANT\RDBMS71\usrorcl.ora’,
8> ’C:\ORANT\RDBMS71\rbsorcl.ora’,
9> ’C:\ORANT\RDBMS71\tmporcl.ora’ to 
10> ’C:\ORANT\DATABASE\log1orcl.ora’,
11> ’C:\ORANT\DATABASE\ARCHIVE\log1orcl.ora’,
12> ’C:\ORANT\DATABASE\log2orcl.ora’,
13> ’C:\ORANT\DATABASE\ARCHIVE\log2orcl.ora’,
14> ’C:\ORANT\DATABASE\sys1orcl.ora’,

Note: If you have your own database file structure, go to Step 10  
(you have neither moved nor renamed your files).
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15> ’C:\ORANT\DATABASE\usr1orcl.ora’,
16> ’C:\ORANT\DATABASE\rbs1orcl.ora’,
17> ’C:\ORANT\DATABASE\tmp1orcl.ora’
 

10. Run SQL scripts at the Server Manager prompt to upgrade the database.

Run these scripts to upgrade from Oracle release 7.0.15 to release 7.3.4:
SVRMGR> ALTER DATABASE OPEN;
SVRMGR> @%RDBMS73%\ADMIN\CAT70101.SQL
SVRMGR> @%RDBMS73%\ADMIN\CAT70102.SQL
SVRMGR> @%RDBMS73%\ADMIN\CAT70103.SQL
SVRMGR> @%RDBMS73%\ADMIN\CAT7103.SQL
SVRMGR> @%RDBMS73%\ADMIN\CAT7106.SQL
SVRMGR> @%RDBMS73%\ADMIN\CAT7201.SQL
SVRMGR> @%RDBMS73%\ADMIN\CAT7202.SQL
SVRMGR> @%RDBMS73%\ADMIN\CAT7203.SQL
SVRMGR> @%RDBMS73%\ADMIN\CAT7301.SQL
SVRMGR> @%RDBMS73%\ADMIN\CAT7302.SQL
SVRMGR> @%RDBMS73%\ADMIN\CAT7303.SQL
SVRMGR> @%RDBMS73%\ADMIN\CAT7304.SQL
SVRMGR> @%RDBMS73%\ADMIN\CATALOG.SQL
SVRMGR> @%RDBMS73%\ADMIN\CATPROC.SQL

Note: If your Oracle Home directory is not C:\ORANT, replace it 
with the actual directory name.

Note: If you have expanded the database, include the additional 
database files in the above statements.
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Run these scripts to upgrade from Oracle release 7.1.3 to release 7.3.4:   

SVRMGR> ALTER DATABASE OPEN;
SVRMGR> @%RDBMS73%\ADMIN\CAT7106.SQL
SVRMGR> @%RDBMS73%\ADMIN\CAT7201.SQL
SVRMGR> @%RDBMS73%\ADMIN\CAT7202.SQL
SVRMGR> @%RDBMS73%\ADMIN\CAT7203.SQL
SVRMGR> @%RDBMS73%\ADMIN\CAT7301.SQL
SVRMGR> @%RDBMS73%\ADMIN\CAT7302.SQL
SVRMGR> @%RDBMS73%\ADMIN\CAT7303.SQL
SVRMGR> @%RDBMS73%\ADMIN\CAT7304.SQL
SVRMGR> @%RDBMS73%\ADMIN\CATALOG.SQL
SVRMGR> @%RDBMS73%\ADMIN\CATPROC.SQL

Run these scripts to upgrade from Oracle release 7.2.2 to release 7.3.4: 
SVRMGR> ALTER DATABASE OPEN;
SVRMGR> @%RDBMS73%\ADMIN\CAT7203.SQL
SVRMGR> @%RDBMS73%\ADMIN\CAT7301.SQL
SVRMGR> @%RDBMS73%\ADMIN\CAT7302.SQL
SVRMGR> @%RDBMS73%\ADMIN\CAT7303.SQL
SVRMGR> @%RDBMS73%\ADMIN\CAT7304.SQL
SVRMGR> @%RDBMS73%\ADMIN\CATPROC.SQL
SVRMGR> @%RDBMS73%\ADMIN\CATALOG.SQL

Run these scripts to upgrade from Oracle release 7.3.2 to release 7.3.4: 
SVRMGR> ALTER DATABASE OPEN;
SVRMGR> @%RDBMS73%\ADMIN\CAT7303.SQL
SVRMGR> @%RDBMS73%\ADMIN\CAT7304.SQL
SVRMGR> @%RDBMS73%\ADMIN\CATALOG.SQL
SVRMGR> @%RDBMS73%\ADMIN\CATPROC.SQL

Run these scripts to upgrade from Oracle release 7.3.3 to release 7.3.4: 
SVRMGR> ALTER DATABASE OPEN;
SVRMGR> @%RDBMS73%\ADMIN\CAT7304.SQL
SVRMGR> @%RDBMS73%\ADMIN\CATALOG.SQL
SVRMGR> @%RDBMS73%\ADMIN\CATPROC.SQL
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Run the following script to upgrade a replication database:    
SVRMGR> @%RDBMS73%\ADMIN\CATREP.SQL

11. Rerun UTLXPLAN.SQL in any schema in which you want to use EXPLAIN 
PLAN.

12. Shut down and restart the 7.0, 7.1, 7.2, or 7.3.x Oracle7 Server database by 
entering the following command at the Server Manager prompt:

SVRMGR> SHUTDOWN
13. Shut down and restart the computer.

Your 7.0, 7.1, 7.2, or 7.3.x Oracle7 Server database is now upgraded to release 
7.3.4.

Note: CATPROC.SQL is for PL/SQL functionality. CATREP.SQL 
is for Advanced Replication Support. Run CATREP.SQL only if 
you have Advanced Replication Support. The CATREP.SQL may 
take over an hour to run!

Note: Ensure that you spool all of the output from the .SQL 
scripts to a file. Then, check the file for errors.
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Using Oracle Migration Wizard for Microsoft Access
Oracle Migration Wizard for Microsoft Access helps you migrate data from a 
Microsoft Access database to Oracle7 Server. Specifically, Oracle Migration Wizard 
for Microsoft Access:

■ Migrates the structure and/or data of a Microsoft Access database(s) to Oracle7 
Server. Oracle7 Server is then used to manage the migrated data and referential 
integrity. 

■ Enables Oracle products such as Oracle Power Objects to work with the newly 
migrated data. 

Oracle Migration Wizard for Microsoft Access can migrate several types of 
Microsoft Access databases, including: 

■ Single Microsoft Access databases with both fixed and dynamically attached 
tables. 

■ Multiple Microsoft Access databases that share attached tables with other 
Microsoft Access databases. 

■ Microsoft Access databases that contain Object Linking and Embedding (OLE) 
or MEMO fields. 

Oracle Migration Wizard for Microsoft Access can be used to migrate both 16-bit 
Access 2.0 databases and 32-bit Microsoft Access 7.0 databases.

To prepare a Microsoft Access database for migration:

1. Compact and back up your Microsoft Access database files. 

2. If you want, separate your Microsoft Access data tables and referential 
integrity into a different .MDB file from the application (forms, reports, macros, 
and modules) and create attachments. The .MDB file containing the data tables 
and referential integrity is the .MDB file to migrate to Oracle7 Server. 
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To migrate a database using Oracle Migration Wizard for Microsoft Access:

The Oracle Migration Wizard for Microsoft Access welcome screen appears:  

Note: Microsoft Access tables with two or more MEMO or OLE 
datatype columns, which need to be mapped to a LONG or 
LONGRAW in Oracle7 Server, are not converted. The Oracle 
Migration Wizard for Microsoft Access tries to convert these 
datatypes to a VARCHAR2(2000) so the table can be converted. 
However, if the existing data does not permit this, the Microsoft 
Access table is not converted. Change the Microsoft Access 
structure to move the additional MEMO or OLE columns to a 
separate table. Oracle7 Server does not support two LONG 
columns in one table.

If Using... Then...

Windows NT 3.51 Double-click the Oracle Migration Wizard for Microsoft Access 
icon in your Oracle for Windows NT Program Group

Windows NT 4.0 Choose Start>Programs>Oracle for Windows NT>Oracle 
Migration Wizard for Microsoft Access
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3. Proceed to the last Oracle Migration Wizard for Microsoft Access screen and 
complete the migration of the Microsoft Access database.  

Known Issues, Restrictions, and Workarounds
This section lists known problems and restrictions with Oracle Migration Wizard 
for Microsoft Access.

■ Supported on Oracle7 Server release 7.3.3 and 7.3.4 only.

■ Does not support Microsoft Access 97 or Access dynasets. 

■ The 16-bit version of Oracle Migration Wizard for Microsoft Access supports 
only migrating schemas that have English or ISO Latin 1 object names; that is, 
table names, index names, column names, and so on.

■ Cannot migrate a Microsoft Access 2.0 database on Windows NT 4.0 or a 
database that has reference to the attached database.

■ If you do not have a default printer selected, the wizard successfully migrates 
your Microsoft Access database to Oracle7 Server; however it will not give you 
any feedback about the progress of the migration.

■ The Oracle7 Server account’s password created after the migration is oracle.

■ Takes the name of the .MDB file and creates a user with the same name for 
Oracle. Do not use names for the .MDB files that are Oracle reserved words. 

■ When using Query mapping layer and attachments, a table t1 is attached from 
database db1 to database db2 as attachment t2. The databases are migrated to 
Oracle and the query mapping layer is built. In this case, the backup 
attachment t2_L that is created in database db2 for the original attachment t2 
does not point to the proper table in database db1. 

■ When you create the backup attachment t2_L in database db2, it still points to 
table t1 in database db1. Since table t1 in database db1 no longer exists (a query 
is created with the same name for the table instead), the attachment is no 
longer valid. To avoid the problem, manually delete and re-create the backup 
attachment t2_L in database db2 pointing to table t1_L instead of table t1 in 
database db1.

■ When generating reports, if you select File as the destination for your report, 
you create a Crystal Reports viewable file format. If you want to create a text 

Additional Information: Click Help to access the online 
documentation.
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file, select Window as the destination of your report. After generating the 
report, select the briefcase icon at the bottom of the report window. Choose text 
as the format and disk file as the destination to create a text file of the report.

■ Use Windows NT or Windows 95 when migrating the AutoNumber column 
with the Structured Only option. The Oracle sequence number starts with the 
last number of the Microsoft Access auto number.
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8
Configuration Tasks

This chapter describes post-installation configuration tasks for Oracle7 Server.

Specific topics discussed are:

■ What Must You Configure?

■ Configuring SQL*Net

■ Configuring Oracle Enterprise Manager

■ Configuring Oracle7 Spatial Data Option

■ Configuring Oracle ConText Option

■ Configuring Advanced Replication Support

■ Switching Oracle Homes (16-Bit Only)
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What Must You Configure?
Some of the products/support that you install must be configured before they can 
be used. Review the table below to identify your configuration responsibilities. 

Product/Support Where Do I Go for Information on Configuring My Product?

SQL*Net networking 
software

See the section “Configuring SQL*Net” in this chapter for information on the 
tools available for configuring SQL*Net and where to go for this 
configuration information.

Oracle Enterprise Manager See the section “Configuring Oracle Enterprise Manager” in this chapter.

Oracle Options:

■ Oracle7 Spatial Data

■ Oracle ConText

■ Oracle Parallel Server

See the following based upon the options you install:

■ “Configuring Oracle7 Spatial Data Option” in this chapter

■ “Configuring Oracle ConText Option” in this chapter

■ Oracle Parallel Server Getting Started Release 7.3.4 for Windows NT

Advanced Replication 
Support

See the section “Configuring Advanced Replication Support” in this chapter. 
Perform the configuration steps in this section only if you decide to add 
Advanced Replication support to an already installed, non-replicated 
database. If you selected Replication when prompted for a database type 
during installation, you do not need to perform these steps.

Switching Oracle homes 
Support (16-bit only)

See the section “Switching Oracle Homes (16-Bit Only)” in this chapter.
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Configuring SQL*Net
Two configuration tools enable you to configure SQL*Net version 2.3 client and 
server database connections and create server and client configuration files. The 
tool you use depends upon the size and complexity of the network.

Review the following guidelines before choosing either SQL*Net Easy 
Configuration or Oracle Network Manager:

■ Use either SQL*Net Easy Configuration or Oracle Network Manager; you 
cannot use both together. 

■ Oracle Corporation strongly recommends that every machine in the network 
be configured with one, and only one, of the configuration tools.  

Configuration Tool Use for...

SQL*Net Easy Configuration Simple database connections.

SQL*Net Easy Configuration is automatically installed 
when you select the: 

■ Oracle7 Server installation option 

■ Oracle7 Client installation option 

■ SQL*Net Server and SQL*Net Client from the 
Custom Installation option

Oracle Network Manager Complex networks, and advanced SQL*Net features 
such as Oracle Names Server and the Advanced 
Networking Option.

Oracle Network Manager is a Windows 16-bit 
application that can be run on Windows NT, Windows 
95, and Windows 3.1x. Install Oracle Network 
Manager using the Windows 3.1 Oracle Installer by 
running the SETUP.EXE file located in the \Windows 
directory on your CD-ROM disc and not the 
SETUP.EXE file located at the root of the CD-ROM disc.

Additional Information: See Chapter 4 “Configuration” and 
Appendix E, “Configuration Files”, of Oracle Network Products 
Getting Started Release 2.3.4 for Windows Platforms for guidelines on 
which tool to use and configuration procedures with either tool.
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Configuring Oracle Enterprise Manager
Oracle Enterprise Manager works with the Oracle Intelligent Agent (installed on 
the Oracle7 database server) to perform database administration from a single 
console. Oracle Enterprise Manager is installed on a console workstation, which 
can be a Windows NT or Windows 95 client machine. 

Oracle Intelligent Agent
The Oracle Intelligent Agent is installed on the Oracle7 Server to be managed. The 
Oracle Intelligent Agent is responsible for managing and completing tasks 
requested from the Oracle Enterprise Manager Console workstation. Once 
installed, the Oracle Intelligent Agent:

■ listens for and responds to job requests initiated by the Oracle Enterprise 
Manager Console workstation 

■ schedules job requests (requests can include detecting and correcting abnormal 
conditions, performing standard database administration procedures, and 
monitoring events)

■ executes the job request

Attention: Oracle Enterprise Manager uses a repository database 
to store information. This repository database is an Oracle7 Server 
database installed on either:

■ An Oracle Enterprise Manager Console if it is a Windows NT 
machine 

■ A separate Windows NT machine to which a Windows 95 or 
Windows NT Oracle Enterprise Manager Console can 
remotely connect

The Oracle7 Server database to be managed by the Oracle 
Enterprise Manager Console must not also act as the Oracle7 
repository database. If it does, you will not be able to perform 
many database administration tasks, such as starting or shutting 
down the database. The repository database must be on a separate 
machine whose sole responsibility is to act as a storage resource for 
the Oracle Enterprise Manager.
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Configuration Tasks
Perform the following configuration tasks after installing the Oracle Enterprise 
Manager on a client Windows NT or Windows 95 console workstation and the 
Oracle Intelligent Agent on your Oracle7 Server machine:

1. Step 1: Start Oracle Services

2. Step 2: Create a Repository User Account

3. Step 3: Create a Windows NT User Account

4. Step 4: Create Configuration Files

5. Step 5: Create the Repository and Discover Services

Each of these tasks is described in the sections that follow.

Step 1: Start Oracle Services
Before configuring Oracle Enterprise Manager, ensure that the Oracle7 database 
services OracleServiceSID, OracleTNSListener, and OracleAgent services are 
started on the machine that contains the Oracle7 Server to be managed. The Oracle 
Intelligent Agent automatically locates the services on the computer where it 
resides and passes this information to the Oracle Enterprise Manager Console.

Note: Oracle Intelligent Agent automatically creates SNMP_RO 
and SNMP_RW. These are used instead of the SNMP.ORA file of 
previous releases. If want to use an SNMP.ORA file that you 
configured with a previous release instead of SNMP_RO and 
SNMP_RW, set the following line to TRUE in the SNMP.ORA file.

 nmi.register_with_names=true 

If you set this line to FALSE, Oracle Intelligent Agent uses 
SNMP_RO and SNMP_RW. 
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To start the Oracle services:

1. Start the OracleServiceSID, OracleTNSListener, and OracleAgent services on 
Oracle7 Server in either of two ways:

■ From the MS-DOS command prompt, enter:

C:\>NET START SERVICE_NAME

■ From the Control Panel’s Services window, select the service, and click Start.

2. Continue to “Step 2: Create a Repository User Account”.

Step 2: Create a Repository User Account
You need to have a user account with DBA (database administrator) privileges set 
up on the Oracle7 Server repository database. This repository database can be on:

■ The same Windows NT machine on which the Oracle Enterprise Manager 
Console is installed

■ A separate Windows NT machine to which the Oracle Enterprise Manager 
Console can connect

Oracle Enterprise Manager places the repository in the default tablespace of the 
user account to which you are connected when creating the repository. Because of 
this, Oracle Corporation recommends that you create a new user account so that 
the repository can be created in its own tablespace. It is also recommended that you 
create a new tablespace and the newly-created user be customized to use this 
tablespace as its default tablespace. 

To create a repository user account on the Oracle7 repository database:

1. Start Server Manager and connect to the Oracle7 repository database:

C:\> SVRMGR23

SVRMGR> CONNECT SYSTEM/MANAGER

where MANAGER is the password for the SYSTEM user account. If you have 
changed this password, substitute MANAGER with the correct password.

2. Create a special tablespace for the Oracle Enterprise Manager repository: 

SVRMGR> CREATE TABLESPACE REPOSIT_TABLESPACE DATAFILE                     
2>’ORACLE_HOME\DATABASE\DATAFILE’ SIZE XM;

where REPOSIT_TABLESPACE is the tablespace name, 
ORACLE_HOME\DATABASE\DATAFILE is the path to the data file, and X is 
the tablespace size in megabytes; 20 MB is a good starting place.
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3. Create a user account and password, where the user’s default tablespace is the 
newly-created tablespace: 

SVRMGR> CREATE USER USERNAME IDENTIFIED BY PASSWORD
2> DEFAULT TABLESPACE REPOSIT_TABLESPACE;

4. Grant the SYSTEM privileges to this user account: 

SVRMGR> GRANT DBA TO USERNAME IDENTIFIED BY PASSWORD;

5. When done, enter:

SVRMGR> EXIT

Exiting Server Manager closes the database connection.

6. Follow Steps 3-5 for additional repository user accounts.

Step 3: Create a Windows NT User Account
After a repository user account is created, a Windows NT must be created on the 
Oracle7 Server that will be managed (that is, the machine on which you performed 
“Step 1: Start Oracle Services”).

To create a user account on the Oracle7 Server:

1. Start User Manager:

If Using... Then...

Windows NT 4.0 1. Choose Start>Programs>Administrative Tools>User 
Manager.

Windows NT 3.51 1. Double-click the Administrative Tools icon in Program 
Manager.

2. Double-click User Manager.
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The User Manager window appears:

2. Choose New User from the User menu.

The New User dialog box appears:



Configuring Oracle Enterprise Manager

                                                                   Configuration Tasks 8-9

3. Enter the appropriate information in the dialog box:

a. Enter a user name in the Username field.

b. Enter the same password in both the Password and Confirm Password 
fields.

c. Make sure the User Must Change Password at Next Logon check box is not 
checked and Password Never Expires check box is checked.

d. Make the user a member of the Administrator’s group by clicking Groups.

The Group Memberships dialog box appears:

e. Select Administrators from the Not member of list box and click <- Add.

Administrators is added to the Member of list box.

f. Click OK to close the Group Memberships dialog box and return to the New 
User dialog box.

4. Click OK in the New User dialog box to accept the user information.

The user is added and the User Manager window re-appears.

5. Select the newly-created user and choose User Rights from the Policies menu.
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The User Rights Policy dialog box appears:

6. Click the Show Advanced User Rights check box and select Log on as a batch job 
from the Right drop-down list box.

7. Select Users from the Grant To list box.

If Users does not exist, create it:

a. Click Add.

The Add Users and Groups dialog box appears:

b. Select the name of the local host machine from the List Names From drop-
down list box.
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c. Select Users from the Names list box and click Add.

d. Click OK.

Users appears in the Grant To list box.

8. Click OK in the User Rights Policy dialog box.

The User Manager window re-appears.

9. Click Exit from the User menu.

10. Repeat Steps 1-9 for any other repository user accounts you created.

Step 4: Create Configuration Files
If Oracle Enterprise Manager is installed on a Windows 95 or Windows NT client 
console separate from the machine on which the Oracle7 repository database 
resides, you must configure the client machine so that it can connect to the 
repository database. Use SQL*Net Easy Configuration or Oracle Network Manager 
to configure your network.

If Oracle Enterprise Manager is installed on the same machine on which the 
Oracle7 repository database is installed, you do not need to configure your 
network.

Step 5: Create the Repository and Discover Services
Before you can use Oracle Enterprise Manager, you need a repository on the 
console workstation where Oracle Enterprise Manager will run. The repository is a 
set of base tables in a database that contains status and environment information 
for your managed databases. A separate repository must be created for each user 
wanting to use Oracle Enterprise Manager. 

The Oracle Enterprise Manager console workstation must also discover network 
services, such as databases, listeners, and nodes, to populate the Oracle Enterprise 
Manager Navigator tree. In addition to discovery, Oracle Enterprise Manager must 
also be able to manage these services for the Job Scheduling and Event 
Management systems. This can be achieved with the Discovery Wizard.

Additional Information: See Oracle Network Products Getting 
Started Release 2.3.4 for Windows Platforms and Understanding 
SQL*Net for complete information about configuring your network.
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When the agent starts up and is explicitly requested by the Oracle Enterprise 
Manager with the Navigator Discovery feature, the agent passes information from 
the Oracle Enterprise Manager console to populate the Navigator tree.

To create a repository on the console workstation:

1. Start Oracle Enterprise Manager:

The Oracle Enterprise Manager Login Information dialog box appears:

2. Enter the following appropriate information and click OK:

■ Repository user name and password you created in “Step 2: Create a 
Repository User Account”

■ SQL*Net service (also known as database alias or connect string) of the 
repository database; it is only necessary to enter a service name if you are 
connecting from a client console machine to the repository database on a 
different machine

If Using... Then...

Windows NT 4.0 1. Choose Start>Programs>Oracle Enterprise Manager>Enterprise 
Manager.

Windows NT 3.51 1. Double-click the Oracle Enterprise Manager icon in the Program 
Manager.

2. Double-click Oracle Enterprise Manager.
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The Oracle Repository Manager window appears, prompting you to build the 
repository:

3. Click OK. 

The repository builds.

After the repository is built, the Discover New Services Wizard appears:
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4. Follow the wizard instructions to discover services.

Services are discovered when you see the dialog box below with a status of 
Discovered:

5. Click Close.

The Oracle Enterprise Manager Console appears:

Note: Do not exit the Oracle Enterprise Manager Toolbar using 
the keyboard combination Alt-F4.
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Configuring Oracle7 Spatial Data Option     
Perform these configuration tasks before using Oracle7 Spatial Data Option:

1. Start Server Manager at the command prompt:

C:\> SVRMGR23

2. Connect to the database as SYSTEM/MANAGER:

SVRMGR> CONNECT SYSTEM/MANAGER

where MANAGER is the password for the SYSTEM user account. If you have 
changed this password, substitute MANAGER with the correct password.

3. Create an MDSYS user. For example:

SVRMGR> CREATE USER MDSYS IDENTIFIED BY MANAGER;

4. Grant the following privileges to the MDSYS user:

SVRMGR> GRANT ALL PRIVILEGES TO MDSYS IDENTIFIED BY MANAGER WITH ADMIN 
OPTION;

SVRMGR> ALTER USER MDSYS QUOTA UNLIMITED ON SYSTEM;

5. Exit Server Manager:

SVRMGR> EXIT

6. Start SQL*Plus from the MS-DOS command prompt:

C:\>PLUS33

7. Connect to the database as MDSYS/MANAGER: 

SVRMGR> CONNECT MDSYS/MANAGER

8. Run the CATMD.SQL script:

SQL> @ORACLE_HOME\RDBMS73\ADMIN\CATMD.SQL

where ORACLE_HOME represents the drive letter and your top-level Oracle 
home directory.

This script creates the following:

■ MD3 data dictionary tables

■ MD3 data dictionary user views

■ MDSQL packages for MD operations

Note: You cannot use Server Manager to run CATMD.SQL.
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■ MDWEX packages for extracting data

■ MDGTRIG package for generating triggers      

Configuring Oracle ConText Option
Perform these configuration tasks before using Oracle ConText Option:

1. Start Server Manager at the command prompt:

C:\> SVRMGR23

2. Create a tablespace called DRSYS with a size of at least 5 MB for the Oracle 
ConText Option objects. 

a. Connect as SYSTEM/MANAGER:

SVRMGR> CONNECT SYSTEM/MANAGER

where MANAGER is the password for the SYSTEM user account. If you have 
changed this password, substitute MANAGER with the correct password.

b. Create tablespace DRSYS:

SVRMGR> CREATE TABLESPACE DRSYS DATAFILE 
’ORACLE_HOME\DATABASE\DRORCL.ORA’ SIZE 30M;

where ORACLE_HOME represents the drive letter and your top-level 
Oracle home directory, DRSYS is the new tablespace, and DRORCL.ORA is 
the new datafile in DRSYS.

c. Exit Server Manager.

3. Go to the ORACLE_HOME\CTX73\ADMIN directory.

4. Start SQL*Plus:

C:\ORANT\CTX73\ADMIN> PLUS33 

Additional Information: See Oracle7 Spatial Data Option User’s 
Guide and Reference.

Note: In order to develop applications that work with the Oracle7 
Spatial Data Option, you must link with SDO73.LIB in the 
ORACLE_HOME\MD73 directory.
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5. Connect as INTERNAL:

SQL> CONNECT INTERNAL/PASSWORD

6. Execute the script DRCRSYST.SQL.

SQL> @DRCRSYST CTXSYS CTXSYS DRSYS DRSYS

This script creates the CTXSYS user with password CTXSYS and default 
tablespace of DRSYS. It also creates the CTXADMIN, CTXAPP, and CTXUSER 
roles.

7. Connect as the CTXSYS user:

SQL> CONNECT CTXSYS/CTXSYS

8. Execute the script DR0INST.SQL script to load the data dictionary.

SQL> @DR0INST

This script loads the data dictionary and packages into user CTXSYS/CTXSYS.

9. Import the CTXSET.DMP file to import data into the data dictionary:

C:\> IMP73 CTXSYS/CTXSYS FILE=CTXSET.DMP FULL=Y IGNORE=Y
This imports data used by the linguistics services into CTXSYS/CTXSYS.

10. Add or check for the following line in your INITSID.ORA file if you want to 
use one-step queries in Oracle ConText Option:

TEXT_ENABLE = TRUE

11. Set the SHARED_POOL_SIZE initialization parameter to at least 9 MB when 
using Oracle ConText Option. See Appendix B, “Initialization Parameter Files” 
for instructions on editing the INITSID.ORA file.

12. Shut down and restart your database.  

Note: Restart the database for INITSID.ORA changes to take 
effect.

Additional Information: See Oracle ConText Option QuickStart, 
Oracle ConText Option Administrator’s Guide, Oracle ConText Option 
Messages, Oracle Context Application Developer’s Guide. See also 
Chapter 5 of the Oracle ConText Option Workbench User’s Guide for 
procedures on migrating from OracleTextServer3 to the Oracle 
Context Option.
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Configuring Advanced Replication Support
Perform the configuration steps in this section only if you decide to add Advanced 
Replication Support to an already installed, non-replicated database. If you selected 
Replication when prompted for a database type during installation, you do not 
need to perform these steps.

Refer to Oracle7 Server Installation Release 7.3.4 for Windows NT for Advanced 
Replication support installation requirements. 

Tablespace Requirements
These are the recommended tablespace requirements for Advanced Replication 
Support:

Additional Information: There are many configuration and usage 
possibilities with Advanced Replication Support. For more 
information about Advanced Replication, see:

• Oracle7 Server Distributed Systems, Volume I: Distributed Systems

• Oracle7 Server Distributed Systems, Volume II: Replicated Data

• Oracle7 Server Concepts

• Oracle7 Server Administrator’s Guide

Tablespace Requirement

SYSTEM At least 20 MB of free space is required for replication 
packages. Replication triggers and procedures are stored here.

ROLLBACK SEGMENTS ■ Rollback Initial Extent = 50 KB

■ Rollback Next Extent = 50 KB

ROLLBACK At least 5 MB of free space.

TEMPORARY At least 10 MB of free space.

USER User specific.
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Initialization Parameters
The following initialization parameters must be set or added to the INITSID.ORA 
file (recommended values are included). 

Master Site
Add these initialization parameters to the master site.

Snapshot Site
Add these initialization parameters for snapshot sites:

Note: These parameters are already set if you choose to install the 
Replication starter database.

Parameter Name Recommended Value

SHARED_POOL_SIZE At least 10 MB

DISTRIBUTED_LOCK_TIMEOUT 300 seconds

DISTRIBUTED_TRANSACTIONS 5

GLOBAL_NAMES TRUE

OPEN_LINKS 4

PROCESSES Add 9 to current value

JOB_QUEUE_PROCESSES 2 (depends on number of n-way sites)

JOB_QUEUE_INTERVAL 10 seconds

JOB_QUEUE_KEEP_CONNECTIONS FALSE

Parameter Name Recommended Value

SNAPSHOT_REFRESH_PROCESSES 2

SNAPSHOT_REFRESH_INTERVAL 60 seconds

SNAPSHOT_REFRESH_KEEP_CONNECTIONS FALSE
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Configuration Tasks

Perform these configuration tasks before using Advanced Replication Support:

1. Start Server Manager at the command prompt:

C:\> SVRMGR23

2. Connect to the database as INTERNAL/PASSWORD:

SVRMGR> CONNECT INTERNAL/PASSWORD

3. Execute the script CATREP.SQL once the database has started. 

This script is found in the ORACLE_HOME\RDBMS73\ADMIN directory. It 
takes approximately one hour to run. A good idea is to spool output to a log 
file first before running CATREP.SQL.

a. Enter the following command:

SVRMGR> SPOOL OUTPUT

This creates a file called OUTPUT.LOG to which to output all on-screen 
activity while the SPOOL session is open. 

b. Execute CATREP.SQL:

SVRMGR> @%ORACLE_HOME%\RDBMS73\ADMIN\CATREP.SQL

c. Close the SPOOL command by entering OFF when the script completes 
running:

SVRMGR> SPOOL OFF

OUTPUT.LOG is placed in your current directory.

4. Confirm that CATREP.SQL ran correctly by running a query on ALL_OBJECTS 
where STATUS = ’INVALID’. For example:

SVRMGR> SELECT * FROM ALL_OBJECTS WHERE STATUS = ’INVALID’;

If you find that any of the package bodies compiled incorrectly, recompile 
them manually:

SVRMGR> ALTER PACKAGE PACKAGE_NAME COMPILE BODY;

If CATREP.SQL has run successfully, a number of replication tables are created 
in the SYSTEM tablespace. The database is now set up for Advanced 
Replication. 

Note: If you installed the Replication starter database, do not 
perform the following configuration tasks.



Configuring Advanced Replication Support

                                                                   Configuration Tasks 8-21

5. Refer to the documentation listed earlier in this section for details on setting up: 

■ a Master Definition Site

■ Master Sites 

■ Updatable Snapshot Sites

■ Conflict Resolution

Data Dictionary Tables
The practical limit as to the number of master sites an environment may have is 10. 
The SNP0 to SNP9 processes each handle one destination master at a time.

If you intend to set up a large number of replicated objects, monitor the following 
data dictionary tables with the SQL SELECT command:

■ SOURCE$

■ IDL_UB1$

■ IDL_UB2$

■ I_SOURCE1I

■ ARGUMENT$

■ I_ARGUMENT1

■ IDL_SB4$

■ IDL_CHAR$

■ TRIGGER$

If necessary, increase the storage parameters to accommodate the storage 
requirements of large numbers of replicated objects.

Note:   Execute the following statement on the master site when setting up 
updatable snapshot sites:

SVRMGR> GRANT EXECUTE ON DBMSOBJGWRAPPER TO PUBLIC;
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Switching Oracle Homes (16-Bit Only)
The Oracle Installer for Windows version included on your CD-ROM disc allows 
you to maintain more than one Oracle home on a single machine and to switch 
between Oracle homes. When you install the Oracle7 Server, a top-level directory 
called Oracle home is created on your hard disk. By default, the Oracle home 
directory for Oracle 16-bit Windows 3.1x products is \ORAWIN.    

Note: Only one Oracle home can be active at a time. Therefore, if 
you install one product into one Oracle home and another into a 
different Oracle home, you will not be able to use both products at 
the same time.

Note: The capability of switching between Oracle homes is 
currently supported on Windows 3.1x, but not on Windows 95 or 
Windows NT.

Note: Before you create another Oracle home, ensure you have 
installed Oracle Installer version 3.1.4.1.5 into an existing Oracle 
home if it is not already installed. All of your Oracle homes must 
have this version of Oracle Installer or you will not be able to 
switch between Oracle homes successfully.

WARNING: Do not use the 32-bit Switch Homes because it can 
render all Oracle 32-bit installations unusable.
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Create Another Oracle Home
To create an additional Oracle home directory:

1. Run Oracle Installer from the CD-ROM disc.

2. Enter a different directory path for the additional Oracle home in the Oracle 
Installation Settings dialog box.

Each time you create another Oracle home, you are prompted by Oracle 
Installer to update the PATH variable in your AUTOEXEC.BAT file. You also 
need to restart Windows 3.1x.

3. Install Oracle Installer version 3.1.4.1.5 and any other products you want to 
install into this new Oracle home.

Your machine will be configured to use this new Oracle home.

Switch Between Oracle Homes
To switch between Oracle home directories, follow these steps:

1. Run Oracle Installer from the Oracle7 Server for Windows NT CD-ROM disc.

2. Select the Switch Homes icon from the Oracle for Windows Program Group.

3. Select the Oracle home you want to use from the Oracle Home Selection dialog 
box.

4. When Oracle Installer completes switching Oracle homes, the Software Asset 
Manager dialog box appears, displaying a list of products installed in your 
Oracle home.

Each time you switch between Oracle homes, Oracle Installer updates the 
PATH in your AUTOEXEC.BAT file and you need to restart Windows 3.1x.
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9
Creating a Database

This chapter describes how to create a new database.

Specific topics discussed are:

■ Creating a Database Using CREATE DATABASE Statement

■ Creating a New Database with NT Instance Manager
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Creating a Database Using CREATE DATABASE Statement
This section describes steps to create a database. An example is used in the 
following sections to demonstrate the commands involved. In this example:

1. Create a new database whose system identifier (SID) PROD.SID is a unique 
name for an Oracle database instance.

2. Copy data from an existing database (use the starter database whose SID is 
ORCL) to PROD.

3. Set the PROD database to start automatically when the Windows NT operating 
system starts. 

The following table summarizes the database creation steps and indicates when 
each step is required, depending on if you want to:

■ Replace an existing database (and copy the data to a new database)

■ Create a new database (and no other database exists on your system)

■ Create an additional database 

Database Creation Steps Replace an 
Existing Database

Create a New 
Database (no 
other database 
exists)

Create an Additional 
Database

Step 1: Export an Existing Database (if applicable) Yes No Only if you want to 
copy data from an 
existing database to 
the additional 
database

Step 2: Delete Database Files Yes No No

Step 3: Modify or Create the INITSID.ORA File Yes Yes Yes

Step 4: Create and Start an Oracle7 Service No Yes Yes

Step 5: Prepare CREATE DATABASE SQL 
Statement

Yes Yes Yes

Step 6: Create a Database Yes Yes Yes

Step 7: Import a Database Yes No Only if you want to 
import tables and 
other objects 
exported from an 
existing database

Step 8: Update ORACLE_SID in the Registry No Yes Only if you want to 
change the default 
SID

Step 9: Back Up the New Database Yes Yes Yes
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Step 1: Export an Existing Database (if applicable)

To use the Export utility to export all data from an existing database to the new 
database:

1. Set ORACLE_SID to the database service of the database whose contents you 
want to export. For example, export the starter database ORCL. Note there are 
no spaces around the equal sign (=) character.

C:\MYDIR> SET ORACLE_SID=ORCL 

2. Run the Export utility: 

C:\MYDIR> EXP73 SYSTEM/PASSWORD FILE=MYEXP.DMP FULL=Y LOG=MYEXP.LOG 

You now have a full database export of the starter database ORCL in the file 
MYEXP.DMP, with all messages from the Export utility logged in the 
MYEXP.LOG file.

CAUTION: Database creation is an advanced function. Oracle 
Corporation recommends that you use the standard starter 
database and expand it to suit your needs if you are not an 
experienced Oracle user.

Note: Assume all operations are performed in the C:\MYDIR\ 
directory for examples used in the following sections.

Note: This step is necessary only if you want to copy the contents 
of an existing database to a new database.
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Step 2: Delete Database Files

To delete database files:

1. Shut down the starter database ORCL: 

C:\MYDIR> ORADIM73 -SHUTDOWN -SID ORCL -USRPWD PASSWORD -SHUTTYPE INST 
-SHUTMODE I

2. Delete the following database files located in the 
ORACLE_HOME\DATABASE directory:

■ SYS1ORCL.ORA

■ USR1ORCL.ORA

■ RBS1ORCL.ORA

■ TMP1ORCL.ORA

■ LOG1ORCL.ORA

■ LOG2ORCL.ORA

■ LOG3ORCL.ORA

■ LOG4ORCL.ORA

■ CTL1ORCL.ORA 

■ CTL2ORCL.ORA   

Note: This step is necessary only if you want to replace an 
existing database.

CAUTION: Do not delete the INITORCL.ORA file, as it will be 
the basis of the new initialization parameter file 
INITPROD.ORA.



Creating a Database Using CREATE DATABASE Statement

                                                                   Creating a Database 9-5

Step 3: Modify or Create the INITSID.ORA File 
If you are replacing the starter database ORCL, copy INITORCL.ORA to 
INITPROD.ORA, and modify the file. You must modify the CONTROL_FILES 
initialization parameter in the INITPROD.ORA file. Modifying the initialization 
parameters DB_NAME, GLOBAL_NAMES, and DB_FILES is highly 
recommended. If you do not have an existing INITORCL.ORA file to copy, create 
INITPROD.ORA using a text editor.   

Additional Information: See the Appendix B, "Initialization 
Parameter Files" for information on how to create an initialization 
parameter file.

Initialization Parameter How to Modify...

CONTROL_FILES This parameter lists the control files of the database. 
You do not have the control files on your file system 
at this point, because the control files are created 
when you execute the CREATE DATABASE 
statement.  

Ensure you specify the complete path and file name. 
For example,

CONTROL_FILES = 
(ORACLE_HOME\DATABASE\CTL1PROD.ORA, 

ORACLE_HOME\DATABASE\CTL2PROD.ORA)  

DB_NAME This parameter indicates the name of the database, 
and must match the name used in the CREATE 
DATABASE statement to be executed in “Step 5: 
Prepare CREATE DATABASE SQL Statement” on 
page 9-7. This name does not need to match the SID of 
the database service. You must give a unique database 
name to each database. For example, 
DB_NAME=PROD_DB

You can use up to eight characters for the database 
name. 

GLOBAL_NAMES The default value of this parameter is FALSE; 
however, it is recommended to set this parameter to 
TRUE. See the Oracle7 Server Administrator’s Guide to 
find out more about global names and how they relate 
to database links. 
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Step 4: Create and Start an Oracle7 Service

Before you create the database, first create a Windows NT service to run the 
database. This service is the Oracle7 database process, ORACLE73.EXE, installed in 
the form of a Windows NT service. Use ORADIM73 to create the service. Upon 
creation, the service starts automatically. 

To create a Windows NT service:

1. Run ORADIM73 from the MS-DOS command prompt:

C:\MYDIR> ORADIM73 -NEW -SID PROD -INTPWD PASSWORD -STARTMODE AUTO 
-PFILE ORACLE_HOME\DATABASE\INITPROD.ORA 

Note that the previously created INITPROD.ORA file is specified, with 
complete path, including drive name. 

2. Set ORACLE_SID to equal PROD. Note there are no spaces around the equal 
sign (=) character.

C:\MYDIR> SET ORACLE_SID=PROD 

DB_FILES Set this initialization parameter to the same number as 
the value of the MAXDATAFILES option of the 
CREATE DATABASE statement. The value of 100 is 
used for this example. 

DB_FILES=100

Note: Do not perform this step if you are replacing an existing 
database. It is not necessary to create a new instance if an existing 
database was installed. You can use the default instance ORCL, if it 
is available.

Additional Information: See the section, “Using NT Instance 
Manager from the Command Line (ORADIM73)” in Chapter 3, 
"Database Tools".

Initialization Parameter How to Modify...
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Step 5: Prepare CREATE DATABASE SQL Statement
You can enter the CREATE DATABASE statement directly in Server Manager. 
Alternatively, you can use a text editor to create a SQL script containing the 
CREATE DATABASE statement, and then execute the script in Server Manager. In 
this example, this script is called CREATE_PROD_DB.SQL, located in the 
C:\MYDIR directory. 

The text of the CREATE_PROD_DB.SQL script is given below. 

CREATE DATABASE PROD_DB 

  LOGFILE ’C:\MYDIR\DATABASE\LOG1PROD.ORA’ SIZE 1M, 

          ’C:\MYDIR\DATABASE\LOG2PROD.ORA’ SIZE 1M, 

          ’C:\MYDIR\DATABASE\LOG3PROD.ORA’ SIZE 1M, 

          ’C:\MYDIR\DATABASE\LOG4PROD.ORA’ SIZE 1M 

  MAXDATAFILES 100 

          DATAFILE ’C:\MYDIR\DATABASE\SYS1PROD.ORA’ SIZE 20M 

  NOARCHIVELOG 

  CHARACTER SET WE8ISO8859P1; 

This statement creates a database where: 

Additional Information:  See Oracle7 Server SQL Reference for the 
complete syntax of the CREATE DATABASE statement.

Parameter Description

PROD_DB Is the name of the database (the same name as entered 
for DB_NAME in the INITPROD.ORA file).

LOGFILE Specifies four (minimum required) online redo log files 
of 1 MB each in size. It also reserves space for 100 data 
files in the control file, and creates a single data file of 20 
MB in size, to be used for the SYSTEM tablespace. 
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Step 6: Create a Database
1. Check if the service is started in the Windows NT Control Panel. In this 

example, the service name is OracleServicePROD, and its status column should 
display Started. If not, single-click the service name and choose the Start button 
to start the service. Alternatively, check the status of the service by entering the 
following at the MS-DOS command prompt: 

C:\> NET START 
A list of all Windows NT services currently running on the system appears. If 
OracleServicePROD is missing from the list, enter: 

C:\> NET START OracleServicePROD 

MAXDATAFILES Sets the maximum number of data files that can ever be 
used by the new database. If you subsequently want to 
increase this limit, you must re-create the control files of 
the database. See the explanation of the CREATE 
CONTROLFILE statement in Oracle7 Server SQL 
Reference for more information.

The default value of MAXDATAFILES on Windows NT 
is 32, and the maximum value is 1022.

NOARCHIVELOG Is the default setting. If you want to enable archiving, 
change this entry to ARCHIVELOG.

CHARACTER SET WE8ISO8859P1 is the recommended 8-bit character set 
for Western European languages, which includes 
English. This 8-bit character set is recommended over 
the default set US7ASCII, which can handle 7-bit 
characters only and is therefore of little use for 
languages other than English. Note the default character 
set used by Oracle client applications on various 
Windows operating systems is WE8ISO8859P1. 

Note: The file names, locations, and sizes in the 
CREATE_PROD_DB.SQL script are only examples. Your database 
will have different values to suit your requirements.

Parameter Description
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2. Make PROD the current SID: 

C:\MYDIR> SET ORACLE_SID=PROD 
C:\MYDIR> SET LOCAL=2:PROD

The second command overrides the setting of the LOCAL environment 
variable, if it is set in the registry or the AUTOEXEC.BAT file. Without 
overriding LOCAL, it is possible to receive an ORA-3121, ORA-9352, ORA-
12154, or ORA-12203 error in Step 3. 

3. Start Server Manager from the MS-DOS command prompt, and connect to the 
database as INTERNAL:

C:\MYDIR> SVRMGR23 
SVRMGR> CONNECT INTERNAL/PASSWORD 
The password is the one you previously used to create the service, with the 
ORADIM73 -NEW command. You should see the message Connected to an idle 
instance.

4. Start the database in NOMOUNT mode: 

SVRMGR> STARTUP NOMOUNT PFILE=ORACLE_HOME\DATABASE\INITPROD.ORA 
When the initialization parameter file INITPROD.ORA is located in the 
DATABASE subdirectory of your Oracle home directory, the PFILE 
specification is optional. Otherwise, you must specify the PFILE option with 
the complete path and file name of the initialization parameter file. Note that 
there is an equal sign (=) between the keyword PFILE and the path/filename. 
There must be no space characters around the equal sign (=). 

5. Turn on spooling to save the messages, and run the previously created 
CREATE_PROD_DB.SQL script:  

SVRMGR> SPOOL CREATE_PROD_DB.LOG 
SVRMGR> @CREATE_PROD_DB.SQL 
This command assumes the script file is located in the directory from which 
Server Manager was invoked. If this is not the case, specify the complete path 
in front of the file name. 

Additional Information: See Oracle7 Server Error Messages for 
information on the meaning of each error. 
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If the database is created successfully, the message Statement processed appears. 
If you receive any errors, there are three possible causes: 

■ The CREATE DATABASE script contained syntax errors. Correct them.

■ Some of the files to be created by the CREATE DATABASE statement 
already exist in the file system. Make sure you are not using any file names 
already used by another database on the system.

■ There was an error at the operating system level, such as a file or directory 
permission problem. You should have received a series of errors in Server 
Manager, the last one of which should have the OSD- prefix. At the end of 
the OSD error you typically see an operating system error number in 
parentheses. To see what the error means:

From the MS-DOS command prompt, enter:

C:\> NET HELPMSG n 

or 

From the Server Manager prompt, enter: 

SVRMGR> HOST NET HELPMSG n 

where n is the operating system error number. See the section, “Operating 
System Permission Problems” in Appendix F, “Troubleshooting” for more 
information.   

6. Create tablespaces and rollback segments to be used by the new database. For 
example, see the file ORACLE_HOME\RDBMS73\ADMIN\BUILD_DB.SQL, 
which shows the commands to duplicate the starter database. It is a good idea 
to write your own commands in a script file, and execute it in Server Manager, 
similar to running the CREATE DATABASE script, rather than typing all the 
commands at the Server Manager prompt.

7. Run the following Oracle provided scripts: 

SVRMGR> @%ORACLE_HOME%\RDBMS73\ADMIN\CATALOG.SQL 
SVRMGR> @%ORACLE_HOME%\RDBMS73\ADMIN\CATPROC.SQL 

The first script generates the data dictionary, the second script installs the 
objects used by PL/SQL. 

Note: You must correct these problems before attempting to re-
create a new database.
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8. Run the following script if you want Advanced Replication functionality with 
the new database: 

SVRMGR> @%ORACLE_HOME%\RDBMS73\ADMIN\CATREP.SQL 
Note that CATREP.SQL requires at least an hour to run, depending on your 
system.

9. Turn off spooling after all scripts have finished running: 

SVRMGR> SPOOL OFF 
10. Examine the CREATE_PROD_DB.LOG file for any errors.  

Note: You may see many messages such as object to be dropped 
does not exist and name already used by another object while the scripts 
are running. These are information messages and are intended to 
occur while creating a new database. If you see any unusual errors 
in the CREATE_PROD_DB.LOG log file, see Oracle7 Server Error 
Messages for suggested actions. 

IMPORTANT: The new database contains two users, SYS and 
SYSTEM with passwords CHANGE_ON_INSTALL and 
MANAGER, respectively. For security reasons, change the 
passwords now. Use the ALTER USER statement to change the 
passwords:

SVRMGR> ALTER USER SYS IDENTIFIED BY new_sys_password; 
SVRMGR> ALTER USER SYSTEM IDENTIFIED BY new_system_password; 
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Step 7: Import a Database
You can choose to import the full export created in the section “Step 1: Export an 
Existing Database (if applicable)” into the new database. 

1. Exit Server Manager:

SVRMGR> EXIT 
2. Run the Import utility:

C:\MYDIR> IMP73 SYSTEM/PASSWORD FILE=MYEXP.DMP FULL=Y LOG=MYIMP.LOG  

Step 8: Update ORACLE_SID in the Registry 
If this is the first database on the system or if you want to make the new database 
the default database, you must make a change in the registry. 

To make a change in the registry:

1. Invoke the registry editor at the MS-DOS command prompt by entering 
REGEDT32. For example,

C:\MYDIR> REGEDT32 

2. Choose the \\HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE key. 

3. Locate the ORACLE_SID parameter on the right side of the registry screen.

4. Double-click the parameter name, and change the data to the new SID, which is 
PROD in this example.

If you do not have ORACLE_SID because this is the first database on your system, 
you must create the ORACLE_SID parameter, called a value in Windows NT 
terminology.

IMPORTANT: Users with missing default and/or temporary  
tablespace(s), will have their corresponding tablespaces set to the 
SYSTEM tablespace. A solution is to precreate the users with 
appropriate settings for default and temporary tablespaces 
before the import is done.



Creating a Database Using CREATE DATABASE Statement

                                                                   Creating a Database 9-13

On Windows NT 3.51:

1. Go to the Edit menu, and choose the Add Value... item.

The Add Value dialog box appears.

2. Enter ORACLE_SID in the Value Name field and REG_EXPAND_SZ in the 
Data Type field. 

3. Click OK.

4. Set the String to PROD in the String Editor dialog box.

On Windows NT 4.0:

1. Go to the Edit menu.

2. Choose the New... item, and choose the String Value sub-item.

3. Change the Value Name to ORACLE_SID.

4. Double-click on the Value Name, and set the Value Data to PROD. 

Step 9: Back Up the New Database 

To back up the new database:

1. Shut down the instance and stop the service: 

C:\MYDIR> ORADIM73 -SHUTDOWN -SID PROD -USRPWD PASSWORD 
-SHUTTYPE SRVC,INST -SHUTMODE I 

WARNING: If anything goes wrong while operating the new 
database without a backup, you must repeat the database 
creation procedure. Back up your database now to prevent this 
from happening. 

WARNING: Although ORADIM73 returns the prompt 
immediately, you must wait for the database and the service to 
stop completely before continuing to Step 2. Wait until the 
Control Panel indicates the OracleServicePROD service has 
stopped. If you do not do this, the backup may be useless as it 
was taken while data was being written to the data files.
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2. Using the tool of your choice, back up the database file:

■ initialization parameter file

■ control files

■ online redo log files

■ data files

You can now start the database again, create users and objects if necessary, 
make any other changes, and use the database. Ensure you make a database 
backup, if possible, after making any significant change to the database, such 
as switching the ARCHIVELOG mode or adding a tablespace or data file. 

Creating a New Database with NT Instance Manager
The GUI mode of NT Instance Manager provides a graphical interface to perform 
most of the tasks described in the previous sections. 

While some users may find the graphical interface easier to use than Instance 
Manager command line, keep in mind that command line gives greater control 
over the customizing of the new database, as well as providing you with a script 
file that documents the exact CREATE DATABASE statement used to create the 
database.

When you click the New button in Instance Manager GUI, you see a dialog box 
with many fields. This dialog box, and another one which pops up when you click 
the Advanced button, provide a graphical interface to write the CREATE 
DATABASE statement. Consult the online help and the syntax description of the 
CREATE DATABASE statement in Oracle7 Server SQL Reference to find out what 
each field of the dialog boxes is used for. 

When you have entered the correct entries in all fields and have clicked the OK 
button, NT Instance Manager: 

■ creates the services for the new database 

■ executes the generated CREATE DATABASE statement 

■ runs CATALOG.SQL and CATPROC.SQL scripts 

Additional Information: See Chapter 12, "Backing Up and 
Recovering Database Files", Oracle7 Server Concepts, and Oracle7 
Server Administrator’s Guide for more information on archiving and 
backup/recovery.
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You must separately create custom tablespaces and rollback segments, and run 
CATREP.SQL if you intend to use Advanced Replication. The rest of the steps and 
considerations are the same as when using ORADIM73. 
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10
Administering a Database

This chapter describes how to administer Oracle7 Server.

Specific topics discussed are:

■ Starting and Stopping Oracle Services

■ Starting and Shutting Down a Database with Server Manager

■ Setting Up Oracle Enterprise Manager for Database Startup or Shutdown

■ Starting a Database with Oracle Enterprise Manager

■ Shutting Down a Database with Oracle Enterprise Manager

■ Running Multiple Instances

■ Integrating Database User Authentication with Windows NT

■ Authenticating Database Administrators

■ Granting Database Roles with Windows NT

■ Encrypting Database Passwords

■ Using the Oracle Enterprise Manager Console
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Starting and Stopping Oracle Services
When you reboot your Windows NT machine, the following three main Oracle 
services are started:

The OracleStartSID service may or may not be present depending on the startup 
type of the database. If the Oracle services were created using the AUTO startmode 
with the NT Instance Manager, both the OracleStartORCL and 
ORACLEServiceORCL services will be present. 

Service Description

OracleServiceORCL Created for the database instance ORCL. An Oracle instance is 
a logical term that refers to:

■ an Oracle service called OracleServiceORCL

■ a database

Each Oracle instance must have a system identifier (SID). A 
SID is a unique name for an Oracle database instance that can 
be up to four alphanumeric characters in length. The default 
SID of ORCL is appended to the service OracleService. Each 
file for the database instance ORCL in the ORACLE_HOME\ 
DATABASE directory has this SID as part of its name (for 
example, CTL1ORCL.ORA, LOG1ORCL.ORA, and 
INITORCL.ORA). The instance name is the same as the value 
of the ORACLE_SID registry configuration parameter.

To connect to a specific Oracle database, users must specify a 
service name (also known as a connect string) that contains a 
SID for that database.

OracleStartORCL Starts the database instance ORCL automatically whenever the 
Windows NT machine reboots.

OracleTNSListener Listens for and accepts incoming connection requests from 
client applications. Automatically starts when the Windows 
NT machine reboots. 
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Starting Oracle Services
When the OracleStartORCL and ORACLEServiceORCL services are created, their 
startup type is set to Automatic. Therefore, the Oracle services should have the 
status Started. This can be verified in the Windows NT Control Panel. If the Oracle 
services are not started, you must start them before starting the database. You can 
start the Oracle services from the Control Panel or the command prompt.

From the Control Panel:
1. Go to the Services dialog box:   

2. Find OracleServiceSID in the list and check that the status is Started. If 
OracleServiceSID is not Started, select it, and click Start.

From the command prompt 
1. Enter the following:

C:\> NET START OracleServiceSID 
If the Oracle service you are looking for is not found in the Services Control Panel, 
then create it with NT Instance Manager in command line mode. Do not use the 
GUI mode of NT Instance Manager as it will try to create the database as well as 
the Oracle services.

If Using Then...

Windows NT 3.51 Choose Main>Control Panel>Services

Windows NT 4.0 Choose Start>Settings>Control Panel>Services

Additional Information: See Chapter 3, “Database Tools” for 
more information on using NT Instance Manager in command line 
mode.
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Additional Oracle Services
Depending upon what other products you have installed, additional Oracle 
networking and server services can be available:

Stopping Oracle Services
Oracle services can be stopped from the Control Panel or the command prompt.

From the Control Panel: 
1. Go to the Services dialog box:   

2. Select the Oracle service, and click Stop.

From the command prompt: 
In this example, the service OracleServiceSID is stopped. Use the same syntax to 
stop other Oracle services.

1. Enter the following to stop the service: 

C:\> NET STOP OracleServiceSID 
SID is the SID of the service to stop.

Service Description

OracleAgent Listens for and responds to job and event requests sent from 
the Oracle Enterprise Manager Console.

OracleConTextService73 ConText server processes started on a Windows NT server are 
normally terminated by Windows NT when the user logs off. 
This service can be used to start server processes that survive 
logouts.

OracleNamesService Enables the Oracle Names Server to accept client connections.

If Using Then...

Windows NT 3.51 Choose Main>Control Panel>Services

Windows NT 4.0 Choose Start>Settings>Control Panel>Services
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Auto-starting Oracle Services
Use the Service dialog box to configure when and how the Oracle7 Server is started. 

To configure the Oracle7 Server to start automatically each time you reboot:

1. Go to the Services dialog box:   

2. Double-click Services.

The Services dialog box appears.

3. Select the service OracleStartORCL and click the Startup button.

The Service dialog box appears.

4. Specify the startup type Automatic.

Starting and Shutting Down a Database with Server Manager

Starting Server Manager
To start or shut down an Oracle7 Server with Server Manager:

1. Start Server Manager at the MS-DOS command prompt:

C:\>SVRMGR23

2. Connect to the Oracle7 Server:

SVRMGR> CONNECT INTERNAL/PASSWORD

If Using Then...

Windows NT 3.51 Choose Main->Control Panel->Services

Windows NT 4.0 Choose Start->Settings->Control Panel->Services

Note:   The password for INTERNAL is ORACLE if you installed 
your Oracle7 Server through the Oracle7 Server option. If you 
installed your Oracle7 Server through the Custom installation 
option, the password for INTERNAL is whatever you entered 
when prompted during installation.
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3. Follow the instructions below:

Starting a Database with Server Manager
Before starting the database, ensure that a database instance has been created and 
that the services have been started. See the previous section, “Starting Server 
Manager”, for procedures on starting Server Manager.

1. Start up the database by entering one of the following commands: 

After completing these steps, you can connect to the Oracle7 Server.

To... Go to Section...

Start a database Starting a Database with Server Manager

Shut down a database Shutting Down a Database with Server Manager

Startup Command Description

SVRMGR> STARTUP Uses the default INITSID.ORA file located in your 
ORACLE_HOME\DATABASE directory to start the Oracle7 
Server.

SVRMGR> STARTUP PFILE=PATH\FILENAME Uses an initialization file other than the default to start your 
database. PATH\FILENAME specifies an initialization parameter 
file other than the default, INITSID.ORA. The following example 
starts the database using a file named INIT2.ORA. 

SVRMGR> STARTUP PFILE=%ORACLE_HOME%\RDBMS73\INIT2.ORA

Note:   See Chapter 3, “Database Tools”, for a list of other tools that can 
start the database.



Starting and Shutting Down a Database with Server Manager

                                                     Administering a Database 10-7

Shutting Down a Database with Server Manager
See the section, “Starting Server Manager”, for procedures on starting Server 
Manager. 

To shut down a database using Server Manager: 

1. Enter the following command:

SVRMGR> SHUTDOWN [MODE]

where MODE is one of the following:

Normal The database waits for all currently connected users to 
disconnect and disallows any new connections before shutting 
down. This is the default mode.

Immediate The database terminates and rolls back active transactions, 
disconnects clients, and shuts down.

Abort The database terminates active transactions and disconnects 
users; it does not roll back transactions. The database performs 
automatic recovery and rollback the next time it is started. Use 
this mode only in emergencies.

Note:   See Chapter 3, “Database Tools”, for a list of other tools that can 
shut down the database.
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Setting Up Oracle Enterprise Manager for Database Startup or 
Shutdown

Oracle Enterprise Manager enables you to start and shut down your Oracle7 Server 
in several different ways. This section describes how to use the Navigator. You can 
also use:

■ SQL Worksheet 

■ Instance Manager 

See the Oracle Enterprise Manager Administrator’s Guide for information on using 
these tools to start or shut down your database.

To set up Oracle Enterprise Manager to be started or shut down:

1. Open Oracle Enterprise Manager:

The Repository Login Information dialog box appears.

Note: This section assumes you have configured Oracle 
Enterprise Manager. If you have not, see Chapter 8, “Configuration 
Tasks”, for instructions.

If Using Then...

Windows NT 4.0 1.  Choose Start>Programs>Oracle Enterprise 
Manager>Enterprise Manager.

Windows NT 3.51 1.  Double-click the Oracle for Windows NT Program Group.

2.  Double-click Oracle Enterprise Manager.
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2. Enter your repository user login information.

The Oracle Enterprise Manager appears. The Navigator window displays in the 
upper-left portion of the Console.

3. Double-click Databases in the Navigator window of the Oracle Enterprise 
Manager Console.

The list of databases in your Oracle Enterprise Manager network appears.

4. Select the database to administer.

If this is the first time you have started the database with Oracle Enterprise 
Manager, you must perform steps 5 through 12. Otherwise, go to step 13.

5. Choose Tools>Applications>Oracle Instance Manager from the main menu.

Note: A SQL*Net service entry is only necessary if you are 
connecting from a client Oracle Enterprise Manager Console 
machine to the Oracle7 repository database on a separate machine. 
If the repository database is on the same machine as your Oracle 
Enterprise Manager Console, you do not need to enter a service 
name.
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The Login Information dialog box appears.

6. Enter the INTERNAL user name and password, and SQL*Net service name for 
the Oracle7 Server.

7. Click OK.

The Oracle Instance Manager window appears.

8. Double-click Initialization Parameters in the Navigator tree.

The initialization parameters appear for the Oracle7 Server that you want to 
start.

9. Click Save.

The Save Configuration dialog box appears.

10. Enter an appropriate configuration name for the initialization parameters (for 
example, SALES_DB) and click OK.

11. Choose Exit from the File menu.

The Oracle Enterprise Manager Console appears.

12. Select the database to administer in the Navigator window.

13. Follow the instructions below:

Note: If this is the first time you have used Oracle Instance 
Manager, the Login Information dialog box appears. If you have 
previously logged in, the Oracle Instance Manager opens without 
prompting you to log on. Go to Step 8 if you have previously 
logged on.

To... Go to Section...

Start a database “Starting a Database with Oracle Enterprise Manager”

Shut down a database “Shutting Down a Database with Oracle Enterprise 
Manager”
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Starting a Database with Oracle Enterprise Manager
To start a database with Oracle Enterprise Manager:

1. Ensure that you have completed the steps in the earlier section “Setting Up 
Oracle Enterprise Manager for Database Startup or Shutdown” and that you 
have right-clicked the database in the Navigator tree that you want to start.

If this is the first time you have started the database with Oracle Enterprise 
Manager, you must perform steps 2 through 4. Otherwise, go to step 5.

2. Choose Connect from the menu that appears.

The Login Information dialog box appears.

3. Enter the INTERNAL user name and password, and click OK.

4. Right-click the database in the Navigator tree that you want to start.

5. Choose Startup from the menu that appears:

The Startup dialog box appears.
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6. Provide the appropriate information and click OK.

Your Oracle7 Server starts. A confirmation dialog box appears.

7. Click OK.

Shutting Down a Database with Oracle Enterprise Manager
To shut down a database with Oracle Enterprise Manager:

1. Ensure that you have completed the steps in the section “Setting Up Oracle 
Enterprise Manager for Database Startup or Shutdown”.

2. Right-click the database in the Navigator tree that you want to shut down.

If this is the first time you have shut down the database with Oracle Enterprise 
Manager, you may have to perform steps 3 through 5. Otherwise, go to step 5.

3. Choose Connect from the menu that appears.

The Login Information dialog box appears.

4. Enter the INTERNAL user name and password, and click OK.

5. Right-click the database in the Navigator tree that you want to shut down.

6. Choose Shutdown from the menu that appears:
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The Shutdown Options dialog box appears: 

7. Provide the appropriate information and click OK.

Your Oracle7 Server shuts down. A confirmation dialog box appears.

8. Click OK.

Running Multiple Instances
To run multiple instances, ensure that you have already created each instance and 
started the services for each instance using NT Instance Manager in line mode 
(ORADIM73) or the Services dialog box in Windows NT Control Panel. 

You then run multiple instances by starting each of the instances using Server 
Manager. 

To run multiple instances:

1. Set a value for the ORACLE_SID configuration parameter at the command 
prompt for each instance you want to run:

C:\> SET ORACLE_SID=SID

where SID is the name of the instance.

2. Start Server Manager at the MS-DOS command prompt:

C:\>SVRMGR23

3. Connect as INTERNAL:

SVRMGR>CONNECT INTERNAL/PASSWORD

4. Start up the database with the new instance:

SVRMGR>STARTUP PFILE=%ORACLE_HOME%\RDBMS73\INITSID.ORA

where SID is the name of the new instance.
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Integrating Database User Authentication with Windows NT
This section describes how to authenticate non-privileged database users (users 
who are not database administrators) using the Windows NT operating system, 
without requiring passwords at the database level. 

When you use Windows NT to authenticate non-privileged users, your database 
relies on Windows NT to restrict access to database accounts. A database password 
is not needed for this type of logon. 

To use Windows NT for non-privileged user authentication:

1. Set the OS_AUTHENT_PREFIX parameter in the INITSID.ORA file, and use 
this prefix in Oracle user names. The default value for this parameter is OPS$. 

2. Create an operating system authenticated user by entering the following:

SVRMGR> CREATE USER OPS$USERID IDENTIFIED EXTERNALLY;

where:

For example, to authenticate a user whose Windows NT user name is FRANK, 
when the OS_AUTHENT_PREFIX is set to XYZ, enter:

SVRMGR> CREATE USER XYZFRANK IDENTIFIED EXTERNALLY;

If you access a shared resource on the Oracle7 Server from a Windows NT or 
Windows 95 workstation and connect to the Oracle7 Server, then you do not need 
to enter your Oracle7 Server user name. For example, using Server Manager, enter:

SVRMGR> CONNECT /@DESTINATION

where @DESTINATION is the SQL*Net 2.3 service name (sometimes referred to as 
a connect string) of the remote database.

Note:   See the chapter “Managing Users and Resources” in the Oracle7 
Server Administrator’s Guide for general information on authenticating users.

OPS$ is the value set for the OS_AUTHENT_PREFIX initialization parameter.
USERID identifies the user’s Windows NT user name.
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Oracle7 Server then:

■ searches the data dictionary tables for an automatic logon user name 
corresponding to the user name of FRANK (retrieved by using operating 
system mechanisms such as a SQL*Net authentication adapter)

■ verifies it

■ allows you to connect as XYZFRANK

As the Oracle7 Server user name is the whole name XYZFRANK, all objects created 
by XYZFRANK (that is tables, views, indexes, etc.) are prefixed by this name. For 
another user to reference the table SHARK owned by XYZFRANK, the user must 
enter:

SVRMGR> SELECT * FROM XYZFRANK.SHARK

Note:   SQL*Net version 2.3 supports automatic authorization accounts for 
all protocols using the Windows NT Native Authentication Adapter. The 
user must be already authenticated on the Windows NT workstation or 
server running the Oracle7 Server. An authenticated connection is 
established between the client workstation and the Windows NT 
workstation or server when a shared resource is accessed and the correct 
user name/password are supplied, or if the current Windows NT, 
Windows 95, or Windows for Workgroups user has NET Logon privileges 
on the machine.

Note:   You can set OS_AUTHENT_PREFIX to the null string (a set of 
double quotes with no string included, “”). This setting eliminates the need 
for any prefix to the Windows NT user names.

Note:   No other changes are required in the INITSID.ORA initialization 
parameter file to enable an automatic log on.
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Authenticating Database Administrators
You authenticate database administrators for Oracle7 Server using any of these 
methods:

■ Using Password Files

■ Using Operating System Authentication

■ Connecting as SYSOPER and SYSDBA

■ Connecting as INTERNAL

Using Password Files
The NT Instance Manager creates password files as part of the process of creating 
an instance. Password files are located in the ORACLE_HOME\DATABASE 
directory and are of the form PWDSID.ORA where SID identifies the instance. A 
password file contains two essential elements:

Use Server Manager to add or delete user names, user passwords, and user 
privileges in password files.

In addition to creating the password file, you must also set the initialization 
parameter REMOTE_LOGIN_PASSWORDFILE to the appropriate value in the 
INITSID.ORA file. 

Note:    See the chapter “The Oracle7 Database Administrator” in Oracle7 
Server Administrator’s Guide for more information on selecting a database 
administrator authentication method.

Element Description

PASSWORD Sets the password for INTERNAL and SYS accounts.

ENTRIES Sets the maximum number of entries in the password file. This 
corresponds to the maximum number of distinct users allowed 
to connect to the database with the SYSDBA and SYSOPER 
DBA roles.
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Appropriate values are:       
NONE Indicates that Oracle7 Server ignores the password file and that 

privileged users are authenticated by the Windows NT operating 
system.

EXCLUSIVE Indicates that only one instance can use the password file and that 
the password file contains names other than SYS and INTERNAL. 
Oracle7 Server looks in the registry for the value of the 
ORA_SID_PWFILE parameter. If a value is unspecified, it looks in 
the registry for the value of the ORA_PWFILE parameter, which 
points to a file containing the INTERNAL password as well as user 
names, passwords, and privileges. If that parameter is not set, it 
uses the default of ORACLE_HOME\DATABASE\PWDSID.ORA.

EXCLUSIVE disallows the changing of the database password 
(done by re-creating the password file) while the database is 
running. If the password file is changed with the database running, 
the database refuses all further connections as INTERNAL, and the 
database must be forced to shut down, by stopping the instance. 
To allow password changes, see the description for the SHARED 
setting. To change the INTERNAL password with EXCLUSIVE set, 
you must shut down the database before changing the password.

SHARED Indicates that more than one database can use the password file. 
However, the only users recognized by the password file are SYS 
and INTERNAL. You cannot log in with SYSOPER or SYSDBA 
privileges even if those privileges are granted in the password file. 
The SHARED value of this parameter affords backward 
compatibility with earlier releases of Oracle7 Server. Oracle7 
Server looks for the same files as it does when the value is 
EXCLUSIVE, but only the INTERNAL account is available for 
privileged access. SHARED is the default value.

This setting for Oracle Parallel Server allows multiple instances to 
share a password file. The side effect is that, for a single instance, it 
allows the password file to be changed while the database is 
running. Changing the password with the database up and 
running and using the SYSDBA/SYSOPER privileges are mutually 
exclusive requirements; you can have one but not the other.

CAUTION:    Do not move or copy password files manually. If you 
manually copy a password file, the NT Instance Manager may not be 
able to find a password to start an instance.
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Using Operating System Authentication
If you choose, you can have the Windows NT operating system authenticate 
database administrator users. 

To use operating system authentication:

1. Set up the Windows NT user corresponding to the database administrator user 
to be authenticated by the operating system.

2. Ensure that the REMOTE_LOGIN_PASSWORDFILE initialization parameter is 
set to NONE in the INITSID.ORA file. Setting this parameter to NONE causes 
Windows NT to ignore the password file. REMOTE_LOGIN_PASSWORDFILE 
can have the value NONE, EXCLUSIVE, or SHARED as described in the 
section “Using Password Files”.

An authenticated database administrator can now connect to a local or remote 
database over a secure connection by entering the following commands:

SVRMGR> CONNECT INTERNAL

SVRMGR> CONNECT / AS SYSOPER

SVRMGR> CONNECT / AS SYSDBA

Connecting as SYSOPER and SYSDBA
Database administrators who use CONNECT INTERNAL, CONNECT / AS 
SYSDBA, and CONNECT / AS SYSOPER from a client workstation must belong to 
one or more of the following Windows NT local groups: 

■ ORA_OPER

■ ORA_DBA 

■ ORA_SID_DBA

■ ORA_SID_OPER

The SYSDBA and SYSOPER privileges are mapped as follows:

This role... Maps to these Windows NT Local Groups...

SYSDBA ORA_SID_DBA, ORA_DBA

SYSOPER ORA_SID_OPER, ORA_OPER, ORA_SID_DBA, ORA_DBA
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For example, if an authenticated connection exists between a client workstation and 
a Windows NT computer running Oracle7 (with the authenticated user name being 
NTUSER2), then Oracle7 searches for the user name NTUSER2 in group 
ORA_ORCL_DBA when the user enters the command:

SVRMGR> CONNECT / AS SYSDBA

If the user name NTUSER2 is located, the user is given DBA privileges. If the user 
name is not found, Oracle7 checks the global group ORA_DBA.

Connecting as INTERNAL
There are two ways to connect as INTERNAL to Oracle7 Server:

■ with a password (using a password file)

■ without a password (using operating system authentication)

This section describes both types of connections.  

Connecting as INTERNAL with a Password
To connect as INTERNAL with a password:

1. Create a password file using the ORAPWD73 utility. See the Oracle7 Server 
Administrator’s Guide for information.

2. Set the REMOTE_LOGIN_PASSWORDFILE initialization parameter to 
EXCLUSIVE or SHARED in the INITSID.ORA file.

3. Connect to your database as follows:

SVRMGR> CONNECT INTERNAL/PASSWORD

Note: The password for INTERNAL is ORACLE if you installed 
Oracle7 Server using the Oracle7 Server installation option. If you 
installed Oracle7 Server using the Custom Installation option, the 
password is whatever you entered when prompted during 
installation.

Note: When the REMOTE_LOGIN_PASSWORDFILE 
initialization parameter is set to NONE in the INITSID.ORA file, 
connecting remotely to a database as INTERNAL is prohibited 
even if the correct password is supplied.
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Connecting as INTERNAL without a Password
You may connect as INTERNAL without a password, from a:

■ Local Windows NT client to a Windows NT server on the same computer

■ Remote Windows NT client

■ Remote Windows 95 client

■ Remote Windows 3.1 client

To connect as INTERNAL without a password, you must install SQL*Net Server 
version 2.3 on an Oracle7 Server and SQL*Net Client version 2.3 on a client. Both 
products include the Windows NT Authentication Adapter, which enables a user to 
make secure Windows NT and Windows 95 client connections to Oracle7 Server 
without a password. To do this, you must create a new local Windows NT users 
group and add a Windows NT operating system user to that group. This enables 
you to log into a Windows NT domain, of which your Oracle7 Server is just one of 
many resources to which you have access. Once you access this domain, you are 
automatically validated as an authorized DBA who can access the Oracle7 Server 
without a password.

To create a user account that uses the Windows NT Authentication Adapter:

1. Identify a Windows NT user account on your Oracle7 Server.

2. Set the REMOTE_LOGIN_PASSWORDFILE parameter to EXCLUSIVE or 
SHARED in the INITSID.ORA file.

3. Create a new local user group called ORA_SID_DBA or ORA_DBA with the 
Windows NT User Manager: 

a. Open the Windows NT User Manager.

b. Choose User>New Local Group from the top menu.

The New Local Group dialog box appears.

Note: Oracle7 Server does not support setting the Windows NT 
registry DBA_AUTHORIZATION parameter to the value of 
BYPASS. However, you can set the DBA_AUTHORIZATION in 
the registry on the client side to the value of the password for 
INTERNAL.
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c. Create a database role in the Group Name field with the following syntax:

Both roles have DBA privileges.

d. Click OK.

The database group appears in the Groups list at the bottom of the User 
Manager Utility main window.

e. Double-click the new group in the Groups list.

The Local Group Properties dialog box appears.

f. Click Add.

The Add Users and Groups dialog box appears.

g. Select the Windows NT user account you created in Step 1 and click Add.

h. Click OK to grant the database role to the NT user account.

The Windows NT user account appears in the Local Group Properties dialog 
box.

i. Click OK.

You are returned to the User Manager main window. 

j. Exit User Manager.

4. Create a shared drive or printer on your Oracle7 Server computer.

5. Connect to the shared drive or printer from your Windows NT, Windows 95, 
or Windows 3.1 client with the Windows NT user account you created earlier.

You are now connected to your Windows NT domain and its resources.

6. Open an Oracle tool such as SQL*Plus or Server Manager.

■ ORA_SID_DBA (specific to one instance) 

■ ORA_DBA (specific to all instances)
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7. Enter the following command to access the Oracle7 Server:

Granting Database Roles with Windows NT
Oracle7 Server allows database roles to be granted to users directly by Windows 
NT. When users are enrolled using the automatic authenticated accounts, Windows 
NT groups can be used to grant these users database roles. Windows NT groups 
are created by using the Windows NT User Manager utility.

When you use Windows NT to authenticate users, you can operate the database so 
that it uses Windows NT groups to identify a user’s database roles when they 
create a database session. Use the Windows NT User Manager to create, grant, or 
revoke database roles to users:

1. Set the value of the OS_ROLES initialization parameter to TRUE. The default 
setting for this parameter is FALSE. 

2. Start, or restart, the database instance.

3. Open the Windows NT User Manager utility.

4. Choose User>New Local Group from the top menu.

The New Local Group dialog box appears.

5. Create a database role in the Group Name field with the following syntax:

ORA_SID_ROLENAME [_D] [_A] 

For... Enter this...

For Windows NT local and 
remote logons

CONNECT INTERNAL/@SERVICE_NAME

where service_name maps to the database alias.

For Windows 95 remote 
logon

CONNECT INTERNAL/@SERVICE_NAME

For Windows 3.1 remote 
logon

CONNECT INTERNAL/@SERVICE_NAME

Additional Information:  See the Oracle7 Server Administrator’s 
Guide for more information on database roles.
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where:   

6. Click OK.

The database group appears in the Groups list at the bottom of the User 
Manager Utility main window.

7. Double-click the new group in the Groups list.

The Local Group Properties dialog box appears.

8. Click Add.

The Add Users and Groups dialog box appears.

9. Select a user and click Add.

10. Click OK.

The user appears in the Local Group Properties dialog box.

11. Click OK.

The User Manager main window appears.

Using this syntax appropriately, you can convert the database roles in the 
following table to Windows NT groups. Then users who are connecting to the 
ORCL instance and authenticated by Windows NT and members of all four 
groups will have the privileges associated with ROLE2 and ROLE4 by default. 

SID Indicates the database instance.

ROLE_NAME Identifies the database role granted to users of a database 
session.

D Optional character that indicates that this database role is to 
be the default role of the database user. If specified, this 
character must be preceded by an underscore. (_D)

A Optional character that indicates that this database role 
includes the ADMIN OPTION. This allows the user to grant 
the role to other roles only. If specified, this character must be 
preceded by an underscore (_A).
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ROLE1 and ROLE3 are available for use by the user if they use the SET ROLE 
command. Additionally, users can grant ROLE3 and ROLE4 to other roles: 

When OS_ROLES is set to TRUE in the INITSID.ORA file, it is important to 
understand how roles, and the privileges granted to these roles, are obtained by 
Oracle users whose IDs are not defined externally.

For example, assume an authenticated connection exists between a client 
workstation and a Windows NT computer running Oracle7 Server. The user then 
connects over SQL*Net version 2.3 with the Oracle user name SCOTT/TIGER. The 
roles applied to the Oracle user name SCOTT consist of all roles defined for the 
Windows NT user account that were mapped to the database roles above. All roles 
available under an authenticated connection are determined by the Windows NT 
user ID and the groups available to the user.

Database Roles Windows NT Groups

ROLE1 ORA_ORCL_ROLE1

ROLE2 ORA_ORCL_ROLE2_D

ROLE3 ORA_ORCL_ROLE3_A

ROLE4 ORA_ORCL_ROLE4_DA

Note:   All privileges for these roles are active when the user connects. 
When using operating system roles, all roles are granted and managed 
through the operating system. You cannot use both operating system roles 
and Oracle roles at the same time.

Note:   When Oracle7 converts the group name to a role name, it changes 
the name to uppercase letters.
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Encrypting Database Passwords 
You can encrypt the password used to verify a remote database connection. Enable 
password encryption by:

1. Setting the DBLINK_ENCRYPT_LOGIN initialization parameter in the 
INITSID.ORA file on the server computer to TRUE.

2. Setting the ORA_ENCRYPT_LOGIN configuration variable on the client 
computer to TRUE.

Once these parameters are set to TRUE, whenever a user attempts to log on 
remotely, Oracle7 Server encrypts the password before sending it to the remote 
database. If the connection fails, the failure is noted in the audit log. Oracle7 Server 
then checks if either of these parameters is set to FALSE. If so, Oracle7 Server 
attempts the connection again using an un-encrypted version of the password. If 
the connection is successful, the success is noted in the audit log, and the 
connection proceeds.

Using the Oracle Enterprise Manager Console
This section provides an overview of using the Oracle Enterprise Manager Console. 
The Console is the centralized point from which you manage your database 
network. See Chapter 5, “Understanding Oracle Enterprise Manager” for a 
conceptual overview of the Oracle Enterprise Manager and the Oracle Enterprise 
Manager Administrator’s Guide for specific instructions on using the Oracle 
Enterprise Manager Console.

You can customize the Oracle Enterprise Manager Console to suit both your 
preferences and the DBA tasks you perform. The individual windows in the Oracle 
Enterprise Manager Console can be minimized, resized, and relocated. The 
windows can be sized by selecting and dragging the splitter bar between the 
windows.

Note:   Releases prior to version 7.1 do not support encrypted passwords. If 
you are connecting to an earlier version of Oracle7 Server, you must set the 
initialization parameter DBLINK_ENCRYPT_LOGIN to FALSE for the 
connection to succeed.
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This section provides procedures for using the following Console features:

■ Logging In

■ Performing Simple Single Tasks in the Navigator

■ Creating Maps

■ Integrating Applications into the Console

Logging In
When you start Oracle Enterprise Manager, you are prompted for a user name, 
password, and service name (sometimes referred to as a connect string). By 
supplying this authentication information, you log into the repository and are 
identified by the Oracle Enterprise Manager Console and its communication 
daemon.

Whenever you submit a job or register an event set, it is marked as belonging to 
you. Any messages regarding the job or event are sent only to you.

For example: 

1. Start the Console on your office personal computer (PC). 

2. Log in to a repository.

3. Submit a backup database job to be executed that night.

4. Log out.

The next day, you can run the Console on your home PC. The agent that performed 
the backup job then delivers messages related to the backup job to the new Console 
and daemon. The agent can also notify multiple administrators of an event’s 
occurrence by email or electronic paging.

Performing Simple Single Tasks in the Navigator
The Navigator simplifies ad-hoc administration. For example, if you want to grant 
a privilege to a single user, you can click the right-mouse button on that user in the 
Navigator tree and click Quick Edit from the context-sensitive menu. The Quick 
Edit User property sheet is displayed, allowing you to easily add the privilege.

The Navigator makes it easy to perform simple, single tasks. However, for more 
complicated, composite tasks, use one of the integrated DBA applications. For 
example, to assign a set of privileges to several users, use Security Manager, one of 
the DBA applications integrated into Oracle Enterprise Manager.
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Customizing your View in the Navigator
Although the Navigator can display all objects being managed, you may not want 
to view the entire system in one Navigator tree if your system is a large and 
complex environment. Consequently, the Navigator can be divided into smaller 
tree lists. These subtrees can be displayed in separate windows. The objects in the 
Navigator can also be filtered to control which objects are displayed.

Checking the Status of an Item
Graphical cues (status indicators) show the state of an object in the Navigator tree. 
For example, the status of a database is depicted graphically by a green or red 
signal light icon. You can determine at a glance the states of items in the Navigator 
tree as they change dynamically.

Creating User-Defined Groups
A user-defined group is a collection of nodes or services of the same type. You can 
group services based on organization, geographic location, or function. For 
example, you might create a group of databases called CAL_MAIL that contains 
the mail databases in California.

Because nodes and services can belong to more than one group, a group can also 
contain other groups of the same type. For example, the group CAL_MAIL can 
belong to the group US_MAIL, which is a group of all the mail databases in the 
United States.

Groups can be placed on maps. If you double-click a group icon, it expands to 
reveal its members and subgroups. The state of a group is also depicted graphically 
on a map. Groups inherit the worst state of a member. For example, if one service 
in a group is down, that state is shown on the map.

Grouping nodes or services simplifies tasks that are applied to all members of the 
group. For example, in order to back up all the databases in the CAL_MAIL group, 
you only need to schedule the backup job once with the group as the destination. 
The backup is scheduled on all relevant databases.

Creating Maps
You create maps by dragging and dropping objects from the Navigator into the 
Map window. Any number of maps can be created, then saved or edited. 

A map can perform DBA tasks. For example, you can double-click an object to call 
up its property sheet. You can also select items from the map and launch one of the 
integrated applications to administer them.
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Integrating Applications into the Console
The Console application is written in Microsoft’s Visual C++ and uses OLE2 
technology to enable applications to integrate or plug into the Console. Integrated 
applications also use the common services provided by the Oracle Enterprise 
Manager platform.

Besides the standard suite of integrated database administrator applications that 
Oracle Corporation provides with Oracle Enterprise Manager, third-party 
developers have developed integrated applications using the Enterprise Manager 
application programmatic interfaces (APIs). For more information on integrating 
third-party applications into the Console, see the Oracle Enterprise Manager 
Application Developer’s Guide.
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11
Monitoring a Database

This chapter describes how to monitor Oracle7 Server.

Specific topics discussed are:

■ Overview of Database Monitoring

■ Using Oracle7 Performance Monitor

■ Using the Event Viewer

■ Using Trace and Alert Files

■ Using the Performance Pack
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Overview of Database Monitoring 
The following tools and procedures enable you to monitor your Oracle7 database.

Each tool and procedure is described in the following sections. 

This Tool Enables You To...

Oracle7 Performance Monitor Monitor database objects, such as CPU usage, buffer 
cache, and background processes.

Event Viewer Monitor database events.

Trace Files Record occurrences and exceptions of database 
operations.

Alert Files Record important information about error messages and 
exceptions during database operations.

Oracle Enterprise Manager 
Performance Pack

Monitor and tune using tools with real-time graphical 
performance information.

Additional Information: See Oracle7 Server Tuning for general 
tuning information and your Microsoft documentation for 
additional information on Windows NT Performance Monitor 
results and optimizing database performance.
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Using Oracle7 Performance Monitor
Oracle7 Performance Monitor is a graphical tool for measuring the performance of 
Oracle7 Server objects on the local server or other servers on a network. This tool is 
the same in appearance and operation as the Windows NT Performance Monitor, 
except it has been preloaded with Oracle7 database performance elements.

On each computer, you can view the behavior of objects, such as the buffer cache, 
data dictionary cache, data files, threads, and processes. An object is a graphical 
representation of an element in your system. Every element, resource, and device 
in your system can be represented as an object.

There is a set of counters associated with each object. A counter is a unit of 
measurement used by the Performance Monitor to display activity. The type of 
activity the counter measures is dependent upon the type of object.

Certain object types and their respective counters are present on all systems. Other 
counters, such as application-specific counters (like Server Manager), appear only if 
the computer is running the associated software.

Each of these objects has an associated set of counters that provide information 
about device usage, queue lengths, delays, and information used to measure 
throughput and internal congestion.

Oracle7 Performance Monitor Setup Information

Installation
To use the Oracle7 Performance Monitor to monitor and analyze Oracle7 Server 
database performance, you must first install the Oracle7 Performance Utility. The 
Oracle7 Performance Utility enables the Windows NT Performance Monitor to 
monitor Oracle7 database objects.

Registry Information
When you install the Oracle7 Performance Utility, values are automatically set in 
the Windows NT registry as described in Appendix C, “Configuration Parameters 
and the Registry”.
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The Oracle7 Performance Monitor allows you to monitor only one database 
instance at a time. For this reason, the registry contains the following values located 
in HKEY_LOCAL_MACHINE\SYSTEM\CURRENTCONTROLSET\SERVICES
\ORACLE73\PERFORMANCE that point to a particular database instance:

■ Hostname 

■ Username

■ Password

To use the Oracle7 Performance Monitor for another database instance on the same 
computer or a UNIX computer, change the values appropriately in the registry. 
You can also monitor non-NT Oracle databases by changing the Hostname registry 
value so it points to another computer specified in the TNSNAMES.ORA file.

Accessing Oracle7 Performance Monitor
To access the Oracle7 Performance Monitor: 

Note: Oracle Corporation recommends setting the security level 
on each of these registry values. 

If Using... Then...

Windows NT 3.51 Double-click the Oracle7 Performance Monitor icon in your Oracle 
for Windows NT Program Group

Windows NT 4.0 Choose Start>Programs>Oracle for Windows NT>Oracle7 
Performance Monitor
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The Performance Monitor window appears with the Chart View:   

counters objects
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You can choose four different views for the Performance Monitor from the View 
menu:

Monitoring Oracle7 Objects
For each view (Chart, Alert, Log, Report), you can decide on the objects you want 
to monitor, and save those settings to a file. When an object is chosen, it is assigned 
a counter, a color, and added to the status bar at the bottom of the Oracle7 
Performance Monitor.

To add objects to a view:

1. From the Edit menu, choose Add To (Chart, Alert, Log, Report).

The Add to (Chart, Alert, Log, Report) dialog box appears. 

Below is the Add to Chart dialog box. Note the corresponding dialog boxes for 
the other views are different.

View Description

Chart View Displays what is going on with database in real-time.

Alert View Lets you know when certain minimum performance criteria are 
not being met, or maximum criteria are being exceeded.

Log View Maintains continuous records on performance.

Report View Saves information about specific criteria.

Additional Information: For complete information about the four 
views, see your Windows NT documentation.
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2. Select the objects you want to monitor.

Below are the components of the Add to Chart dialog box. The other views’ 
dialog boxes have similar features.

3. As you select each item to monitor, click Add.

4. Click Done when you are finished.

5. The counters you have chosen to monitor are displayed.

Component Description

Computer list box Specify the computer you want to monitor.

Object drop-down list box Select an object to monitor.

Note: If no data or Oracle7 objects appear, either the 
database is not running, or an invalid host string or 
password has been entered. If the database is not started, 
exit Performance Monitor, start the database, and restart 
Performance Monitor.

Counter list box Select a counter (or multiple counters) for the object you 
have selected. Note that the contents of the Counter box 
change depending upon your selection in the Object box.

If you want details on how a counter works, highlight 
the counter and choose Explain.

Instance box Select an instance for this counter.

Color box Choose a color for the display of the selected counter.

Scale box Choose the scale at which you want to display the 
counter.

Width box Specify the width of the line on the graph.

Style box Choose a different style for your graph line.
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Understanding Oracle7 Performance Objects

All Oracle7 system resources that can be monitored through Oracle7 Performance 
Monitor begin with Oracle7. These measures are defined in 
ORACLE_HOME\DBS\PERF73.ORA. The following table shows the Oracle7 
objects and their associated counters.

Note:   You can only monitor one instance at a time using Performance 
Monitor on a computer.

Note: For additional information on these objects, see Oracle7 
Server Tuning.

Object Counter Description

Oracle7 Buffer 
Cache

phyrds/gets % The percentage of phyrds/gets is calculated 
as a Miss ratio. If the Miss counter is higher 
than 30% to 40%, increase the number of 
buffers in the buffer cache to improve 
performance. To make the buffer cache 
larger, increase the value of the 
DB_BLOCK_BUFFERS initialization 
parameter. 

This value is not time-derived.

Oracle7 Data 
Dictionary Cache

getmisses/gets % The value of this counter must be less than 
10 or 15% for frequently accessed data 
dictionary caches. If the ratio continues to 
increase above this threshold while your 
application is running, increase the amount 
of memory available to the data dictionary 
cache.

To increase the memory available to the 
cache, increase the value of the initialization 
parameter SHARED_POOL_SIZE. (See 
Oracle7 Server Tuning for more detailed 
information on tuning memory allocation in 
the Oracle7 database.)

This value is not time-derived. 
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Oracle7 Data Files ■ phyrds/sec

■ phywrts/sec

Disk contention occurs when multiple 
processes try to access the same disk 
simultaneously. There are many ways of 
reducing disk contention, depending on the 
results from monitoring disk activity. Some 
corrective actions include: 

■ distributing I/O

■ separating data files and redo log files 

■ separating tables and indexes

■ striping table data 

These values are time-derived.

Oracle7 DBWR 
stats1

These counters are helpful in tuning the 
Buffer Cache. 

buffers scanned/sec Buffers scanned/sec is the number of buffers 
the DBWR scanned per second. The buffers 
scanned are on the LRU list. 

LRU scans/sec LRU_scans/sec is the number of times the 
DBWR scanned the Least Recently Used 
buffer list per second.

Oracle7 DBWR 
stats2

These counters are helpful in determining 
how much work the DBWR has been 
requested to perform. 

timeouts/sec Timeouts/sec is the number of times the 
DBWR timed-out per second. The DBWR is 
on a three seconds timeout interval. If the 
DBWR has not been posted within a three 
second interval, it times out. 

checkpoints/sec Checkpoints/sec is the number of 
checkpoint messages processed by the 
database writer per second. Whenever a 
checkpoint occurs, the DBWR must be 
messaged (posted) to “write dirty buffers to 
disk”. 

Object Counter Description



Using Oracle7 Performance Monitor

11-10 Oracle7 Server Getting Started Release 7.3.4 for Windows NT                                                   

Oracle7 Dynamic 
Space Management

recursive/calls per 
second

Dynamic extension causes Oracle7 to 
execute SQL statements in addition to those 
SQL statements issued by user processes. 
These SQL statements are called recursive 
calls. If Oracle7 makes excessive recursive 
calls while an application is running, it may 
be necessary to determine the cause.

Examine the recursive calls statistic through 
the dynamic performance table V$SYSSTAT.

Oracle7 Free List free list waits/       
requests %

Contention for free lists is reflected by 
contention for free data blocks in the buffer 
cache. You can determine if contention for 
free lists is reducing performance by 
querying V$WAITSTAT.

If the number of free list waits for free blocks 
is greater than 1% of the total number of 
requests, consider adding more free lists to 
reduce contention.

Oracle7 Library 
Cache

reloads/pins % The percentage of SQL statements, PL/SQL 
blocks, and object definitions that required 
reparsing. Total Reloads must be near 0. If 
the ratio of Reloads to Pins is greater than 
1%, then reduce the library cache misses.

This value is not time-derived. 

Oracle7 Redo Log 
Buffer

redo log space 
requests

The value of this counter must be near 0. If 
this value increments consistently, processes 
have had to wait for space in the redo log 
buffer. In this case, it may be necessary to 
increase the size of the redo log buffer. 

Oracle7 Sorts ■ sorts in 
memory/sec

■ sorts on disk/
sec

The default sort area size is adequate to hold 
all the data for most sorts. However, if your 
application often performs large sorts on 
data that does not fit into the sort area, then 
you may want to increase the sort area size. 

Object Counter Description
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Oracle7 Troubleshooting Information
If no data or Oracle7 objects appear, either the database is not running, or an 
invalid host string or password has been entered in the registry.

The OPERF73.LOG file located in ORACLE_HOME\DBS contains error messages 
about the Oracle7 Performance Monitor. 

To resolve this problem:

1. Check the ORACLE_HOME\DBS\OPERF73.LOG file for error messages.

2. Resolve the problem as described here:

■ If the log file indicates an invalid host string or password, check the 
registry for correct values for Hostname, Password, and Username in
HKEY_LOCAL_MACHINE\SYSTEM\CURRENTCONTROLSET
\SERVICES\ORACLE73\PERFORMANCE. See Appendix C, 
“Configuration Parameters and the Registry” for further information about 
these values.

■ If the database is not started, exit Oracle7 Performance Monitor and start 
the database.

3. Restart Oracle7 Performance Monitor.

Using the Event Viewer
Oracle7 Server problems and other significant occurrences are recorded as events. 
These events are recorded in an application event log. You view and manage these 
recorded events in the Event Viewer. 

Additional Information: See your Microsoft documentation for 
more information on using the Windows NT Event Viewer.
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Accessing the Event Viewer
To access the Event Viewer:

The Event Viewer window appears.

1. From the Log menu, choose Application.

The Application view appears: 

If Using... Then...

Windows NT 3.51 Double-click the Event Viewer icon in the Administrative Tools 
Program Group

Windows NT 4.0 Choose Start>Programs>Administrative Tools>Event Viewer

The date event took place.

The time event took place.
Application that recorded event.

Classification of event.
Unique number assigned to event.

Computer name on which 
event occurred.
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Reading the Event Viewer
The icons beside each event determine the type of event. 

Oracle7 Server events display with a source of ORACLE7.Orcl. ORACLE7.Orcl 
consists of the following event IDs:

Icon Event Type Description

red (stop sign) icon Error Indicates an error. Always check these icons.

blue 
(informational) 
icon

Information Indicates a non-critical system event. You can 
ignore these icons unless you want to track 
some specific event.

yellow 
(exclamation 
point) icon

Warning Indicates a special event, such as the 
termination of an instance or the shutdown of 
services. Investigate these icons, but they are 
usually non-critical.

Event ID Description

IDs other than 34 Specifies general database activities, such as an instance being 
started or stopped.

34 Specifies an audit trail event. These events are recorded if the 
AUDIT_TRAIL parameter is set to DB (TRUE) or OS in the 
INITSID.ORA file

The OS option enables system-wide auditing and causes 
audited records to be written to the Event Viewer.

The DB option enables system-wide auditing and causes 
audited records to be written to the database audit trail (the 
SYS.AUD$ table). Some records, however, are written to the 
Event Viewer.
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Using the Event Viewer
To use the Event Viewer:

1. Look at the icons.

2. Double-click an icon to analyze (especially red icons).

The Event Detail dialog box appears with more information about the selected 
event: 

A text description of the event.

Click Bytes to see the 
information in hexadecimal 
format. Or, click Words to see 
DWORDS for the same data.
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Using Trace and Alert Files
Oracle7 Server background threads use trace files to record occurrences and 
exceptions of database operations, as well as errors. Background thread trace files 
are created regardless of whether the BACKGROUND_DUMP_DEST parameter is 
set in the initialization parameter file. If BACKGROUND_DUMP_DEST is set, the 
trace files are stored in the directory specified. If the parameter is not set, the trace 
files are stored in the ORACLE_HOME\RDBMS73\TRACE directory.

Oracle7 database creates a different trace file for each background thread. The 
name of the trace file contains the name of the background thread, followed by the 
extension .TRC. Sample trace file syntax includes:

■ SIDDBWR.TRC 

■ SIDSMON.TRC 

where SID represents the name of the instance.

Trace files are also created for user threads if the USER_DUMP_DEST parameter is 
set in the initialization parameter file. The trace files for the user threads have the 
form ORAxxxxx.TRC, where xxxxx is a 5-digit number indicating the Windows NT 
thread ID.

The alert file contains important information about error messages and exceptions 
that occur during database operations. Each Oracle7 Server instance has one alert 
file; information is appended to the file each time you start the instance. All threads 
can write to the alert file.

For example, when automatic archiving of redo logs is halted because no disk 
space is available, a message is placed in the alert file. The alert file is the first place 
to check if something goes wrong with the database and the cause is not 
immediately obvious.

The alert file is named SIDALRT.LOG and is found in the directory specified by the 
BACKGROUND_DUMP_DEST parameter in the initialization parameter file. If the 
BACKGROUND_DUMP_DEST parameter is not set, the SIDALRT.LOG file is 
generated in ORACLE_HOME\RDBMS73\TRACE.
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Using the Performance Pack
Oracle Corporation offers an optional Performance Pack attachment to Oracle 
Enterprise Manager that consists of the following integrated monitoring and tuning 
applications:

■ Performance Monitor Applications

■ Oracle Trace

■ Oracle Expert

The Performance Pack is a powerful set of performance monitoring and tuning 
tools designed to provide real-time graphical performance information to 
customers who need to manage their dynamic database environments.

Performance Monitor Applications
Oracle Enterprise Manager Performance Pack contains the following optional 
performance monitoring applications:

■ Oracle Performance Manager

■ Oracle TopSessions

■ Oracle Lock Manager

■ Oracle Tablespace Manager

Oracle Performance Manager
Oracle Performance Manager is a tool for monitoring database performance in real 
time. It provides dozens of predefined charts for displaying a wide variety of 
database performance statistics regarding:

■ users

■ throughput

■ tablespaces

■ redo logs

■ buffers

■ caches

■ I/O

Note: The Performance Pack is not included on the Oracle7 Server for 
Windows NT CD-ROM disc and must be purchased separately.
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Oracle TopSessions
Oracle TopSessions enables you to monitor how connected sessions use database-
instance resources in real time. You can obtain an overview of session activity by 
displaying the top n sessions sorted by a statistic of your choosing. For any given 
session, you can then drill down for more detail. You can further customize the 
information you display by specifying manual or automatic data refresh, the rate of 
automatic refresh, and the number of sessions to display. 

In addition to these useful monitoring capabilities, Oracle TopSessions provides a 
methodology for identifying and correcting certain database performance 
problems. For example, when a sudden file I/O load is detected, you can first 
identify the sessions contributing to most of the problem, and then isolate the 
executing SQL statements in user applications for those sessions. You can then 
analyze the SQL explain plans for those SQL statements to determine how best to 
resolve the problem. 

Oracle Lock Manager
With Oracle Lock Manager you can monitor locks, which are mechanisms that 
prevent destructive interaction between users accessing the same resource. 

The main window displays a multi-column list that includes a row for each current 
lock in the database. The information displayed in the columns includes:

■ user name

■ session ID

■ owner of the locked object

■ name of the object

■ type of the object

Additional Information: See Oracle Enterprise Manager Performance 
Monitoring User’s Guide for specific information on using this tool.

Additional Information: See Oracle Enterprise Manager Performance 
Monitoring User’s Guide for specific information on using this tool.
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Oracle Tablespace Manager
Oracle Tablespace Manager enables you to monitor and manage tablespace 
fragmentation. You can display an overview table of space usage information, 
either for all tablespaces in a database, or for the data file(s) within a tablespace.

To find out more about a given tablespace or data file, you can click further to 
display how storage has been allocated for its segments. Clicking a segment in a 
segment list displays the extents in the tablespace or data file storing data for that 
segment. If data storage for a segment is fragmented, you can defragment it. You 
can also use the coalescing feature of Oracle Tablespace Manager to join adjacent 
free blocks. 

Starting Performance Monitor Applications
To start these applications from the Oracle Enterprise Manager Console, first select 
a database instance in the Oracle Enterprise Manager navigator tree with which to 
establish a connection. Then, proceed in one of two ways:

■ Click on the appropriate application icon from the Performance Pack launch 
palette.

■ Choose Tools>Performance Pack>application name menu option

Additional Information: See Oracle Enterprise Manager Performance 
Monitoring User’s Guide for specific information on using this tool.

Additional Information: See Oracle Enterprise Manager Performance 
Monitoring User’s Guide for specific information on using this tool.



Using the Performance Pack

                                                                   Monitoring a Database 11-19

Oracle Trace
Oracle Trace is a general-purpose data collection product that captures data for 
specific software events, such as an application transaction, a user log on, or any 
event particular to the software product. With Oracle Trace, you can collect a wide 
variety of data, such as performance statistics, diagnostics data, system resource 
usage, and business transaction details. 

Two Oracle Corporation products are currently enabled for Oracle Trace collection:

■ Oracle7 database (for performance data collection)

■ SQL*Net (for diagnostics data collection)

The Oracle7 Server performance data collected by Oracle Trace includes SQL 
statements, detailed statistics on SQL events, transactions events, and other useful 
information.

Oracle Trace provides a graphical Oracle Trace Manager application to create, 
schedule, and administer Oracle Trace collections for host products containing the 
Oracle Trace application programming interface (API).   You can store data 
collected by Oracle Trace in Oracle7 database tables for access by SQL reporting 
tools and other products.

Oracle Trace has an API that contains data collection service calls. Software 
developers can use the Oracle Trace API to pre-configure their products for Oracle 
Trace data collection. Users of a product containing the Oracle Trace API calls, such 
as the Oracle7 database, can then automatically use Oracle Trace to collect data 
about specific events that occur in that product. 

Most Oracle Trace users perform collections for products that already include the 
Oracle Trace API.    Therefore, most users only need to be familiar with the data 
that can be collected for the host product and how to use the Oracle Trace 
Collection Manager application to create and administer data collections.

Additional Information: See Oracle Enterprise Manager Oracle Trace 
User’s Guide for specific information on using this tool.
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Starting Oracle Trace
Start Oracle Trace from the Enterprise Manager Console in one of two ways:

■ Click Oracle Trace icon from the Performance Pack launch palette.

■ Choose Tools>Performance Pack>Oracle Trace menu option

Oracle Expert
Oracle Expert enables you to optimize the performance of your database 
environment. It assists you with the initial Oracle7 database configuration and the 
collection and evaluation of the performance characteristics of existing databases. 
Oracle Expert provides many advantages. Oracle Expert:

■ uses trends to ensure continued performance as the database environment 
changes over time

■ provides consistent and complete recommendations

■ performs interdependency checking during analysis

■ detects and reports symptoms of poor performance

■ sifts through vast quantities of data quickly to identify performance problems

■ identifies situations where advanced performance features of the database can 
be applied

Oracle Expert also serves as:

■ an educational tool that explains all of its tuning recommendations through 
detailed reports

■ a methodology tool that guides the DBA, analyst, and designer through the 
process of improving Oracle7 database performance

■ a maintenance tool that uses historical trends to inform the DBA of degrading 
performance and impending bottlenecks

■ an information tool that collects tuning data from numerous sources. This data 
not only feeds the tuning process, but can be displayed, edited, and reported 
on.

Additional Information: See Oracle Enterprise Manager Oracle 
Expert User’s Guide for specific information on using this tool.
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Starting Oracle Expert
To start Oracle Expert from the Oracle Enterprise Manager Console:

1. Select a database instance in the Oracle Enterprise Manager navigator tree with 
which to establish a connection.

2. Access Oracle Expert by:

■ Clicking on the Oracle Expert icon from the Performance Pack launch 
palette.

■ Double-clicking the Expert icon in the Oracle Enterprise Manager Program 
Manager.
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12
Backing Up and Recovering Database Files

This chapter provides information on backing up and recovering your database.

Specific topics discussed are:

■ Selecting a Backup and Recovery Tool

■ Backing Up Files with OCOPY

■ Recovering Files with OCOPY
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Selecting a Backup and Recovery Tool
Backing up and recovering your Oracle7 Server is one of the most critical 
operations that a DBA performs. For this reason, it is extremely important that a 
DBA choose the correct tool for performing backup and recovery. The table below 
describes each available backup and recovery tool and makes recommendations on 
which tool to use with your Oracle7 Server.  

Tool Tool and Description Analysis of Tool To Use this Tool, 
See...

Oracle7 
Enterprise 
Backup Utility 
(EBU)

Provides an effective mechanism to back 
up, restore, and recover all types of Oracle 
database files. This utility is specifically 
designed to back up very large databases. 
EBU requires a media management layer 
(MML) such as Legato Storage Manager 
(included on your Oracle7 Server for 
Windows NT CD-ROM).

Can back up to tape. Oracle7 Enterprise 
Backup Utility 
Administrator’s 
Guide and Oracle7 
Enterprise Backup 
Utility Error and 
Diagnostic Manual

Oracle 
Enterprise 
Manager 
Backup Manager

The Oracle Enterprise Manager Database 
Application Tools include a Backup 
Manager for backing up and recovering 
your Oracle7 Server. The Backup 
Manager:

■ Enables users to perform database 
backups to disk and tape

■ Creates backup scripts guided by a 
backup wizard

■ Enables users to administer redo logs 
and online tablespace backups 

■ Enables users to perform both hot 
and cold backups

The Backup Manager enables you to back 
up and recover your database through a 
graphical user interface (GUI). This GUI 
enables you to use either of the two 
backup subsystems: 

■ Operating system backup 

■ EBU

Highly recommended 
for backing up and 
recovering your 
Oracle7 Server 
because of capabilities 
and ease of use. 
Backing up to tape 
requires an MML 
from a third-party 
vendor.

Oracle Enterprise 
Manager 
Administrator’s 
Guide for 
instructions
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Backing Up Files with OCOPY 
Use OCOPY for both hot and raw database file backups of the following file types:

NT Backup 
Manager and 
NT Recovery 
Manager (GUI 
tools)

NT Backup Manager and NT Recovery 
Manager are Oracle tools that enable you 
to perform database backups to disk or 
tape.

Can back up to 4mm 
tape. Can perform hot 
and cold backups. To 
perform a hot backup, 
you must first use 
OCOPY to copy the 
files to a staging area, 
and then use NT 
Backup Manager. 

Online help 
included with these 
tools.

OCOPY An Oracle executable that behaves like the 
Windows NT XCOPY command. OCOPY 
is needed when performing a hot backup 
manually (that is, backing up a tablespace 
that is in offline backup mode).

Command line usage 
only. Can back up 
only to disk. Can only 
perform local backups.

The sections 
“Backing Up Files 
with OCOPY” and 
“Recovering Files 
with OCOPY” in 
this chapter

File Description

File Allocation Table (FAT) or 
NT File System (NTFS) files

File allocation table (FAT) or NT file system (NTFS) 
files you want to back up.

Logical raw files A logical drive (accessed with the direct I/O) identified 
by the name:

\\.\x:

Where x: is a hard drive partition letter, floppy disk 
drive, or CD-ROM drive.

Physical raw files A physical hard drive (accessed with direct I/O) 
identified by a device name of the form:

\\.\physicaldriveN

Where N is 0, 1, 2, and so on, representing each of the 
physical drives in the system.

Tool Tool and Description Analysis of Tool To Use this Tool, 
See...
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This table describes the two copy modes in which to use OCOPY:

This table describes the syntax to use when backing up all file types to hard disk or 
multiple diskettes.            

Copy Mode OCOPY is used to...

Hard disk Copy hot files to a new name and location on a hard disk where you 
can use an archive utility to back them up.

Multiple diskettes Back up large hot files directly to multiple diskettes.

Copy Mode File Type Syntax

Hard disk FAT or NTFS 
files

C:\>OCOPY73 old_file new_file

Logical raw C:\>OCOPY73 \\.\C: new_file

Physical raw C:\>OCOPY73 \\.\physicaldriveN 
new_file

Multiple diskettes FAT or NTFS 
files

C:\>OCOPY73 /B hot_file a:

Logical raw C:\>OCOPY73 /B \\.\C: a:

Physical raw C:\>OCOPY73 /B \\.\physicaldriveN a:

Where... Indicates the...

old_file Name and location of the hot file you want to back up.

new_file Name and location of the backup copy.

C: Raw drive that holds a single raw database file.

physical drive Physical drive that holds a single raw database file.

N Number(s) representing each of the physical drives in the system.

hot_file Path and filename of the hot file you want to back up. 

a: Diskette drive containing the diskette on which to save the backup 
copy. If the file is too large to fit on one diskette, OCOPY prompts you 
to insert new diskettes as needed. OCOPY catalogs the parts of the file 
automatically so that it can be reconstructed at a later time. 

/B Large files must be split over multiple diskettes.
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Recovering Files with OCOPY
The table below describes the syntax to use when recovering all file types from 
hard disk or multiple diskettes.  

1 These are files originally backed up without the /B option.
2 These are files originally backed up with the /B option.

Note:   Always use a fresh diskette for each OCOPY procedure; do not use 
OCOPY to back up a file onto a diskette that contains part or all of another 
file backed up using OCOPY. 

Restore 
From...

File Type to Restore Syntax

Hard 
Disk1

FAT or NTFS files Use the Windows NT COPY command.

Logical raw C:\> OCOPY73 new_file \\.\c: 

Physical raw C:\> OCOPY73 new_file \\.\physicaldriveN

Multiple 
diskettes2

FAT or NTFS files C:\> OCOPY73 /R a: restore_dir

Note: First insert the disk containing the initial part of 
the backed up file.

Logical raw C:\> OCOPY73 /R a: \\.\c: 

Physical raw C:\> OCOPY73 /R a: \\.\physicaldriveN

Where... Indicates the...

C: Raw drive, which holds a single RAW database file. If you use a different drive as your 
raw drive, substitute it for C:. OCOPY prompts you to insert diskettes as needed.

new_file File name to which to restore the file.

physicaldrive Physical drive that holds a single RAW database file.

N Number(s) representing each of the physical drives in the system.

/R Restore option.

a: Drive containing the diskette with the backed up file.

restore_dir Directory on the server in which to place the file. (The restored file has the same name 
as the original file.)
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13
Distributing and Managing Oracle Software

This chapter describes how to distribute and manage Oracle7 products across a 
network.

Specific topics discussed are:

■ Overview

■ Oracle Client Software Manager

■ Oracle Software Manager

■ Systems Management Server
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Overview
The following products enable you to distribute and manage Oracle software 
across a network:

■ Oracle Client Software Manager

■ Oracle Software Manager

■ Systems Management Server

This chapter provides: 

■ a brief overview of the features of each product 

■ installation, configuration, and usage instructions (where necessary)

Oracle Client Software Manager
Oracle Client Software Manager (OCSM) is part of Oracle Installer. OCSM enables 
system administrators to install and configure 16- and 32-bit Oracle products on 
machines for access by multiple client workstations. Installation is centralized, and 
updates to software on client workstations are automatic. OCSM enables:

■ users to install client software onto a file server shared by multiple clients 

■ the administrator to define software configurations and enhance the degree of 
product sharing based on client space and network performance 

■ the administrator to group individual client personal computers (PCs) with 
common software configurations 

■ the administrator to save time and effort because a single update to the server’s 
shared software pool configures many client PCs 

Follow the procedures in the sections below to create an OCSM environment:

■ Reviewing the List of OCSM-Compliant Products

■ Reviewing the Installation Requirements

■ Creating an OCSM Host Machine

■ Giving OCSM Clients Access to Oracle Home on the OCSM Host Machine

■ Registering the Client Machine

■ Understanding the Oracle Client Configuration Manager

■ Understanding Client User and Administrator Options
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■ Assigning Products

■ Assigning Clients

■ Defining Installation Options

■ Defining Conflict Resolution Installation Options

■ Using Oracle Client Software Agent

■ Understanding OCSM Files

Reviewing the List of OCSM-Compliant Products
For system requirements and instructions on installing OCSM, see the Oracle7 
Server Installation Release 7.3.4 for Windows NT. The table below lists the Oracle 
products that can be installed and maintained through OCSM:

1 Automatically installs Oracle Trace Collection Services, Oracle TCP/IP 
Protocol Adapter, Oracle Named Pipes Protocol Adapter, and Oracle SPX 
Protocol Adapter (if those networking protocols are detected on your 
network). Additional OCSM-compliant Oracle Protocol Adapters, such as 
the Oracle DECnet Protocol Adapter (not available on Windows NT 4.0) 
and Oracle LU6.2 Protocol Adapter, must be selectively installed through 
the Custom Installation option.

2  Automatically installs the Oracle TCP/IP Protocol Adapter, Oracle Named 
Pipes Protocol Adapter, and Oracle SPX Protocol Adapter if those 
networking protocols have been detected on your network. Additional 
OCSM-compliant Oracle Protocol Adapters, such as the Oracle DECnet 
Protocol Adapter, Oracle LU6.2 Protocol Adapter, and Oracle NetBIOS 
Protocol Adapter, must be selectively installed through the Custom 
Installation option.

For Windows NT/Windows 95 For Windows 3.1

All Required Support Files All Required Support Files

SQL*Plus SQL*Plus

SQL*Net Client1 SQL*Net Client2

SQL*Net Server1

ODBC
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Reviewing the Installation Requirements
To install OCSM, you must create an OCSM host machine on which to install 
Oracle products that OCSM clients can access. The table below lists the installation 
requirements for your OCSM host machine and OCSM clients. 

If the OCSM Host Machine is... Then...

Windows NT All OCSM clients registering with an Oracle home 
created on this machine must also be running Windows 
NT. 

The OCSM client machines must belong to a domain 
and have access privileges to the OCSM host machine. 

To set up, run REGEDT32 and use the Security - 
Permissions menu item to allocate access privileges for 
the various OCSM clients. Typically, an OCSM client 
requires read access to the HKEY_LOCAL_MACHINE 
key of the OCSM host machine’s registry. 

The process of assigning access privileges is the same as 
when permissions are defined for access to files and 
directories in an NTFS file system. 

Windows 95 All OCSM clients registering to an Oracle home created 
on this machine must also be running Windows 95. 

The OCSM Client machines must belong to a domain 
and have access privileges with the OCSM host 
machine. 

The Microsoft Remote Registry Services must be 
installed on both the OCSM host and client machines. 
This service is not installed by default when you set up 
Windows 95 on a machine. 

See the sections “Installing the Microsoft Remote 
Registry Service”, “Windows 95 Setup”, and “Windows 
95 Limitations” below.

Windows 3.1 All OCSM clients registering with an Oracle home 
created on this machine must also be running Windows 
3.1. See the section “Windows 3.1 Issues” for additional 
information.
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Installing the Microsoft Remote Registry Service
To install the Microsoft Remote Registry Service:

1. Click Add in the Network option of the Control Panel. 

2. Double-click Service in the Select Network Component Type dialog box. 

3. Click Have Disk in the Select Network Service dialog box.

4. Enter the path to the ADMIN\NETTOOLS\REMOTREG directory on the 
Windows 95 operating system CD-ROM disc in the Install From Disk dialog box 
and click OK. 

5. Click OK in the Install From Disk dialog box. 

6. Click Microsoft Remote Registry in the Select Network Service dialog box and 
click OK. 

Windows 95 Setup 
To enable OCSM client access to the OCSM host machine:

1. Go to the OCSM host machine.

2. Choose the Access Control Tab in the Network option of the Control Panel. 

3. Ensure user-level access control is checked.

4. Enter the domain in which the OCSM client users exist. 

5. Choose the Remote Administration tab in the Passwords option of the Control 
Panel. 

6. Ensure Enable Remote Administration Of This Server is checked.

7. Add the users to be OCSM Clients by clicking Add. 

Note: If you are prompted to specify the location of additional 
files, specify the path to the Windows 95 source files on a shared 
network directory or on the Windows 95 operating system CD-
ROM disc.
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Windows 95 Limitations
It is not possible to give read-only access for OCSM clients to the OCSM host 
machine’s registry. Hence, OCSM Clients can potentially write to the OCSM host 
machine’s registry. This is a known security problem with the current 
implementation.

Windows 3.1 Issues

Creating an OCSM Host Machine
Follow the instructions below to create an OCSM host machine for the Windows 
platform you are running:

■ Windows NT or Windows 95

■ Windows 3.1

Creating an OCSM Host Machine on Windows NT or Windows 95
To create an OCSM host machine:

1. Run Oracle Installer as described in Oracle7 Server Installation Release 7.3.4 for 
Windows NT.

2. Enter a language, company name, and Oracle home directory when prompted.

3. Select Custom when prompted for an installation type and click OK.

The Software Asset Manager dialog box appears.

4. Select Oracle Installer, Oracle Client Configuration Manager, and Oracle Client 
Software Agent (OCSA), and click Install.

Note: This release of OCSM has been tested with Microsoft 
networks, Windows for Workgroups 3.11, Windows 3.1, Windows 
95, and Windows NT 3.51 or 4.0 (Workstation and Server).

Note: The included version of Oracle Objects for OLE is not 
OCSM-compliant. If you want to take advantage of the shared-
installation feature of Oracle Installer, do not attempt to share-
install Oracle Objects for OLE.
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5. Enter the path where the client information is to be stored: 

a. Choose a location. 

The location can be outside Oracle home, but specify the full path. The 
location can be any name, although CLIENTS is the default name. 

b. Enter the name under which to share the client directory to which other 
clients connect. 

6. Click Exit when prompted to exit Oracle Installer.

Your Oracle home directory becomes an OCSM host Oracle home when the 
OCSA is installed.

Creating an OCSM Host Machine on Windows 3.1
To set up a machine as an OCSM host, run Oracle Installer in shared mode. Install 
Oracle Installer, Oracle Client Configuration Manager, and Oracle Client Software 
Agent in a shared Oracle home. 

To set up an OCSM host, follow these steps on the host machine:

1. Run Oracle Installer in shared mode by selecting the RUN option in Windows 
File Manager and entering the following command:

ORAINST.EXE /SHARED

The Language dialog box appears.

2. Select a language in which to run Oracle products and click OK.

The Oracle Installation Settings dialog box appears.

Note: The directory must be one to which clients can write.
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3. Enter the following:

■ company name 

■ path for the shared Oracle home. 

If this is the first time you have installed OCSM and you previously had a 
stand-alone Oracle home on your machine, choose a different location for your 
new shared Oracle home. The path you enter here is bound to the variable 
SHARED_ORACLE_HOME.

The Administrator Information dialog box appears.

4. Enter the OCSM administrator’s user name and click OK.

The Configuration dialog box appears.

5. Click Yes to modify the path in AUTOEXEC.BAT to include the location of the 
new Oracle products. If you do not want Oracle Installer to modify 
AUTOEXEC.BAT, click No.

6. In the Software Asset Manager window, select the following products to install:

■ Oracle Client Configuration Manager

■ Oracle Client Software Agent

■ Oracle Installer

7. Click Install to install the products.

8. Click Exit after the products are installed.

When you install OCSM, you get an Oracle for Windows program group 
containing Oracle Installer, Oracle Client Configuration Manager, and Switch 
Homes icons.

Giving OCSM Clients Access to Oracle Home on the OCSM Host Machine 
To give OCSM clients access to Oracle home on the OCSM host machine:

1. Grant the following permissions to OCSM clients: 

■ Read access to the Oracle home on the OCSM host machine. 

■ Read/write access to the client directory. The OCSA writes to this 
directory. The client directory must be shared explicitly by the 
administrator under the name specified during OCSA installation.
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Registering the Client Machine
Follow the instructions below to register the client machine for the Windows 
platform you are running:

■ Windows NT or Windows 95

■ Windows 3.1

Registering the Client Machine for Windows NT or Windows 95
To register an OCSM client:

1. Go to the client machine.

2. Map a network drive to the OCSM host machine’s Oracle home. 

3. Run BIN\SHRAGT32.EXE from the OCSM host machine’s Oracle home. 

This program places the OCSA icon in the Windows NT or Windows 95 
startup group. Consequently, the OCSA is invoked whenever Windows NT or 
Windows 95 is started or when a client user double-clicks the icon.

4. Enter an appropriate name when prompted for the client name. 

The name you enter appears in the Oracle Client Configuration Manager on the 
OCSM host machine.

5. Enter a name for the OCSM client’s Oracle home when prompted.

This is the area where Oracle products are installed locally. 

When the program exits, the Oracle Client Software Agent icon is created.

Registering the Client Machine for Windows 3.1
To register an OCSM client, the client user must map a network drive to the shared 
Oracle home on the host, then run SHARAGT.EXE. This program places the Oracle 
Client Software Agent icon in the Windows startup group. Consequently, the agent 
is invoked whenever Windows is started or when a user double-clicks the icon. 

Note: In both cases, the OCSM administrator must give you read 
access to the host Oracle home and write access to the client’s 
directory.
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To register an OCSM client, follow these steps on the client machine:

1. Map a network drive to the shared Oracle home on the host. 

To do so with Windows 3.1 or Windows NT 3.51, use the File Manager. On 
Windows 95 and Windows NT 4.0, use the Explorer. In both cases, the OCSM 
administrator needs to give you read access to %SHARED_ORACLE_HOME% 
and read/write access to the %SHARED_ORACLE_HOME%\CLIENTS 
directory.

2. Run BIN\SHARAGT.EXE from the shared Oracle home.

3. Enter an appropriate name for the client name when prompted.

The name you enter here shows up in the Oracle Client Configuration Manager 
on the host.

4. Enter the name for the local Oracle home when prompted. This is the area 
where Oracle products are installed locally.

When the program exits, the Oracle Client Software Agent icon is placed in the 
Windows startup group.

Understanding the Oracle Client Configuration Manager
The system administrator uses the Oracle Client Configuration Manager to define 
client configurations. For each configuration, the administrator must define the 
following:

■ Configuration name 

■ Configuration definitions (the set of products belonging to the configuration) 

■ Client assignments (the names of the OCSM clients belonging to the 
configuration) 

■ Install options (the installation options or instructions on how to install the 
software on the OCSM client) 

Within a configuration, the installation options control the way the products are 
installed on the OCSM clients.

Products can be installed in one of the following ways:

1. Run from OCSM host

All product executables are kept on the OCSM host machine. This saves disk 
space on the client, but the software runs slower because the client must run 
the software over the network.
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2. Download EXE/DLL to Client Machine

Configuration files (EXEs and DLLs) are downloaded to the OCSM client. This 
type of installation improves performance over "Run from OCSM host", 
because executables are run locally.

3. Install Completely on Client Machine

All product files are fully replicated on the client machine. This type of 
installation takes up more disk space than a “Run from OCSM host”, but the 
client can run the software even when the network is down. 

Understanding Client User and Administrator Options
A systems administrator sets the following options that define how OCSM clients 
run the software:

Attention: For OCSM clients on Windows NT and Windows 95, 
the client installation option “Install Completely on Client 
Machine” is always executed, even if you select “Run from OCSM 
host” or “Download EXE/DLL to Client Machine”. Even if you use 
the “Force Executable Location” option to select “Run from OCSM 
host” or “Download EXE/DLL to Client Machine”, the option 
“Install Completely on Client Machine” is executed.

For Windows 3.1, the specific client installation option you select is 
executed, and does not default to “Install Completely on Client 
Machine”. For example, if you select “Run from OCSM host”, it is 
executed.

Option Description

Force Executable 
Location

When an OCSM administrator sets the installation option as 
"Run from OCSM host", "Download EXE/DLL to Client 
Machine", or "Install Completely on Client Machine", OCSM 
client users cannot choose the location of executables. In this 
case, the placement of executables is "forced" from the host. 

When the administrator does not force the location of 
executables, Oracle Installer lets client users choose how the 
products are installed.
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Assigning Products
To assign products to a configuration:

1. Start the Oracle Client Configuration Manager:

2. Choose Configuration Definitions from the View pull-down menu. 

3. Select an existing configuration from the Configuration pull-down menu or 
click Add to create a new configuration. 

Force Product Selection When an OCSM administrator forces the installation of 
products, all products associated with the configuration are 
always installed on the OCSM client. OCSM client users cannot 
choose which products to install.

When an OCSM administrator does not force the installation of 
products in the configuration, Oracle Installer prompts client 
users for which products to install, among the list of products 
specified by the administrator.

Conflict Resolution When a client belongs to more than one configuration and 
some options are set differently for the different configurations, 
a conflict arises. To resolve such conflicts, the administrator 
must define a general conflict resolution setting. The conflict 
resolution options are identical to the regular installation 
options. 

 Note: The conflict resolution setting does not apply to specific 
pairs of configurations. It is one general setting used to resolve 
all OCSM client configuration conflicts.

If Using... Then...

Windows NT 4.0 Choose Start>Programs>Oracle for Windows 
NT>Oracle Client Configuration Manager.

Windows NT 3.51 Choose the Oracle for Windows NT icon from the 
Program Group, then choose Oracle Client 
Configuration Manager.

Windows 95 Choose Start>Programs>Oracle for Windows 95>Oracle 
Client Configuration Manager.

Windows 3.1 Double-click the icon in the Oracle for Windows 
program group.

Option Description
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4. Select the appropriate product names in the Available Products field. 

5. Click Add or double-click on the product names to place products in the 
Selected Products field in the Software Asset Manager dialog box. 

6. Click OK to assign selected products to configuration. 

Assigning Clients
To assign an OCSM client to a configuration: 

1. Ensure that the client user first registers the client with the OCSM host machine. 

2. Start the Oracle Client Configuration Manager: 

The Oracle Client Configuration Manager dialog box appears.

3. Enter the configuration name or select it from the Configuration pull-down 
menu. 

4. Choose Client Assignments from the View pull-down menu. 

5. Select the clients by clicking the client names in the All Clients field. All Clients 
is a list of all registered clients to the host. 

6. Click Add to place clients in the Selected Clients field. 

7. Click OK to assign selected clients to the configuration. 

If Using... Then...

Windows NT 4.0 Choose Start>Programs>Oracle for Windows 
NT>Oracle Client Configuration Manager.

Windows NT 3.51 Choose the Oracle for Windows NT icon from the 
Program Group, then choose Oracle Client 
Configuration Manager.

Windows 95 Choose Start>Programs>Oracle for Windows 95>Oracle 
Client Configuration Manager.

Windows 3.1 Double-click the icon in the Oracle for Windows 
program group.
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Defining Installation Options
To define installation options for a configuration:

1.  Start the Oracle Client Configuration Manager: 

2. Enter the configuration name or select it from the Configuration pull-down 
menu. 

3. Choose Install Options from the View pull-down menu. 

4. In the Client Installation Options window, select Force Executable Location to 
define how software is installed on clients. 

5. To allow client users to define how products are installed, do not select “Force 
Executable Location”. 

6. If you selected Force Executable Location, you must define how software is 
installed on client machines by selecting one of the following: 

■ Run from OCSM Host 

■ Download EXE/DLL to Client Machine 

■ Install Completely on Client Machine 

7. Select Force Client Installation to force the installation of products on client 
machines. 

8. Click OK to assign the installation options to the configuration. 

If Using... Then...

Windows NT 4.0 Choose Start>Programs>Oracle for Windows 
NT>Oracle Client Configuration Manager.

Windows NT 3.51 Choose the Oracle for Windows NT icon from the 
Program Group, then choose Oracle Client 
Configuration Manager.

Windows 95 Choose Start>Programs>Oracle for Windows 95>Oracle 
Client Configuration Manager.

Windows 3.1 Double-click the icon in the Oracle for Windows 
program group.
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Defining Conflict Resolution Installation Options
To define conflict resolution installation options:

1. Start the Oracle Client Configuration Manager:  

2. Select any configuration in the Configuration pull-down menu. 

3. Choose Install Options from the View pull-down menu. 

4. Define the conflict resolution options per host home exactly as you define 
regular installation options in the Conflict Resolution window. 

The options override other conflict resolution options that are set for all 
configured clients on that home. 

5. Click OK to save your conflict resolution settings. 

Using Oracle Client Software Agent
Use the OCSA to bring the OCSM client machines up to date with respect to the 
OCSM host machine. The client is updated when the client user double-clicks the 
OCSA icon or when Windows is started.

To determine whether the OCSM client environment needs to be updated with 
respect to the OCSM host machine’s environment, the OCSA compares the client 
timestamp in the local ORACLE portion of the registry to the client timestamp in 
the CLIENTS.INI file in the OCSM host machine’s Oracle home. When the local 
timestamp is earlier than the CLIENTS.INI timestamp, the client is out of date, and 
the OCSA invokes Oracle Installer in configuration mode. Otherwise, the local 
OCSM client environment is up to date and the OCSA exits after an appropriate 
message. 

If Using... Then...

Windows NT 4.0 Choose Start>Programs>Oracle for Windows 
NT>Oracle Client Configuration Manager.

Windows NT 3.51 Choose the Oracle for Windows NT icon from the 
Program Group, then choose Oracle Client 
Configuration Manager.

Windows 95 Choose Start>Programs>Oracle for Windows 95>Oracle 
Client Configuration Manager.

Windows 3.1 Double-click the icon in the Oracle for Windows 
program group.
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Understanding OCSM Files
The following files in the ORACLE_HOME\ORAINST directory are used by OCSM:

■ GROUPS.INI 

■ CLIENTS.INI 

■ Registration Files 

GROUPS.INI 
OCSM maintains GROUPS.INI in the OCSM host machine’s Oracle home directory. 
Each section in GROUPS.INI describes an OCSM client configuration. There is also 
an extra section for resolving parameter conflicts when an OCSM client is a 
member of more than one configuration. Each OCSM client configuration section is 
headed by its name and keeps track of the following information: 

Note: When Oracle Installer runs for the OCSM client, it does not 
use the product installation scripts to configure the OCSM client. It 
merely copies the files from the OCSM host machine’s Oracle 
home according to how the configuration was defined on the host.

Client Configuration Field Description

ROLE When the administrator forces the location of 
executables, the ROLE is Administrator. Otherwise, 
the ROLE is User.

EXE.HOME The type of install option, either 

■ SHARED (Run from OCSM Host) 

■ LOCAL (Download EXE/DLL to Client 
Machine)

■ DOWNLOAD (Install Completely on Client 
Machine)

SELECTION When the administrator assigns products to the 
clients in a configuration, SELECTION is 
Mandatory. Otherwise, SELECTION is Optional.

PRODUCTS List of products belonging to this configuration. 
These names have the same form as the Product 
field in the .PRD file. For example: WINBOOK20, 
WINRSF71, etc.
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The Conflict Resolution section in GROUPS.INI tracks the following fields, which 
have the same meaning as above, but are used to resolve conflicts:

■ ROLE 

■ EXE_HOME 

■ SELECTION 

CLIENTS.INI 
The CLIENTS.INI file is maintained in the OCSM host machine’s Oracle home 
directory. This file contains a section for each client known to the OCSM host. For 
each client, the CLIENTS.INI file keeps track of the following information: 

Client Field Description

Configurations List of configurations of which the client is a 
member.

OS Operating system of the client.

OSVER Operating system version of the client.

ROLE Client role specifying who selects the various 
options. Possible values are ADMINISTRATOR or 
USER.

EXE_HOME Type of install option: 

■ LOCAL (Run from OCSM Host)

■ SHARED (Download EXE/DLL)

■ DOWNLOAD (Install Completely on Client 
Machine)

TIME_STAMP The timestamp of the last time the OCSM changed 
the properties of any configuration to which the 
client belongs.
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Registration Files
OCSM uses the following registration file:  

Oracle Software Manager
Oracle Software Manager (OSM) is a software distribution and management tool 
packaged with the Oracle Enterprise Manager. OSM automates many of the 
administrative tasks related to installing and upgrading software throughout a 
distributed database environment. OSM provides client and server software 
management from the Oracle Enterprise Manager console. From the console, OSM 
enables you to inspect and determine where various software resides in your 
distributed database network. The centralized console enables system 
administrators to easily run software configuration jobs and track assets across the 
entire network. 

Overview of Process
The Oracle Enterprise Manager/OSM network is comprised of one or more Oracle 
Enterprise Manager/OSM installations, each administering host servers that 
contain Oracle Intelligent Agents. The Oracle Intelligent Agent can have clients that 
are administered as part of the network. The responsibilities of the systems 
administrator are:

■ Identify some servers as distribution hosts 

■ Copy Oracle software to the local drive of the distribution hosts either from CD-
ROM disc or from across the network 

■ Create releases of Oracle products on these hosts 

■ Select appropriate products from these releases and place them into packages 
for distribution 

■ Distribute these packages to other servers and clients across your network

Registration File Description

Client Each client has a registration file maintained in the 
OCSM host machine’s ORACLE_HOME\CLIENTS 
directory. This file lists the shared products already 
configured in the client's local environment.

The client registration file is named after the client. 
For example, if a client is named ALPHA, its 
registration file is ALPHA.RGS.
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Distributing Oracle Software with OSM
See the Oracle Enterprise Manager Administrator’s Guide for instructions on 
distributing Oracle software with OSM. The table below lists the Oracle products 
that can be installed and maintained through OSM:

Systems Management Server
Microsoft Systems Management Server (SMS) manages networked PCs running the 
Windows group of operating systems. Specifically, SMS provides:

■ PC hardware and software inventory 

■ Software distribution

■ PC troubleshooting 

SMS is a component of Microsoft Backoffice, and is sometimes used in companies 
running their businesses on Windows NT.

Oracle7 Server SMS Support 
Oracle products for Windows 95 and Windows NT support remote installation and 
software inventory and auditing capabilities through SMS release 1.2. SMS 
integration with Windows 3.1 and Windows for Workgroups is not currently 
supported. Oracle Corporation provides customizable package definition files 
(.PDFs) that SMS administrators can use to distribute and maintain Oracle products 

1 Automatically installs the Oracle Trace Collection Services, Oracle TCP/IP 
Protocol Adapter, Oracle Named Pipes Protocol Adapter, and Oracle SPX 
Protocol Adapter (if those networking protocols are detected on your 
network). Additional OCSM-compliant Oracle Protocol Adapters, such as 
the Oracle DECnet Protocol Adapter (not available on Windows NT 4.0) 
and Oracle LU6.2 Protocol Adapter, must be selectively installed through 
the Custom Installation option.

For Windows NT/Windows 95 For Windows 3.1

All Required Support Files None

SQL*Plus

SQL*Net Client1

SQL*Net Server1
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in a Windows NT and Windows 95 network. These packages contain the same 
products as the corresponding packages in a traditional installation.

Distributing Oracle Software with SMS
To distribute Oracle software with SMS: 

1. Open the Packages window from the SMS Administrator’s console. 

2. Select New from the File menu.

3. Select Import in the dialog box that appears in order to specify the .PDF 
package that describes the Oracle software package to SMS.

4. Navigate to the SMS directory at the root of the Oracle7 Server for Windows 
NT CD-ROM disc.

5. Select the appropriate PDF package:

Attention: SMS .PDF files are not the same as Adobe Acrobat 
.PDF files. Adobe Acrobat .PDF files contain only documentation, 
do not contain products, and cannot be used to distributed and 
maintain Oracle products.

Note: You must be an SMS administrator to perform these 
procedures.

Package Enables You to...

ServerNT.PDF Install and de-install Oracle7 Server software. This package 
includes Oracle7 Enterprise Backup Utility, which requires Legato 
Storage Manager (LSM) for Oracle to be installed. LSM is not 
automatically installed by SMS. You must manually install LSM 
by executing SETUP.EXE from the Legato directory at the root of 
the Oracle7 Server for Windows NT CD-ROM disc.

Client32.PDF Install and de-install Oracle7 Client software.

Deinstal.PDF De-install any Oracle7 software package. You can use this option 
if you have the software installed but have not already created an 
install/de-install package with SMS, or if you have deleted the 
install/de-install package. Job sending time is greatly reduced.
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6. Select Workstations to see more properties of the package.

7. Select the source directory for the package as follows: 

One or more command line options listed for the package appear. They are 
defined in the .PDF file and must be left alone.

8. Click Close to exit the window. 

9. Click OK to exit the Package Properties window. 

SMS creates the package for you at this time.

10. Create a Run Command on Workstation job to distribute the new Oracle7 
Server product package. You can choose the appropriate command line option 
for the package during job creation (for example, Oracle7 Client/DBA for 
Win95 or Oracle7 Client/AppUser for Win95). Consult your SMS 
documentation for more information about creating jobs.

11. Reboot all client and server machines after installing Oracle software with SMS.

For... Set the Source Directory...

ServerNT.PDF or Client32.PDF (the 
two install/de-install packages)

To the root directory of the Oracle7 Server 
for Windows NT CD-ROM disc

Deinstal.PDF (the de-install only 
package)

To the SMS directory located at the root of 
the Oracle7 Server for Windows NT CD-
ROM disc

Attention: This is important, as installation command lines 
specified in the .PDF file are interpreted relative to the source 
directory.

Note: When you schedule an SMS job to distribute software, the 
source directory that was specified during package creation must 
be accessible to SMS. If you specified the Oracle7 Server for 
Windows NT CD-ROM disc as the source, be sure the CD-ROM 
disc is loaded into your CD-ROM drive during job creation.
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De-installation Issue 
Before executing an Oracle de-installation job on an SMS client machine, be sure 
that all Oracle applications and services are stopped. De-installation will fail if 
services are running.

Note: Oracle documentation as distributed in an SMS package 
refers to the initial installation location in order to save client disk 
space. This location is the SMS_PKGD directory of the SMS 
distribution server. As a result, the client machine requires a drive 
mapping to the initial installation location for access to 
documentation files. On Windows 95 and Windows NT 4.0, this 
drive mapping occurs automatically when the documentation icon 
is selected. On Windows NT 3.51, this mapping must be performed 
manually.
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14
Developing Applications

This chapter describes Windows NT-specific issues for applications developers. 

Specific topics discussed are:

■ Compiling and Linking Oracle XA Library

■ Accessing Web Data with Intercartridge Exchange
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Compiling and Linking Oracle XA Library
The Oracle XA Library is automatically installed as part of the Oracle7 Server 
installation option. The following components are created in your Oracle home 
directory:  

The XA Application Program Interface (API) is typically used to enable an Oracle 
Relational Database Management System (RDBMS) to interact with a transaction 
processing monitor (TP monitor), such as BEA Tuxedo, IBM Transarc Encina, or 
IBM CICS. You can also use TP monitor statements in your client programs. The 
use of the XA API is also supported both from Pro*C and from Oracle Call Interface 
(OCI). In either case, the XA73.DLL must be contained in the execution path of the 
caller.

Compiling and Linking a Pro*C program
1. Precompile PROGRAM.PC using Oracle Pro*C/C++ to generate PROGRAM.C.

2. Compile PROGRAM.C, making sure to include ORACLE_HOME\XA73 in 
your INCLUDE path.

3. Link PROGRAM.OBJ with the following libraries:   

■ XA73.LIB

■ ORA73.LIB

■ SQLLIB18.LIB    

4. Run PROGRAM.EXE. (XA73.DLL must be in the execution path.) 

Component Location

XA73.DLL ORACLE_HOME\BIN

XA73.LIB ORACLE_HOME\RDBMS73\XA

XA.H ORACLE_HOME\RDBMS73\XA
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Compiling and Linking an OCI program
1. Compile PROGRAM.C by using MS VC++, making sure to include 

ORACLE_HOME\XA73 in your INCLUDE path.

2. Link PROGRAM.OBJ with the following libraries:

■ XA73.LIB

■ ORA73.LIB 

3. Run PROGRAM.EXE. (XA73.DLL must be in the execution path.)  

Additional Information: For general information about XA and 
TP monitors, please see: 

• Distributed Transaction Processing: The XA Specification 
published by X/Open (now part of OpenGroup). Visit: http://
www.rdg.opengroup.org/public/pubs/catalog/full_lst.htm 

• Transaction Processing XPG4 X/Open CAE Specification XO/CAE/
91/300 or C193 2/92.

• Your specific TP monitor documentation.

Additional Information: For more information about the Oracle 
XA Library, see the appendix “Operating System Dependencies” of 
Oracle7 Server Distributed Systems, Volume I: Distributed Systems.
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Accessing Web Data with Intercartridge Exchange

Configuring Intercartridge Exchange
You must add a parameter to the registry before using Intercartridge Exchange 
(ICX).

To configure ICX:

1. Start the registry from the MS-DOS command prompt by entering:

C:\> REGEDT32

2. Go to HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE.

3. Choose Edit>Add Value.

The Add Value dialog box appears.

4. Enter HTTP_PROXY in the Value Name field and REG_SZ in the Data Type 
field:

5. Click OK when done.

6. Enter www-proxy.your-site in the String field:

where your-site is the name of your web site.
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Using Intercartridge Exchange
Intercartridge Exchange (ICX) enables you to use a stored package called 
UTL_HTTP to make hypertext transfer protocol (HTTP) calls from PL/SQL, SQL, 
and Server Manager (SVRMGR23) statements. UTL_HTTP can:

■ access data on the internet 

■ call Oracle Web Application Server Cartridges

UTL_HTTP contains two similar entry points, known as packaged functions, that 
make HTTP callouts from PL/SQL and SQL statements:

■ UTL_HTTP.REQUEST

■ UTL_HTTP.REQUEST_PIECES

 Both packaged functions:

■ take a string universal resource locator (URL) of a site

■ contact that site

■ return the data (typically HTML) obtained from that site

The specifications to use with both packaged functions are described below:

Packaged Function UTL_HTTP.REQUEST

Description
UTL_HTTP.REQUEST takes a URL as its argument and returns up to the first 2000 
bytes of data retrieved from the given URL. 

Declaration
UTL_HTTP.REQUEST is specified as:

FUNCTION REQUEST (URL IN VARCHAR2) RETURN VARCHAR2;

To use UTL_HTTP.REQUEST from Server Manager, enter:

SVRMGR> SELECT UTL_HTTP.REQUEST(’HTTP://WWW.ORACLE.COM/’) FROM DUAL;

which outputs:

UTL_HTTP.REQUEST(’HTTP://WWW.ORACLE.COM/’)                         

------------------------------------------------------

<html>
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<head><title>Oracle Corporation Home Page</title>

<!--changed Jan. 16, 19

1 row selected.

Packaged Function UTL_HTTP.REQUEST_PIECES

Description
UTL_HTTP.REQUEST_PIECES takes a URL as its argument and returns a PL/SQL 
table of 2000 bytes of data retrieved from the given URL. The final element may be 
shorter than 2000 characters. The UTL_HTTP.REQUEST_PIECES return type is a 
PL/SQL table of type UTL_HTTP.HTML_PIECES. 

Declaration
UTL_HTTP.REQUEST_PIECES, which uses type UTL_HTTP.HTML_PIECES, is 
specified as:

type html_pieces is table of varchar2(2000) index by binary_integer;

function request_pieces (url in varchar2, 

   max_pieces natural default 32767)

return html_pieces;

A call to REQUEST_PIECES can look like the example below. Note the use of the 
PL/SQL table method COUNT to discover the number of pieces returned, which 
may be zero or more:

declare pieces utl_http.html_pieces;

begin 

  pieces := utl_http.request_pieces(’http://www.oracle.com/’); 

   for i in 1 .. pieces.count loop

     .... -- process each piece

   end loop;

end;

The second argument to UTL_HTTP.REQUEST_PIECES, (MAX_PIECES) is 
optional. MAX_PIECES is the maximum number of pieces (each 2000 characters in 
length, except for the last, which may be shorter) that 
UTL_HTTP.REQUEST_PIECES returns. If provided, that argument is likely a 
positive integer. 
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For example, the following block retrieves up to 100 pieces of data (each 2000 bytes, 
except perhaps the last) from the URL. The block prints the number of pieces 
retrieved and the total length, in bytes, of the data retrieved. 

set serveroutput on

/

declare 

  x utl_http.html_pieces;

begin

  x := utl_http.request_pieces(’http://www.oracle.com/’, 100);

  dbms_output.put_line(x.count || ’ pieces were retrieved.’);

  dbms_output.put_line(’with total length ’);

  if x.count < 1 

  then dbms_output.put_line(’0’);

  else dbms_output.put_line

((2000 * (x.count - 1)) + length(x(x.count)));

  end if;

end;

/

which outputs:

Statement processed.

4 pieces were retrieved.

with total length 

7687

The elements of the PL/SQL table returned by UTL_HTTP.REQUEST_PIECES are 
successive pieces of data obtained from the HTTP request to that URL. 
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UTL_HTTP Exception Conditions
This section describes the exceptions that can be raised by packaged functions 
UTL_HTTP.REQUEST and UTL_HTTP.REQUEST_PIECES:

UTL_HTTP.REQUEST
The PRAGMA RESTRICT_REFERENCES enables exceptions (errors) to be 
displayed:

create or replace package utl_http is

function request (url in varchar2) return varchar2;

pragma restrict_references (request, wnds, rnds, wnps, rnps);

UTL_HTTP.REQUEST_PIECES
The PRAGMA RESTRICT_REFERENCES enables exceptions (errors) to be 
displayed:

create or replace package utl_http is

type html_pieces is table of varchar2(2000) index by binary_integer;

function request_pieces (url in varchar2, 

       max_pieces natural default 32767)

return html_pieces;

pragma restrict_references (request_pieces, wnds, rnds, wnps, rnps);

Exceptional Conditions and Error Messages
 

If... Then...

Initialization of the HTTP callout subsystem 
fails for environmental reasons such as lack of 
available memory 

Exception UTL_HTTP.INIT_FAILED is raised:

init_failed exception;

The HTTP call fails because of failure of the 
HTTP daemon or because the argument to 
REQUEST or REQUEST_PIECES cannot be 
interpreted as a URL because it is NULL or has 
non-HTTP syntax

Exception UTL_HTTP.REQUEST_FAILED is raised:

request_failed exception;
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No response is received from a request to the 
given URL because no site corresponding to 
that URL was contacted

A formatted HTML error message may be returned:

<HTML>

<HEAD>

<TITLE>Error Message</TITLE>

</HEAD>

<BODY>

<H1>Fatal Error 500</H1>

Can’t Access Document: http://home.nothing.comm.

<P>

<B>Reason:</B> Can’t locate remote host: 
home.nothing.comm.

<P>

<P><HR>

<ADDRESS><A HREF="http://www.w3.org">

CERN-HTTPD3.0A</A></ADDRESS>

</BODY>

</HTML>

Note: The first two exceptions in the table above, unless explicitly 
caught by an exception handler, are reported by this generic 
message:

ORA-06510: PL/SQL: unhandled user-defined exception

that shows them as "user-defined" exceptions, although they are 
defined in this system package.

If any other exception is raised during the processing of the HTTP 
request (for example, an out-of-memory error), then function 
UTL_HTTP.REQUEST or UTL_HTTP.REQUEST_PIECES reraises 
that exception.

If... Then...
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Troubleshooting
Do not expect UTL_HTTP.REQUEST or UTL_HTTP.REQUEST_PIECES to succeed 
in contacting a URL unless you can contact that URL by using a browser on the 
same machine (and with the same privileges, environment variables, etc.). If 
UTL_HTTP.REQUEST or UTL_HTTP.REQUEST_PIECES fails (that is, if it raises an 
exception or returns an HTML-formatted error message, yet you believe that the 
URL argument is correct), try contacting that same URL with a browser to verify 
network availability from your machine.



                                                            Using Oracle ConText Option 15-1

15
Using Oracle ConText Option

This chapter describes how to use Oracle ConText Option External Filters and 
Oracle ConText Option Demos that are provided as an addition to Oracle ConText 
Option. It describes how to set up and use the components of Oracle ConText 
Option Workbench.

Specific topics discussed are:

■ Using Oracle Option ConText External Filters

■ Using Oracle ConText Option Workbench

■ The Oracle ConText Option I/O Utility is stand-alone executable that can be 
used to load text to a database column, load text from a column into a file, 
execute SQL and PL/SQL code, and call other executables from the MS-DOS 
command prompt.
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Using Oracle Option ConText External Filters
Oracle ConText Option External Filters are provided as an addition to Oracle 
ConText Option. These external filters are installed and used on the server. You 
may also define your own external filters (user defined external filters). If so, the 
following list describes information specific to using user defined external filters on 
Windows NT.

1. On UNIX operating systems, Perl scripts and UNIX shell scripts can be 
executed as user defined external filters. On Windows NT, only .EXE, .CMD, 
and .BAT files are executed as user defined external filters.

2. To implement a filter on Windows NT, (for example, to run a Perl script 
FOO.PL), associate files with a .PL extension with PERL.EXE (if you have a Perl 
compiler). When the Oracle ConText Option server process executes your 
FOO.PL user defined filter, it calls CCPERL.EXE FOO.PL input file output file.

Setting Up Oracle ConText Option External Filters
This section provides instructions on setting up Oracle ConText Option External 
Filters. On Windows NT, external filters must be placed in the directory 
ORACLE_HOME\BIN. The following Oracle ConText Option External Filters are 
supplied with Oracle ConText Option for Windows NT.

Format Versions Format ID External Filters

AmiPro for Windows 1.0, 2.0, 
3.0

19 W033B16D.EXE

Lotus Freelance for Windows 2.0 85 W114B16D.EXE

Lotus 123 2,3,4,5 20 W020B16D.EXE

Microsoft Excel 5 21 W021B16D.EXE

7 —

Microsoft PowerPoint for Windows 2,3,4 84 W109B16D.EXE

7.0 — W116B16D.EXE

Microsoft Word for MS-DOS 5.0,5.5 8 W005B16D.EXE

Microsoft Word for Apple Macintosh 3,4,5 28 W054B16D.EXE

Microsoft Word for Windows 2 18 W044B16D.EXE

6 68 W049B16D.EXE

7 —
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The information provided in the column Format ID above is used to create Filter 
preferences for mixed-format columns that require external filters. A format ID is 
not provided for the following formats because Oracle ConText Option does not 
support mixed-format columns for these document formats:

■ Microsoft PowerPoint for Windows, version 7

■ Microsoft Word for Windows, version 7

■ Microsoft Excel for Windows, version 7

■ WordPerfect for Windows, version 7

However, the Oracle ConText Option External Filters for these formats can be used 
for single-format columns that contain any one of these formats.

Portable Document Format (PDF) — 57 ACRONT.EXE

WordPerfect for MS-DOS 5.0,5.1 3 W007B16D.EXE

WordPerfect for Windows 5.x

WordPerfect for MS-DOS 6.0 1 W048B16D.EXE

WordPerfect for Windows 6.x

WordPerfect for Windows 7.0 —

Xerox XIF for UNIX 5,6 43 W103B16D.EXE

Additional Information: See Oracle ConText Option Administrator’s 
Guide for more information about Oracle ConText Option External 
Filters.

Format Versions Format ID External Filters
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Creating Wrappers for Oracle ConText Option External Filters
A wrapper must be created for each of the Oracle ConText Option External Filters 
to be used to filter text stored in a column. The wrapper can be any type of 
executable, such as a UNIX shell script or Windows NT batch file, that calls the 
filter executable and provides two system-supplied variables as arguments. Once 
the required wrappers have been created, the external filters can be specified as the 
filters for the text column.

The following example illustrates a simple Windows NT batch file that can be used 
as the wrapper for calling the AmiPro filter executable W033B16D.EXE for 
Windows NT. Note that the .EXE extension for the filter executable file is not 
specified because Windows NT does not require it.

REM AMIPRO FILTER
ORACLE_HOME\BIN\W033B16D %1 /N /T=%2

The batch file can be named anything, for example, AMIPRO.BAT, but the file must 
be located in the ORACLE_HOME\BIN directory and the file extension must be 
.BAT or .CMD. The batch files for all other required external filters for Windows 
NT are identical to this example, except for the name of the filter executable 
supplied in each batch file.

The instructions for creating a wrapper for ACRONT.EXE are different than the 
instructions for creating wrappers for the rest of the executables. 

For ACRONT.EXE, the wrapper text must be as follows:

REM PDF FILTER 
ORACLE_HOME\BIN\ACRONT %1 %2

Using Oracle ConText Option External Filters
This section provides instructions for using the Oracle ConText Option External 
Filters. The following topics are covered in this section: 

■ filtpref—Specifying Oracle ConText Option External Filters  

■ filtman—Using Oracle ConText Option External Filters for Manual Filtering  

filtpref— Specifying Oracle ConText Option External Filters
To specify one or more of the supplied external filters for a column, you first create 
a Filter preference in which you specify the wrapper (file name) for each of the 
filters to be used, then create a policy that calls the Filter preference. 
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You can create Filter preferences for:

■ singleformat—Single Format Columns

■ multiformat—Mixed Format Columns

singleformat— Single Format Columns  For single format columns, create a Filter 
preference that uses the COMMAND attribute (USER FILTER Tile) to specify the 
wrapper that invokes the filter executable for the format used in your column. The 
following PL/SQL example illustrates creating a Filter preference for a column that 
contains documents only in AmiPro format: 

BEGIN
CTX_DDL.SET_ATTRIBUTE(’COMMAND’,’AMIPRO.BAT’); 
CTX_DDL.CREATE_PREFERENCE(’AMIPRO_FILT’, 
                             ’AMIPRO FILTER’, 
                             ’USER FILTER’); 
END;  

multiformat —Mixed Format Columns   For mixed-format columns, create a Filter 
preference that sets the EXECUTABLE attribute (BLASTER Tile) once for each of 
the wrappers that invoke the formats you want to use in your column. The 
following PL/SQL example illustrates creating a Filter preference for a column that 
contains documents in AmiPro, Adobe Acrobat, and WordPerfect 6.0 formats: 

BEGIN 
CTX_DDL.SET_ATTRIBUTE(’EXECUTABLE’,19,’AMIPRO.BAT’, 1); 
CTX_DDL.SET_ATTRIBUTE(’EXECUTABLE’,57,’ACROBAT.BAT’, 2); 
CTX_DDL.CREATE_PREFERENCE(’MULT_FILT’, 
                            ’MULTIPLE FILTERS’, 
                            ’BLASTER’); 
END; 

In this example, it is not necessary to specify the filter executable for WordPerfect 
6.0, because Oracle ConText Option provides an internal filter for WordPerfect 6.0. 
By default, when the Filter preference for a column uses the EXECUTABLE 
attribute (BLASTER Tile), Oracle ConText Option uses internal filters for all 
supported formats for which an external filter is not explicitly specified. 

Additional Information: See Oracle ConText Option Administrator’s 
Guide for more information about creating preferences and policies.
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filtman—Using Oracle ConText Option External Filters for Manual Filtering 
The external filters can also be used to manually filter your documents (files) prior 
to storing them in the database. To use this filtering method, call the appropriate 
external filter executable from the MS-DOS command prompt for each document to 
be filtered and specify two arguments: 

■ the name of the document to be filtered 

■ the name of the output file used to store the filtered text 

Then, you can load the filtered, plain (ASCII) text from the output file into a 
database column, create a policy for the column, and index the column. 

The following example illustrates the command line syntax for using the filter 
executables to perform manual filtering on Windows NT: 

ORACLE_HOME\BIN\W049B16D TEST.DOC /N /T=OUTPUT.TXT 

In this example, a Microsoft Word 6 (or 7) document named TEST.DOC is filtered 
using the W049B16D.EXE filter executable and the filtered output is stored in 
OUTPUT.TXT. 

Note: If you manually filter your documents before loading them 
into a column, when creating the policy for the column, specify a 
Filter preference that uses either the ASCII internal filter or no 
filter. 
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Using Oracle ConText Option Workbench
Oracle ConText Option Workbench can be installed on both server and client and 
consists of the following components:

■ Oracle ConText Option Demos

■ Oracle ConText Option System Administration

■ Oracle ConText Option Viewer

■ Oracle ConText Option Viewer Cartridge

■ Oracle ConText Option Configuration Manager

■ TextServer3 Migration Tool

■ Oracle ConText Option I/O Utility

Oracle ConText Option Demos
The following Oracle ConText Option Demos are installed and used on the server:   

Product Demo Is Installed Under...

SQL*Plus %CTX73%\DEMO\CTXPLUS

Linguistics %CTX73%\DEMO\CTXLING

Additional Information: See the Oracle ConText Option Application 
Developer’s Guide for further information on setting up and 
executing the demo applications.

Note: The Oracle ConText Option Web Sample Application is not 
provided on Windows NT.
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Oracle ConText Option System Administration
The Oracle ConText Option System Administration tool is a GUI application that 
can be used to perform system and text administration tasks. Before you can 
connect to the database using the Oracle ConText Option System Administration 
tool, an entry for the database must be added to the TNSNAMES.ORA file. In 
addition, the CTXSYS user may have to connect once to each database. If this is 
required for a particular database, the Oracle ConText Option System 
Administration tool notifies you when you attempt to connect to the database.

Oracle ConText Option Viewer
The Oracle ConText Option Viewer is supplied as a custom control (OCX), which 
can be embedded in any application developed in an environment, such as Visual 
Basic, and Visual C++.    

Oracle ConText Option Viewer Cartridge
The Oracle ConText Option Viewer Cartridge is a Java web server cartridge that 
packages data for viewing using the web browser plugin, and provides generic 
facilities for downloading large data types from the database to a Web browser. 

Oracle ConText Option Configuration Manager
See Chapter 2, “Introducing Oracle7 Server” for a description of this product.

TextServer3 Migration Tool
See Chapter 2, “Introducing Oracle7 Server” for a description of this product.

Note: CTXSYS needs to connect only once per database. Once 
CTXSYS connects to a database, the database is enabled thereafter 
for all users. See the online help with the Oracle ConText Option 
System Administration tool for details on connecting to the 
database.

Additional Information: See the online help for instructions for 
using the viewer.
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Oracle ConText Option I/O Utility
The Oracle ConText Option I/O Utility is stand-alone executable that can be used 
to load text to a database column, load text from a column into a file, execute SQL 
and PL/SQL code, and call other executables from the MS-DOS command prompt.

Additional Information: See Oracle ConText Option Application 
Developer’s Guide for instructions for using the I/O utility.
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A
Directory Structures

This appendix describes the default directory structures created when Oracle7 
Server is installed on a Windows NT Server and client machines.

Specific topics discussed are:

■ Windows NT Directory Structure

■ Windows 95 and Windows 3.1 Directory Structures
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Windows NT Directory Structure
The Oracle Installer places all Oracle products for Windows NT into subdirectories 
of the ORANT directory. The actual directory names vary according to the different 
products you install.

The subdirectories of ORANT contain the contents listed below. For Oracle7 Server, 
all .DLL and .EXE files and configuration variables have their version numbers 
appended. This convention allows you to maintain multiple releases of these items 
for backward compatibility. For example, the Instance Manager executable for 
version 7.3 is ORADIM73.EXE.

Directory Name Contains...

\A2OWIZ15 Oracle Migration Wizard for Microsoft Access 
Wizard files.

\AGENTBIN Oracle Intelligent Agent files.

\BIN Executable, DLL, icon, and library files, such as 
the Oracle7 Server, Server Manager, SQL*Net, and 
Oracle7 Utilities.

\CTX73 Oracle ConText Option files. 

\CTXW Oracle ConText Option Workbench executable 
files.

\DATABASE Oracle7 Server starter database, password, and 
initialization files. \DATABASE also contains the 
following subdirectory:

\ARCHIVE Archive files.

\DBS Oracle Toolkit II message files and other utility 
files.

\MD73 Oracle Spatial Data Option files.

\MSHELP Microsoft Word help files.

\NETWORK SQL*Net for Windows NT directory. See Oracle 
Network Products Getting Started Release 2.3.4 for 
Windows Platforms for additional information on 
the \NETWORK directory and its contents.

\NETWORK also contains the following 
subdirectories:
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\ADMIN Configuration files used by SQL*Net version 2.3.4 
for Windows NT.

\AGENT Oracle Enterprise Manager intelligent agent files.

\CFG Configuration files placed here by default.

\DEMO Demo files.

\ERROR Error files placed here by default.

\INCLUDE TNS API file.

\LIB TNS API library file.

\LOG Log files placed here by default.

\MESG Error files placed here by default.

\NAMES Oracle Names files.

\TRACE Trace files placed here by default.

\NLSRTL32 NLS message files.

\DATA Loadable NLS files.

\OCI73 Oracle Call Interface (OCI) files. \OCI73 contains 
the following subdirectories:

\INCLUDE Header files.

\LIB Borland and Microsoft Visual C++ files.

\SAMPLES Sample files.

\ODBC Oracle7 ODBC files.

\CPP Subdirectories for precompilation and compilation 
files.

\EXCEL Excel sample files.

\VP Visual Basic files.

\OPS Oracle Parallel Server Option files.

\ORAINST Files used by Oracle Installer.

\NLB Required for \NLSRTL32 to work. Without \NLB, 
Oracle Installer cannot run in multiple languages.

\OTRACE73 Oracle Trace files.

Directory Name Contains...
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\ADMIN Oracle Trace administration files.

\INCLUDE Oracle Trace Header files.

\LIB Oracle Trace Library files.

\PLSQL23 Message files, SQL scripts, and demonstration 
files for PL/SQL.

\PLUS33 SQL*Plus files.

\PRO18 Pro*C/C++ files.

\RDBMS73 Oracle7 Server message, resource, and README 
files. \RDBMS73 also contains the following 
subdirectories:

\ADMIN Oracle7 Server SQL scripts. Use SQL scripts to 
create data dictionary tables or views, and other 
views used by Oracle software.

\LOADER Sample files for SQL*Loader.

\TRACE Informational trace and alert files generated by the 
Oracle7 Server database.

\XA Oracle XA Library files.

\SYSMAN Oracle Enterprise Manager files.

\VS10 NT Backup Manager and NT Recovery Manager 
files.

Directory Name Contains...
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Windows 95 and Windows 3.1 Directory Structures
Oracle Installer places all Oracle for Windows 95 products into subdirectories of 
ORAWIN95 (and into subdirectories of ORAWIN for Windows 3.1.) 

Directory Name Contains...

\BIN Executable, DLL, and batch files and the SQL*Net 
version 2.3.4 networking software.

\DBS Oracle Toolkit II message files and other utility 
files.

\NETWORK SQL*Net version 2.3.4 directory. See Oracle 
Network Products Getting Started Release 2.3.4 for 
Windows Platforms for additional information on 
the \NETWORK directory and its subdirectories. 
\NETWORK also contains the following 
subdirectories. 

\ADMIN Configuration files used by SQL*Net version 2.3.4 
for Windows NT.

\AGENT Oracle Enterprise Manager intelligent agent files.

\CFG Configuration files placed here by default.

\DEMO Demo files.

\ERROR Error files placed here by default.

\INCLUDE TNS API file.

\LIB TNS API library file.

\LOG Log files placed here by default.

\MESG Error files placed here by default.

\NAMES Oracle Names files.

\TRACE Trace files placed here by default.

\NLSRTL32 Loadable NLS files.

\ORAINST Files used by Oracle Installer.

\PLUS33 SQL*Plus files.

\PRO18 Pro*C/C++ files.

\RDBMS73 Oracle7 Server message, resource, and README 
files.
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B
Initialization Parameter Files

Oracle7 Server uses initialization parameters to enable various features of the 
database every time an instance is started.

Specific topics discussed are:

■ What Is an Initialization Parameter File?

■ Initialization Parameters
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What Is an Initialization Parameter File?
An initialization parameter file is an ASCII text file containing a list of parameters. 
Every database instance has a corresponding initialization parameter file and 
ORACLE_SID registry parameter that points to the system identifier (SID) for the 
instance.

The initialization parameter file name take the form INITSID.ORA, where SID is 
the name of the database instance. For example, the initialization parameter file for 
the starter database is named INITORCL.ORA, because the initial database SID is 
ORCL.

A single instance might also have several initialization parameter files, each having 
some differences to affect system performance.   

By changing the parameter values in an initialization file, you can specify, for 
example:

■ the amount of memory the database uses

■ whether to archive filled online redo logs

■ which control files currently exist for the database

Location 
The computer on which the database instance is started must have access to the 
appropriate initialization parameter file. By default, Oracle7 Server uses the 
initialization parameter file located in ORACLE_HOME\DATABASE, unless you 
specify a different initialization file with the PFILE option at database startup. 

Editing
To customize Oracle7 database functions, you may need to edit the initialization 
parameter file. Use any ASCII text editor to modify the file.

Additional Information: See Oracle7 Server Reference for a 
complete list and descriptions of all initialization parameters.
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Sample File
The initialization parameter file INITORCL.ORA used by the starter database that 
you can install with Oracle7 Server is located in ORACLE_HOME\DATABASE. 
You can use this file as a model for creating a new Oracle7 database initialization 
parameter file.

The annotated, sample initialization parameter file contains alternative values for 
the initialization parameters. These values and the annotations are preceded by 
comment signs (#), which prevent them from being processed. To activate a 
particular parameter, remove the preceding # sign. When you no longer want to 
use a particular parameter, edit the initialization parameter file to add a comment 
sign.

For example, several initialization parameters are specified with three different 
values to create small, medium, or large System Global Areas (SGAs), respectively. 
The parameter that creates a small SGA is active in the following example:

  db_block_buffers = 200 # SMALL 
# db_block_buffers = 550 # MEDIUM 
# db_block_buffers = 3200 # LARGE 

To create a medium-sized SGA, comment out the small parameter definition and 
activate the medium parameter definition. Edit the initialization parameter file as 
follows:

# db_block_buffers = 200 # SMALL 
  db_block_buffers = 550 # MEDIUM 
# db_block_buffers = 3200 # LARGE 
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Initialization Parameters
Oracle7 Server Reference includes descriptions of all initialization parameters and 
instructions for setting and displaying their values. The following table describes 
initialization parameters and default values for Oracle7 Server. 

Initialization Parameter Name Default Value Range of Values

AUDIT_TRAIL TRUE NONE (FALSE), 
DB (TRUE), OS

BACKGROUND_DUMP_ DEST %RDBMSnn%\TRACE\ Any valid directory 

COMPATIBLE 7.3.0.0.0 Default release to 
current release

COMMIT_POINT_ STRENGTH 1 0 - 255 

CONTROL_FILES %ORACLE_HOME%\DATABASE\ 
CTL1%ORACLE_SID%.ORA

Any valid path and file 
name 

DB_BLOCK_BUFFERS 200 200 to 3200

DB_BLOCK_SIZE 2048 512 - 16384

DB_FILES 20 0 - 1022

DB_FILE_MULTIBLOCK_ READ_ COUNT1 8 1 - 312 

DB_FILE_SIMULTANEOUS_ WRITES 4 1 - 24 

DB_NAME ORACLE Any valid database 
name limited to a 
maximum of eight 
characters.

DISTRIBUTED_TRANSACTIONS 25 * TRANSACTIONS 0 - TRANSACTIONS 

DML_LOCKS 4 * transactions 20 to unlimited

LOG_ARCHIVE_BUFFER_ SIZE 127 1 - 127 

LOG_ARCHIVE_BUFFERS 4 1 - 8

LOG_ARCHIVE_DEST %RDBMSnn%\ Any valid directory

LOG_ARCHIVE_FORMAT ARC%S.%T A valid file name format 

LOG_ARCHIVE_START None TRUE or FALSE

LOG_CHECKPOINT_ INTERVAL 8000 2 - Unlimited 

LOG_FILES 255 2 - 255 

LOG_SMALL_ENTRY_MAX_ SIZE 800 0 - Unlimited 

MAX_DUMP_FILE_SIZE 10240 0 to 4,000,000

MTS_MAX_DISPATCHERS (unused) (unused) 
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1 MAX_IO_SIZE is not an initialization parameter. However, it is used to calculate the maximum value of 
DB_FILE_MULTIBLOCK_READ_COUNT. On Windows NT, MAX_IO_SIZE is set to 64 KB - 512, or 65012 bytes. The 
maximum value of DB_FILE_MULTIBLOCK_READ_COUNT for a given block size is 65012 divided by the value of 
DB_BLOCK_SIZE. This result is rounded down to the next whole number. So, for DB_BLOCK_SIZE equal to 8192, the 
maximum value of DB_FILE_MULTIBLOCK_READ_COUNT is 65012/8192, which rounds to 7. For a DB_BLOCK_SIZE of 
2048, the maximum value is 31, and so on. 

2 Depends on value for DB_BLOCK_SIZE parameter.

MTS_MAX_SERVERS (unused) (unused)

MTS_SERVERS (unused) (unused) 

NLS_LANGUAGE AMERICAN Any valid language

NLS_SORT (Language dependent) (Language dependent)

NLS_TERRITORY AMERICA Any valid territory

OPEN_CURSORS 50 1 - Unlimited

OS_AUTHENT_PREFIX OPS$ Any character string 

PROCESSES 25 3 - Unlimited 

REMOTE_LOGIN_ PASSWORDFILE SHARED SHARED, EXCLUSIVE, 
NONE

SNAPSHOT_REFRESH_PROCESSES 0 0 to 10

SEQUENCE_CACHE_HASH_BUCKET 10 10 to 89

SEQUENCE_CACHE_ENTRIES 10 10 to 32000

SHARED_POOL_SIZE 6500000 300 KB - Unlimited 

SORT_AREA_SIZE 65536 0 - Unlimited 

SORT_READ_FAC 20 0 - Unlimited 

SORT_SPACEMAP_SIZES 512 0 - Unlimited 

TEXT_ENABLE TRUE TRUE or FALSE

TIMED_STATISTICS None TRUE or FALSE

TEMPORARY_TABLE_ LOCKS SESSIONS 0 - Unlimited 

TRANSACTIONS_PER_ ROLLBACK_ SEGMENT 30 1 - 255 

USER_DUMP_DEST %RDBMSnn%\TRACE Any valid directory 

Initialization Parameter Name Default Value Range of Values
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Creating a New Database Initialization Parameters
Check the following initialization parameters when creating a new database. They 
cannot be modified after you have created the database. See Chapter 9, “Creating a 
Database” for details on creating a new database, including the part of the 
procedure when you modify these parameters.  

Advanced Replication Initialization Parameters
The following initialization parameters must be set or added to the INITSID.ORA 
file (recommended values are included) if using Advanced Replication. 

Master Site
Add these initialization parameters to the master site:

1 Not an initialization parameter, but rather a clause in the CREATE DATABASE statement. See 
Chapter 9, “Creating a Database” for an example of using this clause.

Parameter Description

DB_NAME Specifies the name of the database to be created. The database 
name is a string of eight characters or less. You cannot change 
the name of a database.

DB_BLOCK_SIZE Specifies the size in bytes of Oracle database blocks.

CHARACTER SET1 Specifies the database National Language Support (NLS) 
character set to use. This parameter can be set only when you 
create the database.

Note: These parameters are already set if you choose to install the 
Replication starter database.

Parameter Name Recommended Value

SHARED_POOL_SIZE At least 10 MB

DISTRIBUTED_LOCK_TIMEOUT 300 seconds

DISTRIBUTED_TRANSACTIONS 5

GLOBAL_NAMES TRUE

OPEN_LINKS 4
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Snapshot Sites
Add these initialization parameters for snapshot sites: 

PROCESSES Add 9 to current value

JOB_QUEUE_PROCESSES 2 (depends on number of n-way sites)

JOB_QUEUE_INTERVAL 10 seconds

JOB_QUEUE_KEEP_CONNECTIONS FALSE

Parameter Name Recommended Value

SNAPSHOT_REFRESH_PROCESSES 2

SNAPSHOT_REFRESH_INTERVAL 60 seconds

SNAPSHOT_REFRESH_KEEP_CONNECTIONS FALSE

Parameter Name Recommended Value
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C
Configuration Parameters and the Registry

The registry stores the Oracle configuration parameters. This appendix describes 
only the configuration parameters that apply to your Oracle7 Server. 

Specific topics discussed are:

■ About Configuration Parameters

■ Registry Overview

■ Registry Parameters

■ Modifying a Registry Value

■ Adding a Registry Parameter
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About Configuration Parameters
Oracle7 Server software uses configuration parameters to locate files and specify 
runtime parameters common to all Oracle products. When an Oracle program or 
application requires a translation for a particular configuration variable, Oracle7 
Server consults the associated parameter. Oracle parameters are stored in the 
registry.

Registry Overview
Oracle7 Server stores its configuration information in a database (the registry) that 
is organized in a tree format. The tree format consists of keys in the registry and 
parameter values for the keys. Keys and parameter values can be viewed and 
modified in the Registry Editor. 

Keys are folders that appear in the left pane of a Registry Editor window. A key 
contains subkeys or parameters.

Parameters in the Registry Editor appear as a string that consists of three 
components:

■ name of the parameter

■ value class or type of entry

■ value itself

For example, parameter ORACLE_HOME has the following entry in the registry:

ORACLE_HOME:REG_EXPAND_SZ:ORCL

Value classes for Oracle7 Server parameters are: 

■ string value with a REG_SZ, REG_EXPAND_SZ (for an expandable string), or 
REG_MULTI_SZ (for multiple strings) prefix to identify parameter value entry 
as a data string

■ binary value with a REG_DWORD prefix to identify a value entry as a 
DWORD (hexadecimal data) entry

ATTENTION: The Registry Editor allows you to view and modify 
registry keys and parameter values. Normally, you do not need to 
do so, and in fact, are liable to break your system if you make 
incorrect changes.
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Registry Parameters
This section describes the main Oracle7 Server registry parameters. Other products, 
such as Oracle Enterprise Manager, Oracle ConText Option, and Oracle7 Spatial 
Data Option, have additional keys and parameters.

This section describes the parameters for the following keys:

■ HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE

■ HKEY_LOCAL_MACHINE\SYSTEM\CURRENTCONTROLSET\SERVICES

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE includes the following:

■ ORACLE_HOMES\ ORACLE1 subkey

■ the following parameters:

Additional Information: To modify any of the values listed below, 
see the section “Modifying a Registry Value” in this appendix.

WARNING: Only advanced users should change the registry.

Parameter Description Default Value Entry

A2OWIZ15 Specifies the location of Oracle Migration Wizard 
files.

ORACLE_HOME\A20WIZ15

API Specifies the location of files for Oracle Installer. ORACLE_HOME\DBS

COMPANY_NAME Specifies the name of the company entered during 
the installation process.

company name entered during 
installation

EXECUTE_SQL Specifies the executable to spawn SQL*Plus for 
Oracle Installer.

PLUS33

MSHELP_TOOLS Specifies the location of the Windows help files. ORACLE_HOME\MSHELP

NLS_LANG This parameter specifies the language in which the 
messages are displayed, the territory and its 
conventions for calculating week and day 
numbers, and the character set displayed. The 
default value causes all messages to be displayed 
in American English.

AMERICAN_AMERICA.WE8ISO88
5981
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NLSRTL32 Specifies the location of the Oracle7 NLS message 
files.

ORACLE_HOME\NLSRTL32

OI_NLS32 Specifies the value of ORA_NLS32 used by Oracle 
Installer during the installation process.

ORACLE_HOME\ORAINST\NLB

ORA_NLS32 Specifies the location of the system boot file and 
NLS loadable data files used by the Oracle7 
NLSRTL.

ORACLE_HOME\NLSRTL32
\DATA

ORA_ORCL_
PWFILE

Specifies the name of the password file containing 
the password for the database instance designated 
by the system identifier (SID).

ORACLE_HOME\DATABASE
\PWDSID.ORA

ORACLE_GROUP_
NAME

Specifies the name of the group containing icons of 
the Oracle products installed. The parameter is 
added to your registry when you first install Oracle 
products, even if Oracle Installer does not create a 
program group for the Oracle products you have 
installed. (For example, if you have installed only 
SQL*Net software.)

Oracle for Windows NT

ORACLE_HOME Specifies the Oracle home directory in which 
Oracle products are installed. This directory is the 
top directory in the Oracle directory hierarchy. 

ORACLE_HOME

ORACLE_SID Specifies the name of the Oracle7 Server instance 
on the host machine. The value of this parameter is 
the SID for the instance.

 ORCL (If the starter database is 
installed)

OTRACE73 Specifies the location of the Oracle7 Server trace 
files.

ORACLE_HOME\OTRACE73

PLSQL23 Specifies the directory in which Oracle7 Server 
looks for PL/SQL message files. 

ORACLE_HOME\PLSQL23

PLUS_DFLT Specifies the executable used when SQLPLUS.EXE 
is called. 

PLUS33

PLUS33 Specifies the location in which to find the files 
needed to run SQL*Plus.

ORACLE_HOME\PLUS33

PRO18 Specifies the location of Oracle7 Pro*C/C++ files. ORACLE_HOME\PRO18

RDBMS73 Specifies the directory Oracle7 Server and the 
Oracle7 Utilities use to locate messages, resource 
files, and SQL scripts. 

ORACLE_HOME\RDBMS73

Parameter Description Default Value Entry
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ORACLE_HOMES\ORACLE1
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\ORACLE_HOMES\ 
ORACLE1 subkey contains the following parameters:

RDBMS73_
ARCHIVE

Specifies the location of the backup database files. ORACLE_HOME\DATABASE
\ARCHIVE

RDBMS73_
CONTROL

Specifies the location of the database control files. ORACLE_HOME\DATABASE

SHARED_ORACLE_
HOME

Specifies the Oracle home directory used by Oracle 
Installer.

ORACLE_HOME

SQLPATH Specifies the location of the SQL scripts that 
SQL*Plus uses for searching SQL scripts. 

ORACLE_HOME\DBS

SVRMGR Specifies the location of Server Manager support 
files.

ORACLE_HOME\RDBMS73

Parameter Description Default Value Entry

API Specifies the location of files for Oracle Installer. ORACLE_HOME\DBS

COMPANY_
NAME

Specifies the name of the company entered during 
the installation process.

company name entered during 
installation

NLS_LANG This parameter specifies the language in which the 
messages are displayed, the territory and its 
conventions for calculating week and day 
numbers, and the character set displayed. The 
default value causes all messages to be displayed in 
American English.

AMERICAN_AMERICA.WE8ISO88
5981

ORACLE_GROUP_
NAME

Specifies the name of the group containing icons of 
the Oracle products installed. The parameter is 
added to your registry when you first install Oracle 
products, even if Oracle Installer does not create a 
program group for the Oracle products you have 
installed. (For example, if you have installed only 
SQL*Net software.)

Oracle for Windows NT

ORACLE_HOME Specifies the Oracle home directory in which Oracle 
products are installed. This directory is the top 
directory in the Oracle directory hierarchy. 

ORACLE_HOME

Parameter Description Default Value Entry
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HKEY_LOCAL_MACHINE\SYSTEM\CURRENTCONTROLSET\SERVICES
HKEY_LOCAL_MACHINE\SYSTEM\CURRENTCONTROLSET\SERVICES 
contains the following subkeys:

■ HKEY_LOCAL_MACHINE\SYSTEM\CURRENTCONTROLSET\SERVICES 
\ORACLE7\PERFORMANCE subkey

■ HKEY_LOCAL_MACHINE\SYSTEM\CURRENTCONTROLSET\SERVICES 
\Service subkey

HKEY_LOCAL_MACHINE\SYSTEM\CURRENTCONTROLSET\SERVICES
\ORACLE7\PERFORMANCE
HKEY_LOCAL_MACHINE\SYSTEM\CURRENTCONTROLSET\SERVICES
\ORACLE7\PERFORMANCE contains the following values:

For the Oracle7 Performance Utility to display information for Oracle7 
performance objects, it must actually log on to the database. Modify the following 
parameters if the default information is not applicable or you want to access 
another database:

SHARED_ORACLE_
HOME

Specifies the Oracle home directory used by Oracle 
Installer.

ORACLE_HOME

Parameter Description Default Value 
Entry

Hostname Connect string for local connections to the Oracle7 Server. 2:ORCL

Password Displays the password for the user name to access the database. MANAGER

Username Displays the user name to access the database. SYSTEM

Parameter Description Default Value Entry
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The following parameters are needed by the Oracle7 Performance Monitor as entry 
points.

The following parameters specify Oracle7 Performance Utility log file and object 
configuration file.

Parameter Description Default Value Entry

Close Specifies the close entry point for the 
DLL.

CloseOracle7PerformanceData

Collect Specifies the collect entry point for the 
DLL.

CollectOracle7PerformanceData

Open Specifies the open entry point for the 
DLL.

OpenOracle7PerformanceData

Library Specifies the name of the Oracle7 Per-
formance Utility DLL.

OPERF73.DLL

Parameter Description Default Value Entry

LOGFILE Specifies the name of the Oracle7 Performance 
Monitor log file. This log file reports any errors, 
such as Oracle7 objects not displaying or database 
access problems.

ORACLE_HOME\DBS
\OPERF.LOG

PERF__FILE_
NAME

Specifies the location of PERF.ORA. PERF.ORA 
contains all the performance objects displayed by 
the Oracle7 Performance Monitor.

ORACLE_HOME\DBS\PERF.ORA
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HKEY_LOCAL_MACHINE\SYSTEM\CURRENTCONTROLSET\SERVICES
\Service
HKEY_LOCAL_MACHINE\SYSTEM\CURRENTCONTROLSET\SERVICES 
contains subkeys that correspond to services:

■ OracleServiceSID

■ OracleStartSID

■ OracleTNSListener

■ OracleAgent

■ OracleConTextService73

■ OracleNamesService

Each service subkey contains the following parameters:

Parameter Description Default Value Entry

DisplayName Specifies the service name of the instances whose 
SID is SID.

Name of the service. For example, 
OracleServiceORCL, where ORCL 
is the SID.

ImagePath Specifies the fully-qualified path name of the 
executable invoked by the service and any 
command-line arguments passed into the 
executable at runtime. 

Path to the executable file of the 
product. For example, 
ORACLE_HOME\BIN
\NAMES.EXE, if 
OracleNamesService is selected.

ObjectName Specifies the logon user account and machine to 
which the service should log on.

LocalSystem
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Modifying a Registry Value

To edit the Oracle-related settings:

1. Start the Registry in either of two ways:

■ From the command prompt, enter:

C:\>REGEDT32

■ Choose Start>Run, enter REGEDT32 in the Open field, and click OK.

The Registry Editor window appears:

CAUTION: Do not edit your registry unless it is absolutely 
necessary. If there is an error in your registry, your Oracle7 
Server may become nonfunctional. In fact, the registry itself can 
become unstable.
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2. Navigate to the values you want to view or modify by double-clicking keys.

The left-hand side of the window shows the hierarchy of registry keys, and the 
right-hand side of the window shows various values associated with a key:

3. Double-click the parameter to edit.

An editor dialog box appears:

4. Make any necessary edits.

5. Click OK.

6. From the Registry menu, click Exit.
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Adding a Registry Parameter
To add a parameter to the registry:

1. From the command prompt, enter:

C:\>REGEDT32

The Registry Editor window appears.

2. Navigate to the key where you want to add the new value.

3. Choose the Add Value option in the Edit menu.

The Add Value dialog box appears:

4. In the Value Name field, enter the name that you want to assign to the 
currently selected key.

5. In the Data Type box, select the value class that you want to assign to the 
added value:

■ REG_SZ, REG_EXPAND_SZ (for an expandable string) or 
REG_MULTI_SZ (for multiple strings) for a data string.

■ binary value with a REG_DWORD prefix to identify a value entry as a 
DWORD (hexadecimal data) entry

6. Click OK.

An editor dialog box appropriate for the data type appears:
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7. Enter the value itself for the parameter.

The Registry Editor adds the parameter. 

8. Choose Exit from the Registry menu.

The registry exits.
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D
Messages and Codes

This appendix lists the error messages, causes, and corrective actions that are 
specific to the installation and operation of Oracle7 Server. 

Specific topics discussed are:

■ Logging Error Messages

■ Oracle Installer Error Messages

■ Codes 09200-09499: Oracle7 Server Database Messages

■ Codes 04000-04999: Windows NT-Specific Oracle Messages 
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Logging Error Messages 
Keep a log of error messages you receive from the Oracle7 Utilities by redirecting 
the messages to a file. You can record the contents of normal utility messages by 
using the LOGFILE parameter discussed in Oracle7 Server Utilities. You can 
separately record the error message portion by using standard Windows NT file 
redirection. For example, use the following syntax to redirect the output from the 
Export utility: 

C:\> EXP73 USERNAME/PASSWORD PARFILE=FILENAME FILE1.LOG FILE2.ERR

In this command line, FILE1.LOG receives the standard output from Export, while 
FILE2.ERR receives the standard error messages.

Oracle Installer Error Messages
This section lists potential error messages that can occur while using Oracle 
Installer. Most Oracle Installer error messages are accompanied with corrective 
information on the screen; therefore, they are not listed in this appendix. This 
appendix lists potential error messages in alphabetical order and provides the 
probable cause and corrective action.

Error Cause Action

DISK_FULL There is not enough disk space on the 
destination volume to copy the 
selected program.

Create space on the destination 
volume.

DRIVE_LOCKED The device specified in the full error 
message is in use or locked by another 
process.

Terminate or release the other 
process, or wait for it to complete.

FILE_CORRUPTED The file or directory specified in the 
full error message is damaged or not 
readable.

Try to repair or replace the file or 
repair the directory specified.

FILE_NOT_FOUND It was not possible to locate a file on 
the source or destination media. 

Run a utility program to locate 
any problems with the source or 
destination media; the media 
could be the CD-ROM drive, a 
network drive, or a floppy drive. 

INVALID_FILE_NAME The file or directory name or volume 
label specified in the full message is 
syntactically incorrect.

Specify the file, directory, or 
volume using the correct syntax.
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LEXICAL_ERROR An error has been detected in the 
installation scripts.

Call Oracle Worldwide Customer 
Support.

LOCKING_ VIOLATION A portion of the file specified in the 
full message has been locked by 
another process.

Release or terminate the other 
process, or wait for it to complete.

OS_ERROR There is an unexpected operating 
system error. 

Run a utility program to locate 
any problems with the source or 
destination media; the media 
could be the CD-ROM drive, a 
network drive, or a floppy drive. 

PERMISSION_ DENIED The network has denied permission to 
perform the selected action. 

Check with the Network 
Administrator; make sure you 
have Supervisor privileges and 
can perform the selected action. 

READ_ERROR A problem has been detected on the 
source or destination media while 
executing an I/O operation. 

1. If in a networking 
environment, verify that you 
have read permission for the 
networking file.

2. Run a utility program to 
locate any problems with the 
source or destination media; 
the media could be the CD-
ROM drive, a network drive, 
or a floppy drive.

RECALIBRATION_FAILURE A hardware problem has been detected 
on the hard drive to which you are 
installing.

Run a utility program to diagnose 
the hard drive.

SHARING_VIOLATION The file specified in the full message 
has been locked by another process. 
(This error is similar to the 
LOCKING_VIOLATION message, 
which relates to a portion of a file.)

Release or terminate the other 
process, or wait until it completes.

TOO_MANY_OPEN_FILES Too many files are open on Windows 
NT.

Close some of the open files.

Error Cause Action
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Codes 09200-09499: Oracle7 Server Database Messages
This section lists error messages issued by the Oracle7 database. Each one is 
triggered by an operating system-dependent (OSD) message specific to Windows 
NT that specifies the error condition signalled. The OSD messages appear in the 
next section. When you receive one of these messages, look up the accompanying 
OSD message number listed in the Section , “Codes 04000-04999: Windows NT-
Specific Oracle Messages” for an explanation of the error. 

WRITE_ERROR A problem has been detected on the 
destination media while executing an 
input/output (I/O) operation. 

1. If you are in a network 
environment and installing on 
to the network, verify that 
you have permission to write 
to a network directory. 

2. Run a utility program to 
locate any problems with the 
source or destination media; 
the media could be the CD-
ROM drive, a network drive, 
or a floppy drive.

WRITE_PROTECTED The file or directory specified in the 
full message (in which Oracle software 
is to be installed) is write-protected. 

Remove the write-protection from 
the specified file or directory.

Message Signal

ORA-09200 sfccf: error creating file

ORA-09201 sfcopy: error copying file

ORA-09202 sfifi: error identifying file

ORA-09203 sfofi: error opening file

ORA-09204 sfotf: error opening temporary file

ORA-09205 sfqio: error reading or writing to disk

ORA-09206 sfrfb: error reading from file

ORA-09207 sfsrd: error reading from file

ORA-09208 sftcls: error closing file

ORA-09209 sftget: error reading from file

ORA-09210 sftopn: error opening file

Error Cause Action
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ORA-09211 sfwfb: error writing to file

ORA-09212 sfwfbmt: error writing to file

ORA-09213 slgfn: error fabricating file name

ORA-09214 sfdone: I/O error detected 

ORA-09215 sfqio: error detected in I/O completion routine

ORA-09216 sdnfy: bad value ’%s’ for parameter %s

ORA-09217 sfsfs: failed to resize file

ORA-09218 sfrfs: failed to refresh file size

ORA-09240 smpalo: error allocating PGA memory

ORA-09241 smsalo: error allocating SGA memory

ORA-09242 smscre: error creating SGA

ORA-09243 smsget: error attaching to SGA

ORA-09244 smprset: error setting memory protections

ORA-09245 smcstk: error switching stacks

ORA-09246 sfsmap: unable to map SGA

ORA-09247 smsdes: error destroying the SGA

ORA-09260 sigpidu: error obtaining process id

ORA-09261 spdcr: error creating detached (background) process

ORA-09262 spdde: error terminating detached (background) process

ORA-09263 spini: error initializing process

ORA-09264 sptpa: error flagging process

ORA-09265 spwat: error temporarily suspending process 

ORA-09266 spawn: error starting an Oracle process

ORA-09270 szalloc: error allocating memory for security

ORA-09271 szlon: error verifying user name

ORA-09272 remote OS login is not allowed

ORA-09273 szrfc: error verifying role name

ORA-09274 szrfc: insufficient role name buffer space

ORA-09280 sllfcf: error closing file

Message Signal
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ORA-09281 sllfop: error opening file

ORA-09282 sllfrb: error reading records

ORA-09283 sllfsk: error skipping records

ORA-09290 sksaalo: error allocating memory for archival

ORA-09291 sksachk: invalid device specification for LOG_ARCHIVE_DEST

ORA-09292 sksabln: unable to build file name

ORA-09293 sksasmo: unable to send message to console

ORA-09300 osncon: unable to connect, DPMI not available

ORA-09301 osncon: local kernel only supported in standard mode

ORA-09310 sclgt: error freeing latch

ORA-09311 slsleep: error temporarily suspending process

ORA-09312 slspool: error spooling file to printer

ORA-09313 slsprom: error prompting user

ORA-09314 sltln: error translating logical name

ORA-09315 sql2tt: two-task error translating ORACLE_EXECUTABLE

ORA-09316 szrpc: unable to verify password for role

ORA-09317 szprv: insufficient privileges

ORA-09318 slkhst: error hosting out to operating system

ORA-09319 slgtd: unable to obtain the current date and time

ORA-09320 szrfc: unable to obtain the list of valid OS roles

ORA-09321 slzdtb: unable to convert zoned decimal to binary

ORA-09322 slpdtb: unable to convert packed decimal to binary

ORA-09330 session terminated internally by Oracle or by an Oracle DBA

ORA-09331 scgcan: unable to process lk_sync_cancel return code

ORA-09332 scgcc: unable to process lk_close return code

ORA-09333 scggc: unable to process lk_open_convert return code

ORA-09334 scggc: unable to process lk_convert return code

ORA-09335 scgcm: unable to process return code in completion procedure

ORA-09340 specified ORACLE_SID is either invalid or too long 

Message Signal
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Codes 04000-04999: Windows NT-Specific Oracle Messages
The error messages in this section are Oracle operating system-dependent (OSD) 
messages issued in response to an error condition in Windows NT. Each message 
in this section triggers an Oracle7 Server database error message, listed in the 
previous Section , “Codes 09200-09499: Oracle7 Server Database Messages”. 

■ File I/O Errors: OSD-04000 to OSD-04099

■ Memory Errors: OSD-04100 to OSD-04199

■ Process Errors: OSD-04200 to OSD-04299

■ Loader Errors: OSD-04300 to OSD-04399

■ Semaphore Errors: OSD-04400 to OSD-04499

■ Miscellaneous Errors: OSD-04500 to OSD-04599

File I/O Errors: OSD-04000 to OSD-04099
OSD-04000

Logical block size mismatch
Cause:  The database block size specified in the initialization parameter file 
does not match the block size of the actual database files.

Action:  Use matching logical block sizes.

OSD-04001
Invalid logical block size
Cause:  The logical block size is not a multiple of 512 bytes, or it is too large. 

Action:  Change the value of DB_BLOCK_SIZE in the initialization parameter 
file.

ORA-09341 scumnt: unable to mount database

ORA-09342 Detached process terminated by Oracle during SHUTDOWN ABORT

ORA-09350 Windows NT two-task driver unable to allocate context area

ORA-09351 Windows NT two-task driver unable to allocate shared memory

ORA-09352 Windows NT two-task driver unable to spawn new Oracle task

ORA-09353 Windows NT two-task driver unable to open event semaphore

ORA-09354 Windows NT two-task driver: Oracle task unexpectedly died

Message Signal
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OSD-04002
Unable to open file
Cause:  The specified path or filename is invalid, or the destination device is 
full. This error can also be caused by insufficient Windows NT file handles. 

Action:  Make sure the path and file exist, and the device has free space. If this 
fails, increase the number of Windows NT file handles. 

OSD-04003
Unable to read file header block
Cause:  The media has been damaged. 

Action:  Recover the file if necessary, and verify that Windows NT is 
functioning correctly. 

OSD-04004
Invalid file header
Cause:  The file is corrupted. 

Action:  Recover the file. 

OSD-04005
SetFilePointer() failure, unable to read from file
Cause:  There was an unexpected return from the Windows NT system service, 
SetFilePointer(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04006
ReadFile() failure, unable to read from file
Cause:  There was an unexpected return from the Windows NT system service, 
ReadFile(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation.

OSD-04007
Truncated read
Cause:  The system encountered an unexpected end-of-file, which is due to 
damaged media. 

Action:  Verify that the file is not damaged. 
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OSD-04008
WriteFile() failure, unable to write to file
Cause:  There was an unexpected return from the Windows NT system service, 
WriteFile(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04009
Truncated write
Cause:  The destination device is full or the media is damaged.

Action:  Verify that the device has free space and the file is not damaged. 

OSD-04010
<create> option specified, file already exists
Cause:  The file you attempted to create already exists.

Action:  Delete the existing file or use the REUSE option in the SQL statement. 

OSD-04011
GetFileInformationByHandle() failure, unable to obtain file info
Cause:  There was an unexpected return from the Windows NT system service, 
GetFileInformationByHandle().

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04012
File size mismatch
Cause:  The file to be re-used is either too large or too small.

Action:  Specify the correct file size or delete the existing file. 

OSD-04013
Unable to read line from file
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check the operating system error code (if available) and consult the 
Windows NT documentation. If no operating system error code is presented, 
verify that the media is not damaged. 
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OSD-04014
Unable to close file
Cause:  The media has been damaged. 

Action:  Recover the file, if necessary, and verify that Windows NT is 
functioning correctly. 

OSD-04015
Asynchronous I/O request returned an error
Cause:  There was an unexpected return from the Windows NT system service. 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04016
Error queuing an asynchronous I/O request
Cause:  There was an unexpected return from the Windows NT system service. 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04017
Unable to open the specified RAW device
Cause:  An invalid path or filename was specified or the device is full.

Action:  Make sure the file exists and/or device is not full; verify that the 
operating system is functioning correctly.

OSD-04018
Unable to access the specified directory or device
Cause:  An invalid path name was specified. 

Action:  Make sure the directory or device exists and is accessible. 

OSD-04019
Unable to set file pointer
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check the operating system error code (if available) and consult the 
Windows NT documentation. If no operating system error code is presented, 
verify that the media is not damaged. 
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OSD-04020
Unable to set eof file marker
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check the operating system error code (if available) and consult the 
Windows NT documentation. If no operating system error code is presented, 
verify that the media is not damaged. 

OSD-04021
Unable to read file
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check the operating system error code (if available) and consult the 
Windows NT documentation. If no operating system error code is presented, 
verify that the media is not damaged. 

OSD-04022
Unable to write file
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check the operating system error code (if available) and consult the 
Windows NT documentation. If no operating system error code is presented, 
verify that the media is not damaged. 

OSD-04023
SleepEx() failure, unable to Sleep
Cause:  There was an unexpected return from the Windows NT system service. 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04024
Unable to delete file
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check the operating system error code (if available) and consult the 
Windows NT documentation. If no operating system error code is presented, 
verify that the media is not damaged. 



Codes 04000-04999: Windows NT-Specific Oracle Messages

D-12 Oracle7 Server Getting Started Release 7.3.4 for Windows NT                                                    

OSD-04025
Invalid question asked
Cause:  This is an internal error, not normally expected to occur.

Action:  Contact Oracle Worldwide Customer Support. 

OSD-04026
Invalid parameter passed
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Worldwide Customer Support. 

Memory Errors: OSD-04100 to OSD-04199
OSD-04100

Malloc() failure, unable to allocate memory
Cause:  The program is out of memory. 

Action:  Shut down all unnecessary processes or install more memory in the 
computer. 

OSD-04101
Invalid SGA: SGA not initialized
Cause:  The System Global Area (SGA) has been allocated but not initialized.

Action:  Wait until the STARTUP has completed before attempting to connect.

OSD-04102
Unable to open/create file for shared memory object
Cause:  There was an unexpected return from the Windows NT system service, 
CreateFile(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04103
Unable to attach to SGA: SGA does not exist
Cause:  The SGA does not exist. 

Action:  Start up an Oracle instance.
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OSD-04104
Unable to map shared memory (SGA) into the address space
Cause:  There was an unexpected return from the Windows NT system service, 
MapViewOfFileEx(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04105
Shared memory (SGA) mapped to wrong address
Cause:  There was an unexpected return from the Windows NT system service, 
MapViewOfFileEx(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04106
Unable to allocate memory with VirtualAlloc
Cause:  The program is out of memory. 

Action:  Shut down all unnecessary processes or install more memory in the 
computer. 

OSD-04107
Unable to deallocate memory with VirtualFree
Cause:  There was an unexpected return from the Windows NT system 
service,VirtualFree(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04108
Unable to protect memory with VirtualProtect
Cause:  There was an unexpected return from the Windows NT system 
service,VirtualProtect(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation.
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Process Errors: OSD-04200 to OSD-04299
OSD-04200

Unable to begin another thread
Cause:  The program has run out of system resources. 

Action:  Shut down all unnecessary processes; install more memory in the 
computer.

OSD-04201
No pid structure supplied to spdcr()
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Worldwide Customer Support. 

OSD-04202
DosSetPriority() failure, unable to set process priority
Cause:  There was an unexpected return from the Windows NT system service, 
DosSetPriority(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04203
DosKillProcess() failure, unable to kill process
Cause:  There was an unexpected return from the Windows NT system service, 
DosKillProcess(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04204
Invalid pid
Cause:  Process ID not recognized by system, process previously terminated.

Action:  Verify that process ID is correct and that process is active. 

OSD-04205
CreateProcess() failure, unable to spawn process
Cause:  There was an unexpected return from the Windows NT system service, 
CreateProcess().

Action:  Check the operating system error code and consult the Windows NT 
documentation.
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OSD-04207
Invalid priority specified in CONFIG parameter ORACLE_PRIORITY
Cause:  The priority specified is invalid or out of range. 

Action:  Specify a valid setting for ORACLE_PRIORITY. 

OSD-04208
OpenProcess() failure, unable to open process handle
Cause:  There was an unexpected return from the Windows NT system service, 
OpenProcess(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04209
Incorrect or unknown background image name given to spdcr()
Cause:  There was an unexpected background name given to spdcr(). 

Action:  Contact Oracle Worldwide Customer Support. 

OSD-04210
Timeout waiting for thread semaphore
Cause:  An Oracle7 thread died holding the semaphore. 

Action:  Restart Oracle7 instance. 

OSD-04211
Thread information not found
Cause:  An Oracle7 Server thread died without deleting its information. 

Action:  Restart Oracle7 Server instance. 

OSD-04212
Maximum number of Oracle threads reached
Cause:  The maximum number of Oracle7 Server threads for the instance is 
reached.

Action:  Wait until some connections exit before trying again. 

OSD-04213
Oracle thread unable to DuplicateHandle()
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Worldwide Customer Support. 
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OSD-04214
Oracle thread unable to CreateEvent()
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Worldwide Customer Support. 

OSD-04215
Bad function code supplied to ssthreadop
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Worldwide Customer Support. 

OSD-04216
Unable to find file handle for that thread
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Worldwide Customer Support. 

OSD-04217
Unable to retrieve system username for current user
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Worldwide Customer Support. 

OSD-04218
Cannot post thread
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Worldwide Customer Support. 

OSD-04219
Bad thread list semaphore
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Worldwide Customer Support. 
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Loader Errors: OSD-04300 to OSD-04399
OSD-04300

Unable to read complete record from data file
Cause:  The data file ended in the middle of a record. This error occurs when 
loading files with a fixed record length. 

Action:  Verify that the data file is of the correct length and contains complete 
records. 

OSD-04301
Record size too large
Cause:  The specified record size is too large to load. 

Action:  Reduce record size and reload the data. 

OSD-04302
Invalid record type and/or load options
Cause:  The control file’s Windows NT file processing options string contains 
an invalid option or keyword. 

Action:  Set the Windows NT file processing options string to an acceptable 
value. 

Semaphore Errors: OSD-04400 to OSD-04499
OSD-04400

Unable to acquire internal semaphore for process
Cause:  Oracle7 Server has exceeded the maximum number of connections. 

Action:  Delete any unused connections and try again. 

OSD-04401
WaitForSingleObject() failure, unable to obtain semaphorex
Cause:  There was an unexpected return from the Windows NT system service, 
WaitForSingleObject(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 
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Miscellaneous Errors: OSD-04500 to OSD-04599
OSD-04500

Illegal option specified
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Worldwide Customer Support.

OSD-04501
Internal buffer overflow
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Worldwide Customer Support.

OSD-04502
Translations nested too deep
Cause:  The program encountered too many intermediate translations while 
attempting to translate a configuration variable. 

Action:  Simplify the values of configuration parameters to include fewer 
intermediate translations. 

OSD-04503
Text contains no translatable elementsx
Cause:  The program cannot recognize variables in the text to be translated.

Action:  Check and, if necessary, correct the text to be translated. 

OSD-04505
Stdin not responding
Cause:  The system is unable to receive input from the standard input stream.

Action:  Verify that the process has access to an input device. 

OSD-04506
Unable to spawn process via system()
Cause:  The system is out of memory or the executable is invalid. 

Action:  Shut down unnecessary processes; install more memory in the 
computer. Verify the name of the executable. 
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OSD-04507
Password for ’internal’ is incorrect
Cause:  An attempt was made to connect as ’internal’ with an invalid password. 

Action:  Verify that the password is correct and try again. 

OSD-04508
No password given
Cause:  An attempt was made to connect as ’internal’ without a password.

Action:  Enter a valid password when connecting as internal. 

OSD-04509
No password found
Cause:  Oracle was unable to locate and retrieve the password for ’internal’.

Action:  Verify that Oracle is installed and configured correctly. 

OSD-04510
Operating system roles are not supported
Cause:  An attempt was made to use an operating system role. 

Action:  Only use roles that were created ’IDENTIFIED BY password’ as 
opposed to ’IDENTIFIED EXTERNALLY’. 

OSD-04511
Unable to get date and time from the operating system
Cause:  There was an unexpected return from GetLocalTime() call. 

Action:  Verify that the system time is correct on the computer. 

OSD-04512
Unable to translate the ’USERNAME’ configuration variable on server
Cause:  The ’USERNAME’ configuration parameter variable on the host is not 
properly set. 

Action:  Verify the ’USERNAME’ variable is set. 

OSD-04513
’REMOTE_OS_AUTHENT’ variable not set to TRUE’
Cause:  For remote operating system logins to function, the 
’REMOTE_OS_AUTHENT’ parameter must be set to TRUE. 

Action:  Shut down and start up the instance with ’REMOTE_OS_AUTHENT = 
TRUE’ in the initialization parameter file. 
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OSD-04514
The Windows NT Group name is too long for internal buffer
Cause:  The Windows NT Group name is too long.

Action:  Use a shorter Windows NT group name.
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E
National Language Support

This appendix describes National Language Support (NLS).

Specific topics discussed are:

■ NLS_LANG Parameters and Components

■ Default Values for NLS_LANG

■ Installing Additional Languages
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NLS_LANG Parameters and Components
Oracle7 Server provides NLS that enables users to interact with the database in 
their selected language. When you install Oracle7 Server, you select a language for 
database messages. Oracle Installer supplies a value for the NLS_LANG parameter 
based on the language selected. 

The NLS_LANG parameter uses the following format:

NLS_LANG = LANGUAGE_TERRITORY.CHARACTER_SET 

where:

The default language at installation is American English. If you accept the default 
language, the following value is supplied for the NLS_LANG parameter: 

AMERICAN_AMERICA.WE8ISO8859P1

The NLS_LANG parameter is stored in the registry under 
\HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\NLS_LANG.   

LANGUAGE Specifies the language and conventions for displaying 
messages, day name, and month name.

TERRITORY Specifies the territory and conventions for calculating week 
and day numbers.

CHARACTER_SET Controls the character set used for displaying messages.

Additional Information: See Oracle7 Server Reference for 
information on the NLS_LANG parameter and NLS initialization 
parameters.
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Default Values for NLS_LANG
The following table lists the default NLS_LANG values if you select any of these 
languages during installation of Oracle7 Server.   

If You Select... Then the NLS_LANG Value is...

Arabic ARABIC_UNITED ARAB EMIRATES.AR8MSWIN1256

Brazilian Portuguese BRAZILIAN PORTUGUESE_BRAZIL.WE8ISO8859P1

Catalan CATALAN_CATALONIA.WE8ISO8859P1

Croatian CROATIAN_CROATIA.EE8MSWIN1250

Czech CZECH_CZECH REPUBLIC.EE8MSWIN1250

Danish DANISH_DENMARK.WE8ISO8859P1

Dutch DUTCH_THE NETHERLANDS.WE8ISO8859P1

English AMERICAN_AMERICA.WE8ISO8859P1

Finnish FINNISH_FINLAND.WE8ISO8859P1

French FRENCH_FRANCE.WE8ISO8859P1

German GERMAN_GERMANY.WE8ISO8859P1

Greek GREEK_GREECE.EL8MSWIN1253

Hebrew HEBREW_ISRAEL.IW8MSWIN1255

Hungarian HUNGARIAN_HUNGARY.EE8MSWIN1250

Italian ITALIAN_ITALY.WE8ISO8859P1

Japanese JAPANESE_JAPAN.JA16SJIS

Korean KOREAN_KOREA.KO16KSC5601

Latin American Spanish LATIN AMERICAN SPANISH_AMERICA.WE8ISO8859P1

Norwegian NORWEGIAN_NORWAY.WE8ISO8859P1

Polish POLISH_POLAND.EE8MSWIN1250

Portuguese PORTUGUESE_PORTUGAL.WE8ISO8859P1

Romanian ROMANIAN_ROMANIA.EE8MSWIN1250

Russian RUSSIAN_CIS.CL8MSWIN1251

Simplified Chinese SIMPLIFIED CHINESE_CHINA.ZHS16GBK

Slovak SLOVAK_SLOVAKIA.EE8MSWIN1250
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Installing Additional Languages
To install an additional language:

1. Run Oracle Installer again.

2. Enter the language you want to install in the Language dialog box.

3. Install the Oracle products again.

This method keeps any language support that was previously installed and adds 
the new language.

Spanish SPANISH_SPAIN.WE8ISO8859P1

Swedish SWEDISH_SWEDEN.WE8ISO8859P1

Traditional Chinese TRADITIONAL CHINESE_TAIWAN.ZHT16BIG5

Turkish TURKISH_TURKEY.WE8ISO8859P9

If You Select... Then the NLS_LANG Value is...
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F
Troubleshooting

This appendix lists known issues, restrictions and workarounds when using 
Oracle7 Server. It also describes how to contact Oracle Worldwide Customer 
Support if you cannot resolve these problems, or if you need to report an error. It 
includes the following topics:

Specific topics discussed are:

■ Known Issues, Restrictions, and Workarounds

■ Contacting Oracle Worldwide Customer Support
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Known Issues, Restrictions, and Workarounds

Replication Between Versions 7.2 and 7.3
Replication works between a 7.2 updatable snapshot site and a 7.3 master site 
environment with added parameters to generate_replication_support(). 
The parameter gen_rep2_trigger is FALSE by default; set it to TRUE to make 
the 7.2/7.3 situation work.

Using NT Backup Manager
When backing up to tape using the NT Backup Manager, only 4mm tape drive 
backups are supported.

Support for Universal Naming Conventions
Oracle7 Server does not support universal naming conventions.

Windows NT Registry Keys
If you receive error messages when opening Windows NT registry keys during 
installation, do the following: 

On Windows NT 3.51, use the File Manager to go to 
ORACLE_HOME\SYSMAN\OLE2 and double-click on each registry file. A 
message dialog appears indicating that the registry edit succeeded.

Operating System Permission Problems
The permission problem (OS 5 or 3) is typically caused by inadequate configuration 
of the NTFS permissions. By default, the Oracle7 database service runs using the 
System Account instead of a named Windows NT user such as Administrator. In 
File Manager or Windows NT Explorer, you must grant Full Control on the 
ORACLE_HOME directory and all of its subdirectories to the SYSTEM user. The 
SYSTEM user has the full name The operating system and has an icon of a computer 
chip. For this and other Windows NT problems, consult your Windows NT 
documentation or contact your Windows NT System Administrator. 

After correcting the problem, delete any files that were created as a result of partial 
completion of the CREATE DATABASE command. The files to delete are the 
control files (specified in the initialization parameter file), online redo log files 
(specified in the CREATE DATABASE statement), and the data file(s). Then, run 
the CREATE DATABASE script again in Server Manager. 
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Contacting Oracle Worldwide Customer Support

How to Contact Oracle Worldwide Customer Support
Oracle Worldwide Customer Support can be contacted as follows:

For further information on how to contact Oracle Worldwide Customer Support, 
refer to the included Customer Support Information Booklet.

Before You Call for Assistance
Before calling for assistance, please have the following information available:

■ Your CPU Support Identification (CSI) number

■ Oracle Product Registration Number

■ Oracle product name and version number

■ Make and model of your computer

■ Available memory and disk space of your computer

■ Operating system vendor, name, and version number, if applicable

■ Network operating system vendor, name, and version number, if applicable

■ Any Oracle error numbers and error message text

Location Contact

United States of America Telephone (1) (650) 506-1500

Europe Telephone (1) (44) (1344) 860-160

Outside the United States of America and 
Europe

Your Oracle sales representative

Worldwide Visit: http://www.oracle.com/support/ 
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Glossary

Meaning

admin privileges

The authorization to perform certain administrative procedures on a system.

alias

(1) An alternative name for an existing network object, such as a host (server), or a 
set of parameters. (2) In SQL, a temporary name assigned to a table, view, column, 
or value within a SQL statement, used to refer to that item later in the same 
statement or in associated SQL*Plus commands. (3) In SQL*Net, a nickname for a 
string by which a remote database can be accessed.

application

One or more program modules used to achieve a specific result.  Applications can 
be nested within other applications.

argument

An independent variable whose value can be used to modify a command.

authenticate

The process of verifying the identity of a user, device, or other entity in a computer 
system, often as a prerequisite to allowing access to resources in a system.

authorization

Permission given to a user, program, or process to access Oracle7 Server.
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call interface

A set of standard software routines used to access Oracle7 Server. Also called the 
Oracle Call Interface (OCI).

client–server architecture 

Software architecture based on a separation of processing between two CPUs, one 
acting as the client in the transaction, requesting and receiving services, and the 
other as the server that provides services in a transaction.

data dictionary

Where Oracle7 Server stores information about the structure of the database 
(describes how the data in the server is organized). Collection of tables and views 
commonly used by Oracle7 Server. Owned by the user SYS. Includes:

■ names of all tables and views in the database

■ names and datatypes of columns in database tables

■ privileges of all Oracle users

domain

A division of names guaranteed to be unique. Domains are related hierarchically in 
a naming model.

dump file

See trace file.

dynamic data dictionary

An online data dictionary is an integral part of the data source and always reflects 
the current definition of the data source. Data structures can be changed while the 
data source is being accessed. See also data dictionary.

DLL

Dynamic Link Libraries. Microsoft Windows operating system-loadable executable 
files.
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instance

Combination of processes and threads that begins each time a database is started. 
Identified with a unique system identifier (SID). A default instance, ORCL, is 
installed during installation of Oracle7. The background threads and memory areas 
required to access Oracle7 Server. A database system requires one instance and one 
database. Every Oracle7 Server instance has a single system global area (SGA); a 
multiple-user instance also requires several background threads.

instance recovery

Recovery of an instance in the event of software or hardware failure, so that the 
database is again available to users.  If the instance terminates abnormally, then 
instance recovery automatically occurs at the next instance startup.

instance failure

Failure that occurs when a problem arises that prevents a database instance (SGA 
and background processes) from continuing work. Instance failure can result from 
a hardware problem such as an outage, or a software problem such as an operating 
system crash. When an instance failure occurs, the data in the buffers of the SGA is 
not written to the data files.

instance identifier

A name or ID used to distinguish one instance from another when multiple 
instances exist on one CPU. The identifier is specified in an operating-system 
specific manner.

listener

The server process that listens for and accepts incoming connection requests from 
client applications. Oracle listener processes start up Oracle database processes to 
handle subsequent communications with the client.

LISTENER.ORA

A configuration file that describes one or more Transparent Network Substrate 
(TNS) listeners on a server.

log on account

A user name and password to use Oracle7 Server. This account is usually separate 
from an operating system account.
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logon string

A user-specified command line, used to run an application that is connected to 
either a local or remote database. The log on string either explicitly includes a 
connect string or implicitly uses a default connect string.

mount

To associate a database with a started instance, in order to perform maintenance on 
the database, or to open it and make a database accessible to database users.

mounted database

A database associated with an Oracle instance. The database can be opened or 
closed. A database must be both mounted and opened to be accessed by users. A 
database that has been mounted but not opened can be accessed by DBAs for 
maintenance purposes.

NLS

National Language Support. Oracle support of national languages. Data can be 
entered, stored, and displayed in the language of the administrator’s choice.

SQL*Net

The Oracle client/server communication software that offers transparent operation 
to Oracle tools or databases over any type of network protocol and operating 
system.

Network Computing Architecture

Network Computing Architecture is a common set of technologies that enables all 
PCs, network computers, and other client devices to work with all Web servers, 
database servers, and application servers over any network. It is a robust, scalable, 
and open infrastructure that serves as the basis for the next generation of 
distributed computing. 

network listener

A listener on a server that listens for connection requests for one or more databases 
on one or more protocols.

network service 

In an Oracle application network, a service performs tasks for its service 
consumers; for example, a Names Server provides name resolution services for 
clients.
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NULL value

 The absence of a value.

\ORANT

Default Oracle home directory where the Oracle Installer installs Oracle7 Server.

off-line redo log

A redo log file that has been archived.

online redo log

Redo log files that have not been archived, but are either available to the instance 
for recording database activity or are filled and waiting to be archived or re-used.

online redo log file

File that records all committed changes made to the database. Whenever a 
transaction is committed, the corresponding redo entries temporarily stored in redo 
log buffers of the SGA are written to an online redo log file by the background 
process LGWR. An online redo log file can be individual or mirrored; in the latter 
case, it is an online redo log group, made up of online redo log members.

Oracle Call Interface (OCI)

An Oracle product that allows users to embed Oracle calls directly into high-level 
languages. It is the program call interface to Oracle7 Server. See also call interface.

Oracle Protocol Adapters

A set of products in which each one maps the functions of a given network 
protocol into TNS, so that TNS can act as an interface among all protocols. For 
example, there is a TCP/IP protocol adapter. SQL*Net requires protocol adapters.

Oracle service

Created and associated with Oracle7 Server. Similar to Windows NT services.

Oracle System Identifier (SID)

A unique name for an Oracle7 Server instance. To switch between Oracle7 Servers, 
users must specify the desired SID. The SID is included in the CONNECT DATA 
parts of the connect descriptors in a TNSNAMES.ORA file, and in the definition of 
the TNS listener in the LISTENER.ORA file.
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Oracle Tool

Any Oracle application tool (such as SQL*Plus), an Oracle end-user tool (such as 
Oracle Forms), or a third-party software program that interfaces with Oracle7 
Server.

PL/SQL

The Oracle procedural language extension of SQL. PL/SQL combines the ease and 
flexibility of SQL with the procedural functionality of a structured programming 
language, such as IF ...THEN, WHILE, and LOOP.  Even when PL/SQL is not 
stored in the database, applications can send blocks of PL/SQL to the database 
rather than individual SQL statements, thereby reducing network traffic.

parameter file

File that contains information to initialize the database and instance.

precompiler

A tool that enables a user to embed any SQL statement in a third-generation 
language (3GL) (host language) program. The precompiler takes this program as 
input and produces as output another program, in the same 3GL, in which all the 
embedded SQL calls are translated into host language procedure calls. This 
resulting program can be compiled, linked, and executed. Oracle supports 
precompilers for the languages C, FORTRAN, Pascal, PL/I, COBOL, and Ada.

privilege

A right to successfully execute a particular type of SQL statement. Some examples 
of privileges include rights to connect to the database (create a session), create a 
table in your schema, select rows from someone else’s table, and execute someone 
else’s stored procedure. The privileges of Oracle7 Server can be divided into two 
distinct categories: system privileges and object privileges.

procedure

A set of SQL and PL/SQL statements grouped together as an executable unit to 
perform a very specific task.  Procedures and functions are nearly identical; the 
only difference between the two is that functions always return a single value to 
the caller, while procedures do not return a value to the caller.
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process

(1) A thread of control in an operating system; that is, a mechanism in an operating 
system that can execute a series of steps. Some operating systems use the term job 
or task. A process normally has its own private memory area in which it runs. 
Oracle7 Server has two general types of processes: user processes and Oracle 
processes. (2) A synonym for “user,” a single entity performing a set of tasks in an 
operating system environment or a database.

Process Monitor (PMON)

One of five background tasks used by an Oracle instance. PMON performs 
recovery when a process accessing a database terminates abnormally.

Protocol Adapter

The software component of the Oracle Transparent Network Substrate (TNS) 
architecture that translates TNS function calls into requests to the underlying 
network protocol.

query

A SQL SELECT statement that retrieves data, in any combination, expression, or 
order.  Queries are read-only operations; they do not change any data, they only 
retrieve data.

quota

A limit on a resource, such as a limit on the amount of database storage used by a 
database user. A DBA can set tablespace quotas for each Oracle user name.

redo log

A sequential log of all changes made to the data. The redo log is written and used 
in the event that a failure caused the changes to not be written to disk; it is used to 
re-apply the changes to disk. The redo log consists of two or more redo log files; 
one is optionally being saved while the other is being written to by Oracle7 Server. 
When the file currently being written fills, the other file is re-used. See also online 
redo log and off-line redo log.

 redo log file 

A file containing records of changes to the databases.  These files are used for 
recovery purposes.  See also redo log. 

remote computer

A computer on a network other than the local computer.



Glossary-8                                                                         

remote database

A database on a computer other than the local database. Usually a computer on the 
same network, but at a different node (that is, a database that you use through a 
database link).

replication

A database feature in which identical (and updateable) copies of a table are stored 
in the database, on more than one node. 

role

A list of user names that can be granted privileges to operate on database objects, 
or perform database system level operations.

roles

Named groups of related privileges that are granted to users or other roles.

rollback

The second half of the recovery procedure. After the roll forward, any changes that 
were not committed must be undone. After the redo log files have been applied, 
the rollback segments are used to identify and undo transactions that were never 
committed, yet were recorded in the redo log. Oracle completes this step 
automatically.

SQL

Structured Query Language—the internationally accepted standard for defining 
and manipulating relational databases.

SID

A unique name for an Oracle database instance. To switch between Oracle 
databases, users must specify the desired SID. The SID is included in the 
CONNECT DATA parts of the connect descriptors in a TNSNAMES.ORA file, and 
in the definition of the network listener in the LISTENER.ORA file. Also known as 
system ID.

schema

A collection of table definitions.
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schema objects

A collection of related objects. Schema objects are the logical structures that directly 
refer to the database’s data. Schema objects include such structures as tables, views, 
sequences, stored procedures, synonyms, indexes, clusters, and database links. 
There is no relationship between a tablespace and a schema: objects in the same 
schema can be in different tablespaces, and a tablespace can hold objects from 
different schemas.

select

To fetch rows from one or more database tables using a query (the SQL statement 
SELECT).

server

(1) The provider of services requested by a client. (2) A process providing services 
to other co-operating processes.

service

An executable process installed in the registry database and administered by 
Windows NT. Once created and started, it can run even while no user is logged on 
to Oracle7 Server.

service name

The name used to identify a SQL*Net server process. The services file on client and 
server machines maps each service name to a port number and protocol.

session

The time after a user name connects to Oracle7 Server and before disconnecting, 
and the events that happen in that time.

snapshot

Information stored in rollback segments to provide transaction recovery and read 
consistency. Rollback segment information can be used to re-create a snapshot of a 
row before an update.

snapshots

Read-only copies of a master table located on a remote node.  A snapshot can be 
queried, but not updated; only the master table can be updated.  A snapshot is 
periodically refreshed to reflect changes made to the master table.
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starter database

The starter database named ORACLE is the core of Oracle7 Server. Oracle 
Corporation recommends that you use the starter database and modify it to suit 
your needs.

static data dictionary

A data dictionary that contains data definitions that are not an integral part of the 
data source. Changes to data structures require the data source to be rebuilt. See 
also dynamic data dictionary.

synonym

An alias for a table, view, sequence, or program unit; a synonym is not actually an 
object itself, it is a direct reference to its base object.  Synonyms are used to mask 
the real name and owner of an object, provide public access to an object, provide 
location transparency for tables, views, or program units of a remote database, and 
simplify the SQL statements for database users.  A synonym can be public or 
private.

SYSDBA

A special database administer role that contains all system privileges with the 
ADMIN OPTION, and the SYSOPER system privilege. SYSDBA also permits 
CREATE DATABASE and time–based recovery.

SYSOPER

A special database administer role that permits a database administrator to 
perform STARTUP, SHUTDOWN, ALTER DATABASE OPEN/MOUNT, ALTER 
DATABASE BACKUP, ARCHIVE LOG, and RECOVER, and includes the 
RESTRICTED SESSION privilege.

system ID

A synonym for instance identifier. Often abbreviated to SID.

SYSTEM user name

One of two standard DBA user names automatically created with each database 
(the other is SYS). The Oracle user SYSTEM is created with the password 
MANAGER. The SYSTEM user name is the preferred user name for DBAs to use 
when performing database maintenance.
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TNSNAMES.ORA

A network configuration file that contains connect descriptors mapped to service 
names. The file may be maintained centrally or locally, for use by all or individual 
clients.

table

The basic unit of storage in a relational database management system. A table 
represents entities and relationships, and consists of one or more units of 
information (rows), each of which contains the same kinds of values (columns). 

tablespace

A logical portion of Oracle7 Server used to allocate storage for table and index data. 
Each tablespace corresponds to one or more physical database files. Every Oracle7 
Server has a tablespace called SYSTEM and may have additional tablespaces. A 
tablespace is used to group related logical structures together. For example, 
tablespaces commonly group all of an application’s objects to simplify certain 
administrative operations.

trace file

A file created when a problem or exceptional condition is encountered while using 
a software program. Also called a dump file, the file contains information useful in 
diagnosing or locating the problem. 

variable

A named object that can be assigned a value and whose assigned value may change 
over time.  SQL*Plus uses substitution, system, and user variables.

variable parameters

(1) Parameters whose value can be changed or reset. (2) The INITSID.ORA 
parameters whose values can vary and affect the performance of a database. DBAs 
may wish to “tune” or experiment with the variable parameter values in order to 
optimize their database’s performance.
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Index
Symbols
"", SQL*Loader parameter, 3-16
"FIX n", SQL*Loader parameter, 3-16
"VAR xxxx", SQL*Loader parameter, 3-16

A
A2OW1Z15 parameter, C-3
Advanced Networking Option, 5-22
Advanced Program-to-Program Communication 

(APPC), defined, 2-13
Advanced Replication support

configuration guidelines, 8-2
configuring, 8-18, 8-20
data dictionary tables, 8-21
initialization parameters, 8-19
tablespace requirements, 8-18
using, 8-22

alert files, 11-15
for monitoring a database, 11-2
using, 11-15

alert view, 11-6
ALTER USER command, 6-4
API

Oracle Enterprise Manager, 10-28
parameter, C-5
value, C-3

APPC architecture, 2-13
Application Programming Interface. See API
audit trail, operating system, 4-2
AUDIT_TRAIL parameter, 11-13
auditing, 11-13
auto-starting, Oracle Services, 10-5

B
BACKGROUND_DUMP_DEST parameter, using 

with trace files, 11-15
backup

databases, 9-13
OCOPY73 file types, 12-3

backup and recovery tools
Backup Manager, 12-2
NT Backup and Recovery Manager, 12-3
OCOPY73, 12-3
Oracle7 Enterprise Backup Utility, 12-2
selecting, 12-2

Backup Manager
capabilities, 5-16, 12-2
starting, 3-12

browsers
Microsoft Internet Explorer, 1-9
Netscape Navigator, 1-9

C
CATNSNMP.SQL, capabilities, 6-4
CD-ROM

order of installation, 2-5
product contents, 2-4

CHARACTER SET parameter, 9-8
chart view, 11-6
CLIENTS.INI file, 13-17
coexistence, version 7 and 8 databases, 2-14
COMMIT_POINT_ STRENGTH parameter, B-4
communication daemon, responsibilities, 5-7
COMPANY_NAME parameter, C-3, C-5
COMPATIBLE parameter, B-4
composite jobs, Job Scheduling System, 5-10
configuration parameters
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defined, C-2
registry, C-1

configuring
Advanced Replication support, 8-18
Oracle ConText Option, 8-16
Oracle Enterprise Manager, 8-4
Oracle7 Spatial Data Option, 8-15
SQL*Net, 8-22

CONNECT INTERNAL
passwords, 10-5
using, 10-5

connecting as INTERNAL, 10-19
connecting as SYSDBA, 10-18
connecting as SYSOPER, 10-18
connecting to a database, 10-5
console

features, 5-3
Oracle Enterprise Manager, 5-2
windows, 5-5

control files
description, 6-7
starter database, 6-7

Control Panel
defined, 4-7
integration with Oracle7 Server, 4-7
starting, 3-9

CONTROL_FILES parameter, 9-5, B-4
conventions, used in this manual, xvii
copy modes, for OCOPY73, 12-4
CREATE DATABASE statement, 9-7
cross-platform job scripts, 5-10
customer support, contacting, F-3

D
data dictionary

contents, 6-8
description, 6-8
starter database, 6-8

data files
description, 6-6
RBS1ORCL.ORA, 6-6
starter database, 6-6
SYS1ORCL.ORA, 6-6
TMP1ORCL.ORA, 6-6

USR1ORCL.ORA, 6-6
Data Manager

capabilities, 5-17
starting, 3-11

database administration applications
Backup Manager, 5-16
common features, 5-18
Data Manager, 5-17
Instance Manager, 5-16
Oracle Enterprise Manager, 5-15
Schema Manager, 5-16
Security Manager, 5-17
Software Manager, 5-18
SQL Worksheet, 5-17
Storage Manager, 5-17

database administrators
operating system authentication, 10-18
password file authentication, 10-16

database backup and recovery tools, 12-3
Backup Manager, 12-2
OCOPY73, 12-3
Oracle7 Enterprise Backup Utility, 12-2

database files
deleting, 9-4
moving, 7-7

database monitoring
using Performance Monitor, 11-3
with alert files, 11-15
with Event Viewer, 11-11
with trace files, 11-15

database roles
creating, 10-20
DBSNMP user account, 6-4
granting, 10-22
of SCOTT user account, 6-4
of SYS user account, 6-4
of SYSTEM user account, 6-4

database tools
operating system support, 3-2
starting, 3-5

databases
authenticating DBAs, 10-16
authenticating users, 10-14
backing up, 9-13
changing passwords, 9-11
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coexistence, 2-14
connecting to, 10-5
contents of starter database, 6-3
control files in starter database, 6-7
creating, 9-1
data dictionary in starter database, 6-8
data files in starter database, 6-6
deleting, 9-4
exporting, 9-3
granting roles, 10-22
importing, 9-12
manual creation steps, 9-2
migration, 2-14
monitoring, 11-1, 11-2
naming conventions, 9-2
options in starter database, 6-2
parameters for a new database, B-4
password encryption, 10-25
redo log files in starter database, 6-7
security, 10-14
shutting down, 10-5
starter database, 8-23
starter database, defined, Glossary-10
starting, 10-5
tablespaces in starter database, 6-5
user accounts in starter database, 6-3

DB_BLOCK_SIZE parameter, B-4
DB_FILE_MULTIBLOCK_ READ_ COUNT 

parameter, B-4
DB_FILE_SIMULTANEOUS_ WRITES 

parameter, B-4
DB_FILES parameter, 9-6, B-4
DB_NAME parameter, 9-5
DBLINK_ENCRYPT_LOGIN parameter, 10-25
DBSNMP user account, 6-4

database roles, 6-4
dropping with CATNSNMP.SQL, 6-4
password, 6-4

default control files, CTL1ORCL.ORA, 
CTL2ORCL.ORA, 6-7

default data files
RBS1ORCL.ORA, 6-6
SYS1ORCL.ORA, 6-6
TMP1ORCL.ORA, 6-6
USR1ORCL.ORA, 6-6

default initialization parameter file, 
INITORCL.ORA, 6-6

default redo log files
LOG1ORCL.ORA, 6-7
LOG2ORCL.ORA, 6-7
LOG3ORCL.ORA, 6-7
LOG4ORCL.ORA, 6-7

default tablespaces, 6-5
default user accounts, 6-3
directory structures

Windows 3.1, A-5
Windows 95, A-5
Windows NT, A-2

discovering services, 8-11
DISK_FULL error message, D-2
DisplayName parameter, C-8
distributing software

Oracle, 13-2
Oracle Software Manager, 13-19
Systems Management Server, 13-20

documentation
finding specific information, 1-8
formats, 1-2
generic, 1-3
HTML, 1-2
list of manuals, 1-4
Oracle Information Navigator, 1-2
platform-specific, 1-3
printed, 1-2

DRIVE_LOCKED error message, D-2

E
error messages

Intercartridge Exchange, 14-8
logging, D-2
Oracle Installer, D-2
Oracle7 database, D-4
OSD-04000 to OSD-04099, D-7
OSD-04100 to OSD-04199, D-12
OSD-04200 to OSD-04299, D-14
OSD-04300 to OSD-04399, D-17
OSD-04400 to OSD-04499, D-17
OSD-04500 to OSD-04599, D-18

Event Management System
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Oracle Enterprise Manager, 5-12
proactive events management, 5-12

Event Management Window, Oracle Enterprise 
Manager, 5-5

event scripts, with Job Scheduling System, 5-14
Event Viewer, 11-11

34 ID, 11-13
accessing, 11-12
auditing, 11-13
blue (informational) icon, 11-13
defined, 4-2
for monitoring a database, 11-2
IDs other than 34, 11-13
integration with Oracle7 Server, 4-2
logging operating system audit trail, 4-2
overview, 4-2
reading, 11-13
red (stop sign) icon, 11-13
using, 11-11
yellow (exclamation point) icon, 11-13

exception conditions, Intercartridge Exchange, 14-
8

EXECUTE_SQL parameter, C-3
EXP73. See Export Utility
Export Utility

databases, 9-3
redirecting output, D-2
starting, 3-7

F
FILE_CORRUPTED error message, D-2
FILE_NOT_FOUND error message, D-2
files

alert, 11-15
sample INIT.ORA, B-3
trace, 11-15

G
GLOBAL_NAMES parameter, 9-5

H
Hostname parameter, 11-4, C-6
hostname value, 11-4

I
ICX. See Intercartridge Exchange
ImagePath parameter, C-8
IMP73. See Import Utility
Import Utility

databases, 9-12
starting, 3-7

initialization parameter file
defined, B-2
description, 6-6
editing, B-2
INITORCL.ORA, 6-6
location, B-2
modifying, 9-5
starter database, 6-6

initialization parameters
Advanced Replication support, 8-19
BACKGROUND_DUMP_ DEST, B-4
COMMIT_POINT_ STRENGTH, B-4
COMPATIBLE, B-4
CONTROL_FILES, B-4
DB_BLOCK_SIZE, B-4
DB_FILE_MULTIBLOCK_ READ_ COUNT, B-4
DB_FILE_SIMULTANEOUS_ WRITES, B-4
DB_FILES, B-4
LOG_ARCHIVE_BUFFER_ SIZE, B-4
LOG_ARCHIVE_BUFFERS, B-4
LOG_ARCHIVE_DEST, B-4
LOG_ARCHIVE_FORMAT, B-4
LOG_CHECKPOINT_ INTERVAL, B-4
LOG_FILES, B-4
LOG_SMALL_ENTRY_MAX_ SIZE, B-4
MTS_MAX_DISPATCHERS, B-4
MTS_MAX_SERVERS, B-5
MTS_SERVERS, B-5
NLS_LANGUAGE, B-5
NLS_SORT, B-5
NLS_TERRITORY, B-5
OPEN_CURSORS, B-5
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OS_AUTHENT_PREFIX, B-5
PROCESSES, B-5
REMOTE_LOGIN_ PASSWORDFILE, B-5
SHARED_POOL_SIZE, B-5
SORT_READ_FAC, B-5
SORT_SPACEMAP_SIZES, B-5
TEMPORARY_TABLE_ LOCKS, B-5
TRANSACTIONS_PER_ ROLLBACK_ 

SEGMENT, B-5
USER_DUMP_DEST, B-5

INITORCL.ORA file. See initialization parameter file
installation options, 2-4
Instance Manager

capabilities, 5-16
Oracle Enterprise Manager, 5-16
starting, 3-11
starting GUI, 3-6

instances
creating, 3-14
defined, 4-7, 10-2, Glossary-3
deleting, 3-14
editing, 3-15
running multiple instances, 10-13
starting, 3-14
stopping, 3-15

integrated applications
application programmatic interfaces, 10-28
of Oracle Enterprise Manager, 5-15
Oracle7 Server and Windows NT, 4-1

Intercartridge Exchange
accessing web data, 14-4
configuring, 14-4
error messages, 14-8
exception conditions, 14-8
packaged functions, 14-5
stored packages, 14-5
troubleshooting, 14-10
using, 14-5

INTERNAL
alias for SYS and SYSDBA, 6-3
password of, 6-3
passwords, 10-5
user account, 6-3

INTERNAL, connecting as, 10-19
INVALID_FILE_NAME error message, D-2

J
Java Database Connectivity, 2-3

JDK JDBC OCI Driver, 2-7
OCI Driver, 2-4
Thin Client Driver, 2-6

JDBC. See Java Database Connectivity
Job Scheduling System

composite jobs, 5-10
event scripts, 5-14
lights out management, 5-9
optimized intelligent agent, 5-14
Oracle Enterprise Manager, 5-8
predefined event sets, 5-13
predefined job tasks, 5-9
scalability, 5-11, 5-13
scripts, 5-10
security, 5-11
storing and forwarding job scheduling, 5-9
unsolicited error detection, 5-12

Job Scheduling Window, Oracle Enterprise Manag-
er Console, 5-5

L
LEXICAL_ERROR error message, D-3
lights out management, 5-9
LOCKING_VIOLATION error message, D-3
log view, 11-6
LOG_ARCHIVE_BUFFER_ SIZE parameter, B-4
LOG_ARCHIVE_BUFFERS parameter, B-4
LOG_ARCHIVE_DEST parameter, B-4
LOG_ARCHIVE_FORMAT parameter, B-4
LOG_CHECKPOINT_ INTERVAL parameter, B-4
LOG_FILES parameter, B-4
LOG_SMALL_ENTRY_MAX_ SIZE parameter, B-4
LOG1ORCL.ORA file, 6-7
LOG2ORCL.ORA file, 6-7
LOG3ORCL.ORA file, 6-7
LOG4ORCL.ORA file, 6-7
LOGFILE parameter, 9-7, C-7
logging error messages, D-2
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M
managing jobs, Oracle Enterprise Manager, 5-12
Map Window, Oracle Enterprise Manager, 5-5
MAXDATAFILES parameter, 9-8
Microsoft Internet Explorer, 1-9
migration

Oracle Migration Wizard for Microsoft 
Access, 7-14

overview, 2-14
monitoring

alert files, 11-2
databases, 11-1
Event Viewer, 11-2
Oracle events, 4-2, 4-3
Oracle7 Objects, 11-6
Performance Monitor, 11-2
Performance Pack, 11-2
trace files, 11-2

MSHELP_TOOLS parameter, C-3
MTS_MAX_DISPATCHERS parameter, B-4
MTS_MAX_SERVERS parameter, B-5
MTS_SERVERS parameter, B-5

N
Named Pipes Protocol Adapter

defined, 2-13
Navigator Window, 5-5
NET START command, 9-8
Netscape Navigator, 1-9
network security and single sign-on Biometric 

Manager, 5-22
NLS support, E-2
NLS_LANG parameter, C-3, C-5, E-2

default values, E-2
territory and character set defaults, E-3

NLS_LANGUAGE parameter, B-5
NLS_SORT parameter, B-5
NLS_TERRITORY parameter, B-5
NLSRTL32 parameter, C-4
NOARCHIVELOG parameter, 9-8
NT Backup Manager

capabilities, 12-3
operating system compatibility, 3-2

restriction, F-2
NT Recovery Manager

capabilities, 12-3
operating system compatibility, 3-2

O
ObjectName parameter, C-8
OCI, defined, 2-9
OCOPY73

backup file types, 12-3
capabilities, 12-3
copy modes, 12-4
recovery file types, 12-5
starting, 3-8
syntax for backing up files, 12-4
syntax for recovering files, 12-5

OCSM. See Oracle Client Software Manager
ODBC. See Oracle Open Database Connectivity 

Driver
OI_ NLS32 parameter, C-4
Open Systems Interconnect (OSI) model, 2-13
OPEN_CURSORS parameter, B-5
operating systems

audit trail, 4-2
authenticating users, 10-18

OPERF73.LOG file, 11-11
viewing Performance Monitor status, 11-11

OPS$ database logon, 10-14
optimized intelligent agent, Job Scheduling 

System, 5-14
options

configuration guidelines, 8-2
in starter database, 6-2

options, automatically configuring, 8-2
ORA_ENCRYPT_LOGIN parameter, 10-25
ORA_NLS33 parameter, C-4
ORA_ORCL_PWFILE parameter, C-4
ORA_SID_DBA, 10-21
Oracle Administrator Toolbar, defined, 2-10
Oracle Advanced Networking Option Administra-

tor’s Guide, 1-6
Oracle Biometrics Manager, defined, 2-10
Oracle Call Interface, compiling, 14-3
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Oracle Client Configuration Manager, defined, 2-
11

Oracle Client Software Agent, defined, 2-11
Oracle Client Software Manager

access to Oracle home, 13-8
capabilities, 13-2
client user vs. administrator options, 13-11
CLIENTS.INI file, 13-17
compliant Oracle products, 13-3
creating a host machine, 13-6
defining conflict resolution, 13-15
distributing software, 13-19
installation requirements, 13-4
Microsoft remote registry service, 13-5
registering the client machine, 13-9
using, 13-15

Oracle ConText Option
configuration guidelines, 8-2
configuring, 8-16

Oracle ConText Option Configuration Manager, 2-
8

Oracle ConText Option Messages, 1-5
Oracle ConText Option Workbench, 1-5
Oracle DECnet Protocol Adapter, defined, 2-13
Oracle Enterprise Manager

applications, integrating, 10-28
Backup Manager, 5-16
common services, 5-6
communication daemon, 5-7
configuration files, creating, 8-11
configuration guidelines, 8-2
console capabilities, 5-2
console features, 5-3, 10-25
console windows, 5-5
console, using, 10-25
Data Manager, 5-17
database administration applications, 5-15
defined, 2-10
Event Management System, 5-12
Event Management Window, 5-5
Instance Manager, 5-16
integrated applications, 5-15
Job Scheduling System, 5-8
Job Scheduling Window, 5-5
key components, 5-3

logging on to the console, 10-26
managing jobs, 5-12
Map Window defined, 5-5
maps, creating, 10-27
Navigator, 10-27
Navigator view, 10-27
Navigator Window, 5-5
operating system compatibility, 3-3
Oracle Advanced Networking Option, 

integrating, 5-22
Oracle Intelligent Agent, 5-7
Oracle Media Server, integrating, 5-20
Oracle Parallel Server, integrating, 5-20
Oracle Software Manager
Oracle WebServer, integrating, 5-21
overview, 5-2
Performance Pack, 11-2
Replication Manager, integrating, 5-19
repository, 5-14
repository, creating, 8-11
scheduling jobs, 5-8
Schema Manager, 5-16
security, 5-15
Security Manager, 5-17
service discovery, 5-8
services, discovering, 8-11
simple single tasks, 10-26
Software Manager, 5-18
SQL Worksheet, 5-17
starting, 3-10
Storage Manager, 5-17
Tcl scripts
User Manager, 8-8
user-defined groups, creating, 10-27

Oracle Enterprise Manager configuration, 8-4
creating a repository user account, 8-6
creating an NT user account, 8-7
overview, 8-4
starting Oracle Services, 8-5

Oracle Enterprise Manager SDK, defined, 2-10
Oracle Expert, 11-20
Oracle Home, creating multiple, 8-22
Oracle homes

defined, xviii
switching between homes, 8-22
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Oracle Information Navigator, 1-2
starting, 1-8

Oracle Installer
defined, 2-5
error messages, D-2

Oracle instance. See instances, 4-7
Oracle Intelligent Agent

communicating with the console, 5-7
defined, 2-11
overview, 8-4
responsibilities, 5-7
starting, 8-5

ORACLE key, C-3
Oracle Lock Manager, 11-17
Oracle LU6.2 Protocol Adapter, defined, 2-13
Oracle Migration Wizard for Microsoft Access

starting, 3-13
using, 7-14

Oracle Named Pipes Protocol Adapter, defined, 2-
13

Oracle Names Administrator’s Guide, 1-6
Oracle Names Server, defined, 2-12
Oracle NetBIOS Protocol Adapter, defined, 2-13
Oracle Network Manager, 8-3
Oracle Network Manager Administrator’s 

Guide, 1-6
Oracle Network Products Troubleshooting 

Guide, 1-6
Oracle Objects for OLE, defined, 2-9
Oracle Open Database Connectivity Driver, 2-9
Oracle Parallel Server Option, 2-3
Oracle Parallel Server Support for the Oracle Enter-

prise Manager Console, 1-5
Oracle products

configuration guidelines, 8-2
Oracle Client Software Manager compliant, 13-3
package definition files, 13-20
Systems Management Server support, 13-19

Oracle Replication Manager, defined, 2-11
Oracle Server Manager Release 2.3.2 

Addendum, 1-5
Oracle Server Manager User’s Guide, 1-5
Oracle Services

auto-starting, 10-5
defined, 4-7

for Oracle7 Server, 4-7
stopping, 10-4
viewing in the Control Panel, 4-7

Oracle Software Manager
capabilities of
defined, 13-18
distributing software, 13-19
products available for installation, 13-19

Oracle SPX Protocol Adapter, defined, 2-12
Oracle TCP/IP Protocol Adapter, defined, 2-12
Oracle tool, defined, Glossary-6
Oracle Trace

overview, 11-19
starting, 11-20

Oracle WebServer Manager, defined, 2-10
Oracle WebServer, defined, 2-5
Oracle Worldwide Customer Support, 

contacting, F-3
Oracle XA Library, compiling and linking, 14-2
ORACLE_GROUP_NAME parameter, C-4, C-5
ORACLE_HOME parameter, C-4, C-5
ORACLE_SID parameter, 9-12, 10-2, C-4
Oracle7, 3-1
Oracle7 Buffer Cache, 11-8
Oracle7 ConText Filters

creating wrappers, 4
overview, 2
setting up, 2
using, 4

Oracle7 ConText Option
defined, 2-7, 2-9

Oracle7 ConText Option Demos, 7
list of, 7

Oracle7 ConText Option I/O Utility, defined, 2-8
Oracle7 ConText Option System Administration, 

defined, 2-8
Oracle7 ConText Option Viewer

defined, 2-8
Oracle7 ConText Option Viewer, defined, 2-8
Oracle7 ConText Option Workbench

defined, 2-7
overview, 7

Oracle7 Data Dictionary Cache, 11-8
Oracle7 Data Files, 11-9
Oracle7 database
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error messages, D-4
Oracle7 DBWR stats1, 11-9
Oracle7 DBWR stats2, 11-9
Oracle7 Dynamic Space Management, 11-10
Oracle7 Enterprise Backup Utility, 2-3

capabilities, 12-2
Oracle7 Free List, 11-10
Oracle7 JDBC Drivers, 1-5
Oracle7 Library Cache, 11-10
Oracle7 Objects, 11-4, 11-12

monitoring, 11-6
Oracle7 Performance Monitor

accessing, 11-4
alert view, 11-6
chart view, 11-6
for monitoring a database, 11-2
Hostname parameter, 11-4
installation, 11-3
log view, 11-6
monitoring Oracle7 Objects, 11-6
OPERF73.LOG, 11-11
Oracle7 Buffer Cache, 11-8
Oracle7 Data Dictionary Cache, 11-8
Oracle7 Data Files, 11-9
Oracle7 DBWR stats1, 11-9
Oracle7 DBWR stats2, 11-9
Oracle7 Dynamic Space Management, 11-10
Oracle7 Free List, 11-10
Oracle7 Library Cache, 11-10
Oracle7 Redo Log Buffer, 11-10
password, 11-4
registry information, 11-3
Report View, 11-6
troubleshooting information, 11-11
Username parameter, 11-4
using, 11-3

Oracle7 Performance Utility, defined, 2-9
Oracle7 Redo Log Buffer, 11-10
Oracle7 Server

available Oracle Services, 4-7
connecting to, 10-5
default name in starter database, 6-2
defined, 2-2
installable products, 2-4
installing after upgrade, 7-5

integration with Windows NT, 4-1
key features, 2-2
new features, 2-3
options in starter database, 6-2
selecting a backup and recovery tool, 12-2
shutting down, 10-5
standard option, 6-2
starter database, 6-2
starter database contents, 6-3
starter database control files, 6-7
starter database data dictionary, 6-8
starter database data files, 6-6
starter database initialization parameter file, 6-6
starter database redo log files, 6-7
starter database tablespaces, 6-5
starter database user accounts, 6-3
starting, 10-5
using Control Panel, 4-7
using Event Viewer, 4-2
using Performance Monitor, 4-3
using User Manager, 4-9

Oracle7 Server backup and recovery tools
Backup Manager, 12-2
OCOPY73, 12-3
Oracle7 Enterprise Backup Utility, 12-2

Oracle7 Sorts, 11-10
Oracle7 Spatial Data Option

configuration guidelines, 8-2
configuring, 8-15
defined, 2-9

Oracle7 Spatial Data Utilities
defined, 2-9

Oracle7 Utilities
defined, 2-6
operating system compatibility, 3-2

OracleAgent
defined, 4-7, 10-4

OracleAgent key, C-8
OracleConTextService73

defined, 10-4
OracleConTextService73 key, C-8
OracleConTextService73, defined, 4-7
OracleNamesService

defined, 10-4
OracleNamesService key, C-8
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OracleServiceORCL
defined, 4-7, 10-2

OracleServiceSID key, C-8
OracleStartORCL, defined, 4-7, 10-2
OracleStartSID key, C-8
OracleTNSListener

defined, 4-7, 10-2
OracleTNSListener key, C-8
ORADIM73

list of parameters, 3-16
starting, 3-6
using, 3-14

ORADIM73 command, 3-6
ORAPWD73, starting, 3-8
OraTcl, using with database commands, 5-10
OS_AUTHENT_PREFIX parameter, B-5
OS_ERROR error message, D-3
OSD-04000 to OSD-04099 error codes, D-7
OSD-04100 to OSD-04199 error codes, D-12, D-14
OSD-04300 to OSD-04399 error codes, D-17
OSD-04400 to OSD-04499 error codes, D-17
OSD-04500 to OSD-04599 error codes, D-18
OSM. See Oracle Software Manager
OTRACE73 parameter, C-4
overview

managing and distributing Oracle software, 13-
2

monitoring a database, 11-2
Oracle Enterprise Manager, 5-2

P
package definition files, Oracle products, 13-20
packaged functions

Intercartridge Exchange, 14-5
UTL_HTTP.REQUEST, 14-5
UTL_HTTP.REQUEST_PIECES, 14-6

parameters
defined, C-2
registry, C-1

PARFILE, using, D-2
password files, creating, 10-16
Password parameter, C-6
Password Utility. See ORAPWD73
passwords

changing for SYS user account, 6-4
changing for SYSTEM user account, 6-4
changing with ALTER USER command, 6-4
for databases, 9-11
for DBSNMP user account, 6-4
for INTERNAL user account, 6-3, 10-5
for SCOTT user account, 6-4
for SYS user account, 6-4
for SYSTEM user account, 6-4

PERF_FILE_NAME parameter, C-7
PERFORMANCE key, C-6
Performance Monitor, 11-3

defined, 4-3
integration with Oracle7 Server, 4-3
monitoring specific Oracle events, 4-3
viewing OPERF73.LOG file status, 11-11

Performance Pack, monitoring a database, 11-2
PERMISSION_DENIED error message, D-3
PLSQL23 parameter, C-4
PLUS_DFLT parameter, C-4
PLUS33 parameter, C-4
PRAGMA RESTRICT_REFERENCES, with Intercar-

tridge Exchange, 14-8
predefined event sets, with Job Scheduling 

System, 5-13
Pro*C, compiling, 14-2
Pro*COBOL Supplement to the Oracle 

Precompilers, 1-6
PRO18 parameter, C-4
proactive events management

Event Management System, 5-12
PROCESSES parameter, B-5
Programmer’s Guide to the Oracle 

Precompilers, 1-6
protocol adapters, defined, Glossary-7
PWDsid.ORA file, 10-16

R
RBS1ORCL.ORA

data file, 6-6
tablespace contained in, 6-6

RDBMS73 parameter, C-4
RDBMS73_ARCHIVE parameter, C-5
RDBMS73_CONTROL parameter, C-5
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READ_ERROR error message, D-3
RECALIBRATION_FAILURE error message, D-3
recovering, an Oracle7 Server, 12-2
recovery file types, OCOPY73, 12-5
redo log files

LOG1ORCL.ORA, 6-7
LOG2ORCL.ORA, 6-7
LOG3ORCL.ORA, 6-7
LOG4ORCL.ORA, 6-7
starter database, 6-7

REGEDT32 command, 9-12
registry

A2OW1Z15, C-3
adding parameters, C-11
API, C-3
API parameter, C-5
COMPANY_NAME, C-3, C-5
configuration parameters, C-1
DisplayName, C-8
EXECUTE_SQL, C-3
Hostname, C-6
Hostname parameter, 11-4
ImagePath, C-8
keys, C-2
LOGFILE, C-7
modifying values, C-9
MSHELP_TOOLS, C-3
NLS_LANG, C-3, C-5
NLSRTL32, C-4
ObjectName, C-8
OI_NLS32, C-4
ORA_NLS32, C-4
ORA_ORCL_PWFILE, C-4
ORACLE key, C-3
ORACLE_GROUP_NAME, C-4, C-5
ORACLE_HOME, C-4, C-5
ORACLE_SID, C-4
OracleAgent key, C-8
OracleConTextService73 key, C-8
OracleNamesService key, C-8
OracleServiceSID key, C-8
OracleStartSID key, C-8
OracleTNSListener key, C-8
OTRACE73, C-4
parameter values, C-2

Password, C-6
password value, 11-4
PERF_FILE_NAME, C-7
PERFORMANCE key, C-6
PLSQL23, C-4
PLUS_DFLT, C-4
PLUS33, C-4
PRO18, C-4
RDBMS73, C-4
RDBMS73_ARCHIVE, C-5
RDBMS73_CONTROL, C-5
REG_DWORD, C-2, C-11
REG_EXPAND_SZ, C-2, C-11
REG_MULTI_SZ, C-2, C-11
REG_SZ, C-2, C-11
REGEDT32, C-9, C-11
SHARED_ORACLE_HOME, C-5, C-6
SQLPATH, C-5
SVRMGR, C-5
update ORACLE_SID, 9-12
Username, C-6
Username parameter, 11-4

Registry Editor, C-2
REMOTE_LOGIN_ PASSWORDFILE 

parameter, B-5
REMOTE_LOGIN_PASSWORDFILE 

parameter, 10-19
Report View, 11-6
repository user account, 8-6
repository, Oracle Enterprise Manager, 5-14
Required Support Files

version 7.3, 2-6
version 7.x, 2-6

roles
creating, 10-20
granting, 10-22
of DBSNMP user account, 6-4
of SCOTT user account, 6-4
of SYS user account, 6-4
of SYSTEM user account, 6-4

ROLLBACK_DATA tablespace, description, 6-5
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S
scalability

Job Scheduling System, 5-11
with Job Scheduling System, 5-13

scheduling jobs, Oracle Enterprise Manager, 5-8
Schema Manager

capabilities, 5-16
starting, 3-12

schema, INTERNAL user account, 6-3
SCOTT user account, 6-4

database roles of, 6-4
password of, 6-4

security
of Oracle Enterprise Manager, 5-15
with Job Scheduling System, 5-11
with Oracle Enterprise Manager, 5-15

Security Manager, 5-17
starting, 3-12

Server Manager
running multiple instances, 10-13
shutting down the database, 10-5
starting, 3-6, 10-5
starting the database, 10-5

service discovery, Oracle Enterprise Manager, 5-8
services

auto-starting, 10-5
available with Oracle7 Server, 4-7
creating, 9-6
OracleAgent, 10-4
OracleConTextService73, 10-4
OracleNamesService, 10-4
OracleServiceORCL, 10-2
OracleStartORCL, 10-2
OracleTNSListener, 10-2
starting, 9-6, 10-2
starting Oracle Services, 10-2
stopping, 10-4
viewing in the Control Panel, 4-7

SET ORACLE_SID=SID, 10-13
SHARED_ORACLE_HOME parameter, C-5, C-6
SHARED_POOL_SIZE parameter, B-5
SHARING_VIOLATION error message, D-3
SHUTDOWN command

options, 10-6

using, 10-6
shutting down, databases, 10-5
SID. See system identifier
SMS. See Systems Management Server
SNA, 2-13
Software Manager, capabilities, 5-18
SORT_READ_FAC parameter, B-5
SORT_SPACEMAP_SIZES parameter, B-5
SQL Worksheet

capabilities, 5-17
starting, 3-12

SQL*DBA to Oracle Server Manager Migration 
Guide, 1-5

SQL*Loader
control file conventions, 3-17
direct path option, 3-17
starting, 3-7
using, 3-16

SQL*Net
configuration guidelines, 8-2
configuring, 8-3
Oracle Network Manager, 8-3
products, 2-11
SQL*Net Easy Configuration, 8-3

SQL*Net Client, defined, 2-12
SQL*Net configuration tools

overview, 7-2
SQL*Net Easy Configuration, 8-3
SQL*Net Server, defined, 2-12
SQL*Plus

defined, 2-10
operating system compatibility, 3-3
starting, 3-13

SQLPATH parameter, C-5
standard option, database type, 6-2
starter database, Glossary-10

contents, 6-2, 6-3
control files, 6-7
data dictionary, 6-8
data files, 6-6
default SID and database name, 6-2
initialization parameter file, 6-6
options in, 6-2
Oracle7 Server, 6-2
redo log files, 6-7
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tablespaces, 6-5
types, 8-23
user accounts, 6-3

starting
databases, 10-5
Event Viewer, 11-12
Instance Manager GUI, 3-6
Oracle Services, 10-2
Oracle7 Performance Monitor, 11-4
performance monitoring applications, 11-20
Server Manager, 10-5

STARTUP, use of, 10-6
stopping, Oracle Services, 10-4
Storage Manager, capabilities, 5-17
stored packages, Intercartridge Exchange, 14-5
support, contacting, F-3
SVRMGR parameter, C-5
SVRMGR23. See Server Manager
syntax

for backing up files with OCOPY73, 12-4
for recovering files with OCOPY73, 12-5

SYS user account, 6-4
changing the password, 6-4
database roles of, 6-4
password of, 6-4

SYS1ORCL.ORA
data file, 6-6
tablespace contained in, 6-6

SYSDBA, use of, 10-18
SYSOPER, use of, 10-18
system identifier

defined, 4-7, 10-2
in starter database, 6-2

System Network Architecture (SNA), 2-13
SYSTEM tablespace, description, 6-5
SYSTEM user account, 6-4

changing the password, 6-4
database roles of, 6-4
password of, 6-4

Systems Management Server
capabilities
defined
distributing software, 13-20
Oracle product support, 13-19
package definition files, 13-19

products available for installation, 13-20

T
tablespaces

containing RBS1ORCL.ORA, 6-6
containing SYS1ORCL.ORA, 6-6
containing TMP1ORCL.ORA, 6-6
containing USR1ORCL.ORA, 6-6
expanding for large sorts, 6-5
ROLLBACK_DATA, 6-5
starter database, 6-5
SYSTEM, 6-5
TEMPORARY_DATA, 6-5
USER_DATA, 6-5

Tcl
including database commands, 5-10
scripts

TEMPORARY_DATA tablespace, description, 6-5
TEMPORARY_TABLE_ LOCKS parameter, B-5
TMP1ORCL.ORA

data file, 6-6
tablespace contained in, 6-6

TOO_MANY_OPEN_FILES error message, D-3
Tool Command Language. See Tcl
trace files, 11-15

for monitoring a database, 11-2
using, 11-15
using BACKGROUND_DUMP_DEST 

parameter, 11-15
using USER_DUMP_DEST, 11-15

TRANSACTIONS_PER_ ROLLBACK_ SEGMENT 
parameter, B-5

troubleshooting
Intercartridge Exchange, 14-10
Oracle7 Server, F-2

U
Understanding SQL*Net, 1-6
unsolicited error detection, Job Scheduling 

System, 5-12
user accounts

changing passwords for SYS and SYSTEM, 6-4
DBSNMP, 6-4
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INTERNAL, 6-3
SCOTT, 6-4
starter database, 6-3
SYS, 6-4
SYSTEM, 6-4

User Manager
defined, 4-9
for Oracle Enterprise Manager, 8-8
integration with Oracle7 Server, 4-9
starting, 3-9

USER_DATA tablespace, description, 6-5
USER_DUMP_DEST parameter, B-5
USER_DUMP_DEST, using, 11-15
Username parameter, C-6
users, operating system authentication, 10-14
USR1ORCL.ORA

data file, 6-6
tablespace contained in, 6-6

UTL_HTTP.REQUEST, Intercartridge 
Exchange, 14-5

UTL_HTTP.REQUEST_PIECES, Intercartridge 
Exchange, 14-6

W
web data, Intercartridge Exchange
Windows 3.1, directory structure for database, A-5
Windows 95, directory structure for database, A-5
Windows NT

directory structure for database, A-2
tools, 3-2
user account, 8-7

wizards
operating system compatibility, 3-3
Oracle Migration Wizard for Microsoft 

Access, 7-14
starting, 3-13

wrappers, Oracle7 ConText Filters, 4
WRITE_ERROR error message, D-4
WRITE_PROTECTED error message, D-4


